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Safety

Your printer and the recommended supplies have been designed and tested to meet strict safety
requirements. Attention to the following information ensures the continued safe operation of your Xerox
printer.

Notices and Safety

Read the following instructions carefully before operating your printer. Refer to these instructions to
ensure the continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These
include safety agency evaluation and certification, and compliance with electromagnetic regulations
and established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox®
materials only.
Note

Unauthorized alterations, which can include the addition of new functions or connection of external
devices, can affect the product certification. For more information, contact your Xerox representative.

Electrical Safety

General Guidelines

A Warning

e Do not push objects into slots or openings on the printer. Touching a voltage point or shorting out a
part could result in fire or electric shock.

» Do not remove the covers or guards that are fastened with screws unless you are installing optional
equipment and are instructed to do so. Power off the printer when performing these installations.
Disconnect the power cord when removing covers and guards for installing optional equipment.
Except for user-installable options, there are no parts that you can maintain or service behind these
covers.
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The following are hazards to your safety:

The power cord is damaged or frayed.

Liquid is spilled into the printer.

The printer is exposed to water.

The printer emits smoke, or the surface is unusually hot.

The printer emits unusual noise or odors.

The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Power off the printer immediately.

2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

Power Cord

Use the power cord supplied with your printer.

Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the
cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check
the outlet.

A Warning

To avoid risk of fire or electrical shock, do not use extension cords, power strips, or power plugs for
more than 90 days. When a permanent outlet receptacle cannot be installed, use only one
factory-assembled extension cord of the appropriate gauge for each printer or multifunction printer.
Always adhere to national and local building, fire, and electrical codes regarding length of cord,
conductor size, grounding, and protection.

Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a
ground connection terminal.

Verify that the printer is plugged into an outlet that is providing the correct voltage and power. Review
the electrical specification of the printer with an electrician if necessary.

Do not place the printer in an area where people can step on the power cord.

Do not place objects on the power cord.

Do not plug or unplug the power cord while the power switch is in the On position.

If the power cord becomes frayed or worn, replace it.

To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.

Emergency Power Off

If any of the following conditions occur, power off the printer immediately and disconnect the power
cord from the electrical outlet. Contact an authorized Xerox service representative to correct the problem

if:

1-2

The equipment emits unusual odors or makes unusual noises.
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e The power cable is damaged or frayed.

e A wall panel circuit breaker, fuse, or other safety device has been tripped.
e Liquid is spilled into the printer.

e The printer is exposed to water.

e Any part of the printer is damaged.

Telephone Line Cord

& Warning
To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger telecommunication line
cord.

Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your
printer.

Operational Guidelines

¢ Do not remove any trays when the printer is printing.

e Do not open the doors when the printer is printing.

e Do not move the printer when it is printing.

o Keep hands, hair, neckties, and so on, away from the exit and feed rollers.

e Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove
the protective covers.

e Do not override any electrical or mechanical interlock devices.
e Do not attempt to remove paper that is jammed deeply inside the printer. Switch off the printer

promptly and contact your local Xerox representative.
ﬁ\\. Warning

e The metallic surfaces in the fuser area are hot. Always use caution when removing paper jams from
this area and avoid touching any metallic surfaces.

e To avoid a tip hazard, do not push or move the device with all the paper trays extended.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone.
Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to www.xerox.com/environment . In other
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe.
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Safety

Printer Location

Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight.
To find the weight for your printer configuration, refer to Physical Specifications.

Do not block or cover the slots or openings on the printer. These openings are provided for ventilation
and to prevent overheating of the printer.

Place the printer in an area where there is adequate space for operation and servicing.
Place the printer in a dust-free area.

Do not store or operate the printer in an extremely hot, cold, or humid environment.

Do not place the printer near a heat source.

Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.

Do not place the printer where it is directly exposed to the cold air flow from an air conditioning
system.

Do not place the printer in locations susceptible to vibrations.
For optimum performance, use the printer at the elevations specified in Elevation.

Printer Supplies

Use the supplies designed for your printer. The use of unsuitable materials can cause poor performance
and a possible safety hazard.

Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.
Store all consumables in accordance with the instructions given on the package or container.

Keep all consumables away from the reach of children.

Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame.

When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can
cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase
the risk of skin or eye contact.

@ Caution

Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and Total
Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by
use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total Satisfaction
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please
contact your Xerox representative for details.

Maintenance Safety

14

Do not attempt any maintenance procedure that is not specifically described in the documentation
supplied with your printer.

Clean with a dry lint-free cloth only.

Do not burn any consumables or routine maintenance items. For information on Xerox® supplies
recycling programs, go to www.xerox.com/gwa .
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Safety

A Warning

Do not use aerosol cleaners. Aerosol cleaners can cause explosions or fires when used on electromechanical
equipment.

When installing the device in a hallway or similar restricted area, additional space requirements can
apply. Ensure that you comply with all workspace safety regulations, building codes, and fire codes for
your area.

Printer Symbols

Symbol Description

f Warning:
Indicates a hazard that can result in death or serious injury if not avoided.

Hot Warning:
Hot surface on or in the printer. Use caution to avoid personal injury.

Warning:
& Wait for the printer to cool for the specified time before touching the fuser.

e
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#
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]

Caution:
Indicates a mandatory action to take in order to avoid damage to the property.

Do not touch the part or area of the printer.

Do not touch.

Do not expose the drum cartridges to direct sunlight.

Do not burn the toner cartridges.

ZUZRCNGI
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Safety
Symbol Description

Do not burn the drum cartridges.

Do not use paper attached with staples or any other form of binding clip.

Do not use inkjet paper.

@ Do not use folded, creased, curled, or wrinkled paper.

Do not use transparencies or overhead projector sheets.

Do not reload paper previously printed on or used.

Do not copy money, revenue stamps, or postage stamps.

LED Printhead Cleaner Storage Location

Environmental, Health and Safety Contact
Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies,
contact the following customer help lines:

¢ United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)
e Europe: +44 1707 353 434

For product safety information in the United States and Canada, go to www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/environment_europe.
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Parts of the Printer

Front View
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1. Tray 2, Optional 550-Sheet Feeder 6
2. Tray1 7.
3. Bypass Tray 8.
4. Front Door 9
5. USB Memory Port 1

0.

Power/Wake Button

Touch Screen

Duplex Automatic Document Feed
Output Tray

Output Tray Extension
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Duplex Automatic Document Feeder

CVT Glass
Second-Side Scanning Access Cover Lever

Document Feeder Cover

Document Guides

Document Feeder Tray Document Glass

O 0 N o

Document Output Tray Document Cover

v &> wWwhN =

Document Output Tray Extension

Document Feeder Guidelines

The Duplex Automatic Document Feeder accommodates the following original-sized documents:

e Width: 140-216 mm (5.5-8.5 in.)
e Length: 140-356 mm (5.5-14in.)
e Weight: 60-125 g/m?

Follow these guidelines when loading original documents into the duplex automatic document feeder:

¢ Load original documents face up so that the top of the document enters the feeder first.
e Place only loose sheets of undamaged paper in the duplex automatic document feeder.
e Adjust the paper guides so that they fit against the original documents.

e Insert paper in the duplex automatic document feeder only when ink on the paper is dry.
e Do not load original documents above the MAX fill line.

Document Glass Guidelines

The document glass accommodates original size documents up to 216 x 356 mm (8.5 x 14 in.). Use the
document glass rather than the duplex automatic document feeder to copy or scan the following types
of original documents:

e Paper with paper clips or staples attached

e Paper with wrinkles, curls, folds, tears, or notches

e Coated or carbonless paper or items other than paper, such as cloth or metal

e Envelopes
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e Books

Internal Parts

1. Front Door
2. Toner Cartridge
3. Drum Cartridge

Rear View

Transfer Roller

Fuser

Rear Door

Wireless Network Adapter Port Cover
Phone Connector
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Fax Line Connector
Options

Finisher
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4. Document Glass
5. Document Cover
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7. USB Port, Type A

8. USB Port, Type B

9. Ethernet Connection

10. FDI Port

11. Left-Side Panel, Access to optional Productivity
Kit

12. Power Connector

Mailbox
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Control Panel

The control panel consists of a touch screen and buttons you press to control the functions available on
the printer. The control panel:

e Displays the current operating status of the printer.

e Provides access to print, copy, and scan features.

e Provides access to reference materials.

e Provides access to Tools and Setup menus.

e Prompts you to load paper, replace supplies, and clear jams.

o Displays errors and warnings.

e Provides the Power/Wake button used for powering on or powering off the printer. This button also
supports the power-saver modes, and blinks to indicate the power status of the printer.

Item Name Description

1 Touch Screen Display This area of the screen displays information and provides access to printer
functions and applications.

2 Administrator Logon This is the location where the system administrator logs in using the system
administrator password.
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Item Name

3 Power/Wake

Getting Started

Description

This button serves several power-related functions.

e When the printer is off, this button powers on the printer.

e When the printer is on, pressing this button displays a menu on the control
panel. From this menu, you can choose to enter Sleep mode, restart, or
power off the printer.

e When the printer is on, but in a low-power or Sleep mode, pressing this
button wakes the printer.

e When the printer is powered on, holding this button for 5 seconds powers
off the printer.

This button also blinks to indicate the power status of the printer.

e When the light blinks slowly, the printer is in Low Power or Sleep mode.

e When the light blinks fast, the printer is powering down, or exiting a low-
power mode.

4 Home Button

This button provides access to the Home menu for access to printer features.

5 NFC Area

Near Field Communication (NFC) is a technology that enables devices to
communicate when they are within 10 cm (4 in.) of each other. Use the NFC
area to obtain a network interface or to establish a TCP/IP connection
between your device and the printer.

6 Status LED

This light blinks blue or amber to indicate printer status.
e Blue

Blinks once slowy to acknowledge a successful Authentication request.

Blinks once slowly for a Copy or Print job initiated at the control
panel.

Blinks twice slowly for Fax or Print job received from the network.

Blinks fast while the printer is powering up, or to signal detection of
a Wi-Fi Direct connection request.

e Amber

Blinks to indicate an error condition or warning that requires your
attention. For example, an out-of-toner condition, a paper jam, or
out of paper for the current job.

The printer status LED also blinks to indicate a system error, which
typically is associated with an error code.

Power Options

The Power/Wake button is a single multifunction button on the control panel.

e When used in conjunction with the main power switch, the Power/Wake button powers on the printer.

o If the printer is already powered on, you can use the Power/Wake button to:

Xerox® VersalLink® B605/B615 Multifunction Printer
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- Restart the printer
- Enter or exit Sleep mode
- Enter or exit Low-Power mode

e The Power/Wake button also flashes when the printer is in low-power mode.

Powering On the Printer or Exiting Low-Power or Sleep Mode

To power on the printer, or to exit Low-Power mode or Sleep mode, press the Power/Wake button.

Note

e The Power/Wake button is the only power button on the printer.

e The printer exits Low-Power mode or Sleep mode automatically when it receives data from a connected
device.

e When in Low-Power mode, or Sleep mode, the touch screen is powered off and unresponsive. To wake
the printer manually, press the Power/Wake button.

@ Caution

e To prevent a printer malfunction, perform the control panel shutdown first.
¢ Do not plug or unplug the power cord while the printer is powered on.

Restarting, Placing in Sleep Mode, or Powering Off the Printer

At the printer control panel, press the Power/Wake button.
1. To restart the printer, place the printer in Sleep Mode, or power off the printer.
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2. Select an option.
e To restart the printer, touch Restart.
e To place the printer in Sleep Mode, touch Sleep.
In Sleep Mode, the touch screen goes dark and the Power/Wake button flashes.

e To power off the printer, touch Power Off.

o If the printer does not respond to a single press of the Power/Wake button, then press and hold
the button for 5 seconds. A Please Wait message appears as the printer powers down.

After 10 seconds, the touch screen goes dark and the Power/Wake button flashes until the printer
powers down.

@ Caution
Do not unplug the power cord while the printer powers down.

Accessing the Printer

Logging In

Logging inis the process by which you identify yourself to the printer for authentication. If authentication
is set, to access printer features, you log in with your user credentials.

Logging In at the Control Panel

1. At the printer control panel, press the Home button.

2. Touch Log In.

3. Type the User Name using the keypad, then touch Enter.

4. If prompted, enter the password, then touch Enter.
Note

For more information on logging in as system administrator, refer to the System Administrator Guide
at www.xerox.com/office/VLB605_VLB615docs.

5. Touch OK.

Note
To access each password-protected service, enter the User Name and password.

Introduction to Apps

Xerox Apps are a gateway to the features and functions of your device. Standard Apps are already
installed on the device and appear on the Home screen. Some Apps are installed as standard, but hidden
the first time you use the device.

When you log in, the Apps configured for your personal account appear on the control panel.
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You can download more Apps for your device from the Xerox® App Gallery. For more information, refer
to Xerox® Apps Gallery Overview.

Information Pages

Your printer has a set of Information Pages that you can print. These pages include configuration and
font information, demonstration pages, and more.

The following Information Pages are available:

Name Description

Configuration Report

The Configuration Report provides printer information including installed
options, network settings, port setup, tray information, and more.

[x]+]
oo

Billing Summary Report

The Billing Summary Report provides information about the device and
a detailed listing of the billing meters and sheet counts.

Supplies Usage Report

The Supplies Usage Report provides coverage information and part
numbers for reordering supplies.

PostScript Font List

The PostScript Font List provides a printout of all PostScript fonts that
are available on the printer.

PCL Font List

The PCL Font List provides a printout of all PCL fonts that are available
on the printer.

Demonstration Print

Demonstration Print provides a demonstration of the current print-
quality settings.

Startup Page

The Startup Page provides basic printer configuration and network in-
formation.

1 | B | | =]
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Job History Report

The Job History Report provides retained information on previous print
jobs, including the date, time, job type, document name, paper size,
number of pages, and results. The status of a maximum of 20 jobs prints
on the Job History Report.

Printing Information Pages

1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.

3. To print an information page, touch the needed page.
4, To return to the Home screen, press the Home button.
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Configuration Report

The Configuration Report provides product information including installed options, network settings,
port setup, tray information, and more.

Printing the Configuration Report

1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.

3. Touch Configuration Report.

4. To return to the Home screen, press the Home button.

The Embedded Web Server

The Embedded Web Server is the administration and configuration software that is installed in the
printer. It allows you to configure and administer the printer from a Web browser.

The Embedded Web Server requires:

e A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux
environments.

e TCP/IP and HTTP enabled in the printer.

¢ A network-connected computer with a Web browser that supports JavaScript.

Accessing the Embedded Web Server

At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

Finding the IP Address of Your Printer

To install the print driver for a network-connected printer, you need the IP address of your printer. You
also need the IP address to access the settings of your printer through the Embedded Web Server. You
can view the IP address of your printer on the control panel or on the Configuration Report.

Note

To view the TCP/IP address on the control panel, wait until the printer has been on for 2 minutes. If the
TCP/IP address is 0.0.0.0, or begins with 169, it indicates a network connectivity issue. However, note
that if Wi-Fi is set as the primary Ethernet connection, 0.0.0.0 is shown for the printer’s IP address.

Viewing the IP Printer Address on the Control Panel

To view the IP address of the printer on the control panel:
1. At the printer control panel, press the Home button.
2. Touch Device > About.

3. Record the IP address from the display.

4. To return to the Home screen, press the Home button.
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Obtaining the Printer IP Address from the Configuration Report

To obtain the printer IP address from the Configuration Report:
1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.

3. Touch Configuration Report.
The IP address appears in the Connectivity section of the Configuration Report for IPv4 or IPv6.

4. To return to the Home screen, press the Home button.

Installation and Setup

For reference:

e Installation Guide packaged with your printer
e Online Support Assistant at www.xerox.com/office/VLB605_VLB615docs

Installation and Setup Overview

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected.
Configure the initial settings of the printer, then install the print driver software and utilities on your
computer.

You can connect to your printer directly from your computer using USB, or connect to a network using
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different
connection methods. Routers, network hubs and switches, modems, Ethernet cables, and USB cables
are not included with your printer and must be purchased separately. Xerox recommends an Ethernet
connection because it is typically faster than a USB connection, and it provides access to the Embedded
Web Server.

For more information, refer to the System Administrator Guide at
www.xerox.com/office/VLB605_VLB615docs.

Selecting a Location for the Printer
1. Select a dust-free area with temperatures from 10-32°C (50-90°F), and relative humidity 10-85%.

Note
Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can cause
condensation inside the printer, directly interfering with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight
of the printer. The printer must be horizontal with all four feet in solid contact with the surface.
To find the weight for your printer configuration, refer to Weights and Dimensions.

3. Select a location with adequate clearance to access supplies and to provide proper ventilation.
To find the clearance requirements for your printer, refer to Clearance Requirements.

4. After positioning the printer, you are ready to connect it to the power source and computer or network.
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Opening the Output Tray Extension

To provide better support for your prints, open the Output Tray Extension. For printing on longer paper,
lengthen the Output Tray Extension by pulling out the extender until it stops.

Connecting the Printer

Selecting a Connection Method

You can connect the printer to your computer using a USB cable, Ethernet cable, or wireless connection.
The method that you select depends on how your computer is connected to the network. A USB
connection is a direct connection and is the easiest to set up. An Ethernet connection is used to connect
to a network. If you are using a network connection, it is important to understand how your computer
is connected to the network.

Note

Hardware and cabling requirements vary for the different connection methods. Routers, network hubs,
network switches, modems, Ethernet cables, and USB cables are not included with your printer and must
be purchased separately.

uUsB

If you connect the printer to one computer and do not have a network, use a USB connection. A
USB connection offers fast data speeds, but typically not as fast as a network connection.

Note
To access the Embedded Web Server, a network connection is required.

Network

If your computer is connected to an office network or home network, use an Ethernet cable to
connect the printer to the network. You cannot connect the printer directly to the computer via
Ethernet. A connection through a router or network switch is required. An Ethernet network can be
used for one or more computers and supports many printers and systems simultaneously. An
Ethernet connection is typically faster than USB and allows you direct access to the settings of the
printer using the Embedded Web Server.
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Wireless Network

If your environment includes a wireless router or wireless access point, you can connect the printer
to the network with a wireless connection. A wireless network connection provides the same access
and services as a wired connection. A wireless network connection is typically faster than USB and
allows direct access to the settings of the printer using the Embedded Web Server.

Telephone

To send and receive faxes, the multifunction printer must be connected to a dedicated telephone
line.

Connecting to a Computer Using USB

To connect using USB, you need one of these operating systems:

e Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server2008 R2, and Windows
Server 2012.

¢ Macintosh OS X version 10.10 and later.

Note

Your printer supports connection to various UNIX platforms, including Linux, through the network
interface.

For more information, see Installing the Software.

To connect the printer to the computer using a USB cable:

1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the
printer.

2. Connect the A end of the USB cable to the USB port on the computer.

3. If the Windows Found New Hardware Wizard appears, press Cancel.

4. Install the print driver.

Connecting to a Wired Network

1. Ensure that the printer is powered off.

2. Attach a Category 5 or better Ethernet cable from the printer to the network or router socket. Use
an Ethernet switch or router, and two or more Ethernet cables. Connect the computer to the switch
or router with one cable, then connect the printer to the switch or router with the second cable.
Connect to any port on the switch or router except the uplink port.

3. Attach the power cord, then plug in the printer and power it on.

4. Set the network IP printer address, or set up the printer for automatic printer IP detection. For more
information, refer to the System Administrator Guide at
www.xerox.com/office/VLB605_VLB615support.

Connecting to a Wireless Network

A wireless local area network (WLAN) provides the means to connect 2 or more devices in a LAN without
a physical connection. The printer can connect to a wireless LAN that includes a wireless router or wireless
access point. Before connecting the printer to a wireless network, the wireless router must be configured
with a service set identifier (SSID) and any necessary credentials.
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Note
Wireless networking is available only on printers with the optional Wireless Network Adapter installed.

Installing the Wireless Network Adapter

The optional Wireless Network Adapter plugs in to the back of the printer. After the adapter is installed,
and wireless networking is enabled and configured, the adapter is able to connect to a wireless network.

To install the Wireless Network Adapter:
1. Power off the printer.

2. To remove the Wireless Network Adapter Port Cover, press down on the latch, then pull the cover
away from the printer.

3. Remove the packaging from the Wireless Network Adapter.
4, Toinstallthe Wireless Network Adapter, follow the procedure defined on the instruction sheet provided
with the Wireless Network Adapter.
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Note
Pulling on the adapter can damage it. Once installed, remove it only as needed, and as directed in
the Wireless Network Adapter removal instructions. For more information, refer to Removing the

Wireless Network Adapter.

5. Power on the printer.

6. Configure the Wi-Fi settings from the front panel or the embedded web server if connected via
ethernet. For more information, refer to Resetting Wireless Settings.

Removing the Wireless Network Adapter

1. Power off the printer.

Xerox® VersaLink® B605/B615 Multifunction Printer
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2. To unlatch the left-side cover, slide the handle away from the printer, then swing the handle toward
the rear of the printer.

- -

4. Reach into the printer and push the release lever toward the front of the printer. Hold the release
lever in this position and gently pull the Wireless Network Adapter away from the printer.

Note

Do not use force to pull on the Wireless Network Adapter. If the latch is released properly, the adapter
pulls out easily. Pulling on a secured adapter can damage it.
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5. Toreinstall the Wireless Network Adapter Port Cover, insert the bottom tab into the small slot. Gently
press the port cover against the back of the printer until it latches into place.
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7. To latch the cover, swing the handle toward the front of the printer, then push the handle in until it
clicks into the locked position.
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8. Connect the printer to your computer with a USB cable or to a network using an Ethernet cable.

9. Power on the printer.

Resetting Wireless Settings

If the printer was previously installed in a wireless network environment, it could retain setup and
configuration information. To prevent the printer from attempting to connect to the previous network,
reset the wireless settings.

To reset the wireless settings:

At the printer control panel, press the Home button.
Touch Device > Connectivity > Wi-Fi.

Touch the network selection that you want to reset.
Touch Forget This Network.

At the prompt, touch Forget & Reboot.

e wN=

Connecting to a Network with a Wi-Fi Protected Setup

Wi-Fi Protected Setup (WPS) is a network standard for setting up a wireless network. The WPS protocols
enable you to set up devices in a secure wireless network without having wireless networking experience.
With a WPS-certified router, you can use tools in the router and the printer to connect the printer to the
network. To use the tools, ensure that the wireless router is configured properly and is compliant with
the WPS.

e Push Button Connection (PBC) is the easiest way to connect the printer to a wireless network. It
automatically connects when you push a button on the router and on the printer. After the router
and printer exchange information, the printer accepts the security and configuration information
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from the router and connects to the network. The PBC is a moderately secure way to connect the
printer to the network. You do not need to enter any information to make the network connection.

e PIN (Personal Identification Number) automatically connects the printer to a wireless router using
a common PIN. The printer generates and prints a PIN for use in the setup process. When you enter
the PIN into the router, the router broadcasts network information using the PIN. When both devices
recognize the PIN, the router provides the security and configuration information to the printer, which
uses it to connect to the network.

Connecting to a WPS Wireless Network Using the PBC Method

To connect to a Wi-Fi Protected Setup (WPS) wireless network using the Push-Button Connection (PBC)
method:

Note

Before you install the device, ensure that the wireless router is configured properly and is connected to
the network.

1. At the printer control panel, press the Home button.
2. Touch Device > Connectivity > Wi-Fi.
3. If Wi-Fiis Off, turn it on.
a) To toggle Wi-Fi from Off to On, touch the Wi-Fi toggle button.
b) To activate your Wi-Fi setting changes, press the Home button.
c) At the prompt, touch Restart Now.
d) After the printer restarts, touch Device > Connectivity > Wi-Fi.
4. Touch Manual Setup.
5. Touch Wi-Fi Protected Setup (WPS).

Note
If Wi-Fi Protected Setup (WPS) is not visible, at the top of the screen, touch Manual Setup.

6. Touch PBC.
Touch OK.
8. On the wireless router, press the WPS button.

N

Note

If the wireless router does not have a physical PBC button, use your computer to select the virtual
button in the router control panel. For more information, refer to your router documentation.

The router broadcasts setup information for 120 seconds.

9. To activate your Wi-Fi setting changes, restart the printer.
a) Press the Home button.
b) At the prompt, touch Restart Now.
10. After the printer restarts, wait two minutes, then to get the network information that includes the

IP address, print a Configuration Report. For more information, refer to Printing the Configuration
Report.

11. At the printer control panel, press the Home button.
12. If Wi-Fi is Off, turn it on.
a) Touch Device > Connectivity > Wi-Fi.
b) To toggle Wi-Fi from Off to On, touch the Wi-Fi toggle button.
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¢) To activate your Wi-Fi setting changes, press the Home button.
d) At the prompt, touch Restart Now.

Note

The following steps can vary with different router manufacturers. For more information, refer to your
router documentation.

13. At your computer, open the wireless router control panel, then select Add WPS Client.

14. Select PIN Method. The wireless router control panel opens to a dialog box ready for the PIN number.
15. At the printer control panel, touch Device > Connectivity > Wi-Fi.

16. Touch Manual Setup.

17. Touch Wi-Fi Protected Setup (WPS).

Note
If Wi-Fi Protected Setup (WPS) is not visible, at the top of the screen, touch Manual Setup.

18. Touch PIN.
19. Record the PIN from the screen, then touch OK.

Note

The printer continues to advertise for 120 seconds. If the printer does not locate the wireless router
within 120 seconds, the connection attempt stops.

The printer starts advertising using the displayed PIN Code.

20. At your computer, in the wireless router control panel Client PIN Code field, enter the PIN code, then
click Next.

The printer communicates with the wireless router to resolve setup and configuration information.
When the printer has the correct information, it connects to the router and restarts with the proper
setup and configuration information.

If the router does not connect with the printer within 120 seconds, the connection attempt stops.

21. After the printer restarts, wait 20 seconds, then to get the network information that includes the IP
address, print a Configuration Report. For more information, refer to Printing the Configuration
Report.

Connecting to a WPS Wireless Network Using the PIN Method

To connect to a Wi-Fi Protected Setup (WPS) wireless network using the PIN method:

Note
Before you install the printer, ensure that you connect and configure the wireless router for the network.

1. At the printer control panel, press the Home button.

2. If Wi-Fi is Off, turn it on.
a) Touch Device > Connectivity > Wi-Fi.
b) To toggle Wi-Fi from Off to On, touch the Wi-Fi toggle button.
¢) To activate your Wi-Fi setting changes, press the Home button.
d) At the prompt, touch Restart Now.

Note

The following steps can vary with different router manufacturers. For more information, refer
to your router documentation.
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3. At your computer, open the wireless router control panel, then select Add WPS Client.
4. Select PIN Method. The wireless router control panel opens to a dialog box ready for the PIN number.
5. At the printer control panel, touch Device > Connectivity > Wi-Fi.
6. Touch Manual Setup.
7. Touch Wi-Fi Protected Setup (WPS).
Note
If Wi-Fi Protected Setup (WPS) is not visible, at the top of the screen, touch Manual Setup.
8. Touch PIN.

9. Record the PIN from the screen, then touch OK.

The printer starts advertising using the displayed PIN Code.

Note

The printer continues to advertise for 120 seconds. If the printer does not locate the wireless router
within 120 seconds, the connection attempt stops.

10. At your computer, in the wireless router control panel Client PIN Code field, enter the PIN code, then
click Next.

The printer communicates with the wireless router to resolve setup and configuration information.
When the printer has the correct information, it connects to the router and restarts with the proper
setup and configuration information.

If the router does not connect with the printer within 120 seconds, the connection attempt stops.

11. After the printer restarts, wait 20 seconds, then to get the network information that includes the IP
address, print a Configuration Report. For more information, refer to Printing the Configuration
Report.

Connecting to a Wireless Network Manually

When connecting to a wireless network that does not include a WPS-compliant router, set up and
configure the printer manually. Before starting, obtain the router setup and configuration information,
such as name and passphrase. For assistance, contact your system administrator.

To connect to a wireless network manually:

1. At the printer control panel, press the Home button.

2. Touch Device > Connectivity > Wi-Fi.

3. If Wi-Fi is Off, turn it on.
a) To toggle Wi-Fi from Off to On, touch the Wi-Fi toggle button.
b) To activate your Wi-Fi setting changes, press the Home button.
c) At the prompt, touch Restart Now.
d) After the printer restarts, touch Device > Connectivity > Wi-Fi.

4, To connect to a network:

e Touch the name of the network, enter the password for the selected network, then touch OK.

o If the desired network does not appear, touch Manual Setup, then configure the wireless network
settings.

For Enter the Network Name (SSID), type the name (SSID) of your network, then press OK.
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Touch Security, then select the security method that your wireless network uses.
Touch Enter Password, then enter the password for your wireless network.
Touch OK.

5. To activate your Wi-Fi setting changes, press the Home button.
At the prompt, touch Restart Now.

7. After the printer restarts, wait two minutes, then to get the network information that includes the
IP address, print a Configuration Report. For more information, refer to Printing the Configuration
Report.

o

Connecting to Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smartphone,
using Wi-Fi Direct. Wi-Fi Direct is disabled by default.

Note

Wireless networking is available only on printers with the optional Wireless Network Adapter installed.

Connecting with Wi-Fi Direct from Your Mobile Device

To connect with Wi-Fi Direct, follow the directions provided with your mobile device.

Connecting to a Telephone Line

@ Warning
To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger telecommunication line
cord.

1. Ensure that the printer is powered off.

2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on
the back of the printer.

3. Connect the other end of the RJ11 cable to an operating telephone line.
4. Power on the printer.
5. Enable and configure the Fax functions.

Initial Printer Setup

Before installing the printer software, verify that the printer is set up correctly. Setup includes enabling
the optional features and assigning an IP address for the Ethernet network connection. The installation
wizard starts automatically the first time the printer is powered on. The installation wizard prompts the
system administrator to configure the following settings:

e Language

¢ Network Connection

e Proxy Server Setup

e Date and Time

e Measurements

o LDAP Settings

e Apps Setup
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e Security Settings

For more information on configuring the printer settings, refer to the System Administrator Guide at
www.xerox.com/office/VLB605_VLB615docs.

Configuring AirPrint

AirPrint® is a software feature that allows you to print from wired or wireless Apple i0OS-based mobile
devices and Mac OS-based devices without the need to install a print driver. AirPrint®-enabled printers
allow you to print directly from a Mac, an iPhone, iPad, or iPod touch. You can use AirPrint® to print from
a wired device or a wireless device without using a print driver.

AirPrint

Note

e Not all applications support AirPrint®.
o Wireless devices must join the same wireless network as the printer.
e For AirPrint® to function, both IPP and Bonjour® (mDNS) protocols must be enabled.

e The device that submits the AirPrint® job must be on the same subnet as the printer. To allow devices
to print from different subnets, configure your network to pass multicast DNS traffic across subnets.

e The Mac OS device must be Mac OS 10.10 or later.
e AirPrint®-enabled printers work with all models of iPad, iPhone (3GS or later), and iPod touch (third
generation or later), running the latest version of iOS.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

Note
If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, click Home > Connectivity.

Note
If this feature does not appear, log in as a system administrator.

3. For Mobile Printing, click AirPrint®.
4. To enable AirPrint®, click the Enable toggle button.
Note
AirPrint® is enabled by default when IPP and Bonjour® (mDNS) are both enabled.

e To change the printer name, in the Name field, enter a new name.
o To enter a location for the printer, in the Location field, enter the location of the printer.

e To enter a physical location or address for the printer, in the Geo-Location field, enter the
geographic latitude and longitude coordinates in decimal form. For example, use coordinates
such as 45.325026, -122.766831 for a location.

5. Click OK.
6. To activate your changes, at the prompt, click Restart Now.
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Configuring Google Cloud Print

Google Cloud Print allows you to print documents that are stored in the cloud without using a print
driver.

Before you begin:

e Set up a Google email account.
e Configure the printer to use IPv4.
o Configure Proxy Server settings as needed.

To configure Google Cloud Print:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.
Note
If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, click Home > Connectivity.

3. For Mobile Printing, click Google Cloud Print.

4. To enable Google Cloud Print, click the Enable toggle button.

5. Click OK.

6. Restart the printer, then wait 2 minutes for the printer to connect.

7. Refresh your Web browser, then for Mobile Printing, click Google Cloud Print.
8. Click Printer Registration.
9. Click Register.

A printer registration page prints.

10. To register the printer, in your Web browser, type the URL provided, or use your mobile phone to scan
the barcode.

After the printer is registered, a confirmation status window appears.

11. To access the Google Cloud Print feature, in your Google account, click Manage Your Printer.

Note
The default printer name appears in this format: Model name (MAC address).

Installing the Software

Before installing driver software, verify that the printer is plugged in, powered on, connected correctly,
and has a valid IP address. The IP address usually appears in the upper, right corner of the control panel.
If you cannot find the IP address, see Finding the IP Address of Your Printer.

Note

If the Software and Documentation disc is not available, download the latest drivers from
www.xerox.com/office/VLB605_VLB615drivers.
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Operating System Requirements

Windows Vista, Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008
R2, and Windows Server 2012.

Macintosh OS X version 10.10 and later.

UNIX and Linux: Your printer supports connection to various UNIX platforms through the network
interface.

Installing the Print Drivers for a Windows Network Printer

1.

ounswN

13.

Insert the Software and Documentation disc into the appropriate drive on your computer. If the
installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer
file.

Note

If the Software and Documentation disc is not available, download the latest drivers from
www.xerox.com/office/VLB605_VLB615drivers.

Select your printer model.

Click Install Drivers.

Select Install Print Driver, Install Scan Driver, or Install Print and Scan Drivers.
At the License Agreement, click I Agree.

From the list of discovered printers, select your printer.

Note

When installing drivers for a network printer, if your printer does not appear in the list, click the IP
Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of your
printer, then click Search to locate and select your printer. If you do not know the IP address of the
printer, refer to Finding the IP Address of Your Printer.

Click Next.
If needed, you can name your printer by typing a name in the Queue Name field.
If installing a print driver, make a print driver selection.

. If installing a scan driver, make a scan driver selection.
. Click Install.
. If needed, set the printer as the default printer.

Note
Before selecting Share Printer, contact your system administrator.

To complete the installation, click Finish, then click Close.

Installing the Print Drivers for a Windows USB Printer

1.

Insert the Software and Documentation disc into the appropriate drive on your computer.

Note
If the Software and Documentation disc is not available, download the latest drivers from
www.xerox.com/office/VLB605_VLB615drivers.

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe
installer file.
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Click Install Software.

At the License Agreement, select I Agree, then click Next.

To install the printer support software, select Software, then click Next.

In the Software and Documentation window, clear the check box for any unnecessary options.
Click Next.

To complete the installation, click Finish.

Installing the Drivers and Utilities for Macintosh OS X

1. Insert the Software and Documentation disc into the appropriate drive on your computer.
Note
If the Software and Documentation disc is not available, download the latest drivers from
www.xerox.com/office/VLB605_VLB615drivers.
2. Open Xerox® Print Drivers 3.xx.x.dmg/.pkg as needed for your printer.
3. To run Xerox® Print Drivers 3.xx.x.dmg/.pkg, double-click the appropriate file name.
4. When prompted, click Continue.
5. To accept the license agreement, click I Agree.
6. To accept the current installation location, click Install, or select another location for the installation
files, then click Install.
7. If prompted, enter your password, then click OK.
8. From the list of discovered printers, select your printer, then click Next.
9. If your printer does not appear in the list of discovered printers:
a) Click the Network Printer Icon.
b) Type the IP address of your printer, then click Continue.
¢) Select your printer in the list of discovered printers, then click Continue.
10. If your printer was not detected, verify that the printer is powered on and that the Ethernet or USB
cable is connected properly.
11. To accept the print queue message, click OK.
12. Select or clear the Set Printer as Default and Print a Test Page check boxes.
13. Click Continue, then click Close.
Adding the Printer

For networking, set up your printer using Bonjour® (mDNS), or connect using the IP address of your
printer for an LPD/LPR connection. For a non-network printer, create a desktop USB connection.

Online Support Assistant at: www.xerox.com/office/VLB605_VLB61 5support

Adding the Printer Using Bonjour

To add the printer using Bonjour®:

1.
2.

From the computer Applications folder or from the dock, open System Preferences.
Click Printers & Scanners.

The list of printers appears on the left of the window.

For the list of printers, click the Plus icon (+).

. At the top of the window, click the Default icon.
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5.

Select your printer from the list, then click Add.

Note

If your printer is not detected, verify that the printer is powered on and that the Ethernet cable is
connected properly.

Adding the Printer by Specifying the IP Address

To add the printer by specifying the IP address:

1.
2.

10.

WO NOULEW

From the computer Applications folder or from the dock, open System Preferences.
Click Printers & Scanners.

The list of printers appears on the left of the window.

Under the list of printers, click the Plus icon (+).

Click IP.

From the Protocol list, select the protocol.

In the Address field, enter the IP address of the printer.

In the Name field, enter a name for the printer.

From the Use list, choose Select a driver to use.

From the printer software list, select the print driver for your printer model.
Click Add.

Installing Scan Drivers for Macintosh

. Insert the Software and Documentation disc into your computer.

To view the .dmg file for your printer, double-click the Disc icon on your desktop .

Open the Scan Installer.dmg file, then navigate to the appropriate installer file for your operating
system.

Open the Scan Installer package file.
To acknowledge the warning and introductory messages, click Continue.
To accept the license agreement, click Continue, then click Agree.

To accept the current installation location, click Install, or select another location for the installation
files, then click Install.

Enter your password, then click OK.

. Select your printer then click Continue.
10.
11.

In the list of discovered printers, click Continue Installation.
To restart, click Log Out.

Installing LAN Fax Drivers for Macintosh

1.
2.
3.

Nowu-LE

Insert the Software and Documentation disc into your computer.
To view the .dmg file for your printer, double-click the Disc icon on your desktop.

Open the LAN Fax Installer.dmg file, then navigate to the appropriate installer file for your operating
system.

Open the LAN Fax Installer package file.
To acknowledge the warning and introductory messages, click Continue.
To accept the license agreement, click Continue, then click Agree.

To accept the current installation location, click Install, or select another location for the installation
files, then click Install.
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8. Enter your password, then click OK.

9. Select your printer in the list of discovered printers, then click Continue.
10. Click Continue Installation.
11. To finish, click Close.
12. To register your printer and software, complete the registration form.

Adding a LAN Fax Printer for Macintosh

After installing the LAN fax driver on a Macintosh computer, use Bonjour to set up your printer. You can
also add the printer using the IP Address of the printer for an LDP/LPR connection. For non-network
printers, create a desktop USB connection.

Installing Drivers and Utilities for UNIX and Linux

For more information on installing print drivers and utilities for UNIX and Linux, refer to UNIX and Linux
Printing.

Installing the Printer as a Web Service on Devices

Web Services on Devices (WSD) allows a client to discover and access a remote device and its associated
services across a network. WSD supports device discovery, control, and use.

Using the Add Device Wizard to Install a WSD Printer

To install a WSD printer using the Add Device Wizard:

1. At your computer, click Start, then select Devices and Printers.

2. To launch the Add Device Wizard, click Add a Device.

3. In the list of available devices, select the one you want to use, then click Next.

Note

If the printer you want to use does not appear in the list, click the Cancel button. Add the WSD printer
manually using the Add Printer Wizard.

4. Click Close.
Using the Add Printer Wizard to Install a WSD Printer

To install a WSD printer using the Add Printer Wizard:

At your computer, click Start, then select Devices and Printers.

To launch the Add Printer Wizard, click Add a Printer.

Click Add a network, wireless, or Bluetooth printer.

In the list of available devices, select the one you want to use, then click Next.

If the printer you want to use does not appear in the list, click The printer that I want is not listed.
Select Add a printer using a TCP/IP address or hostname, then click Next.

From the Device type field, select Web Services Device.

In the Hostname or IP address field, enter the printer IP address, then click Next.

Click Close.
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More Information

You can obtain more information about your printer from these sources:

Resource Location

Installation Guide

Packaged with the printer.

Other documentation for your printer

www.xerox.com/office/VLB605_VLB615docs

Recommended Media List

United States: www.xerox.com/rmlna
European Union: www.xerox.com/rmleu

Technical support information for your printer; including
online technical support, Online Support Assistant, and
print driver downloads.

www.xerox.com/office/VLB605_VLB615support

Information Pages

Print from the control panel. For details, refer to Inform-
ation Pages.

Order supplies for your printer

www.xerox.com/office/VLB605_VLB615supplies

Local sales and Technical Customer Support

www.xerox.com/office/worldcontacts

Printer registration

www.xerox.com/office/register

Xerox © Direct online store

www.direct.xerox.com/
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Customize and Personalize

Customize and Personalize Overview

This chapter provides information on how to customize and personalize your device to meet the specific
demands of your workflows.

. You can customize your apps, hide, or show apps on the Home screen, and rearrange the
\Ya order to suit your job priorities. For each app, you can hide or show individual features and
aa configure default settings to meet the needs of your workgroup. You can save job settings

for repeated use.

Customization enables users to work more productively.

When individual user accounts are configured on the device, you can personalize the device
. to meet specific user needs. You can configure your personal Home page to hide or show
- only the apps you use. Each of the feature lists can be tailored to your job requirements.

Default settings for each app can be specified, and settings for regular jobs can be saved
for your use.

Personalization options ensure that the features and functions displayed meet individual
user needs, improving efficiency.

Customizing or Personalizing the Home Screen

Hiding or Showing an App on the Home Screen

1. At the printer control panel, press the Home button.

2. Touch Customize.

3. To display an installed app that is hidden initially:
a) Touch the Plus (+) icon.
b) Touch the app that you want to appear on the control panel.
c) Touch Done.

4. To hide an installed app:
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a) For the app, touch X.
b) Touch Done.

5. Verify that only the selected apps appear on the Home screen.

Rearranging Apps on the Home Screen

At the printer control panel, press the Home button.

Touch Customize.

Touch and hold the required app.

Drag the app to the new location.

Release the app.

Touch Done.

Verify that the apps appear in the correct location on the Home screen.

NounLswN-=

Customizing or Personalizing the Apps

Customization enables you to modify the features available, delete a saved preset, or remove customized
settings applied to an app.

Customizing or Personalizing the Feature List

To customize the Features list for an app:

1. At the printer control panel, press the Home button.
2. Touch the app required.

3. Scroll to the bottom, then touch Customize.

4. Touch Feature List.

Note

For logged-in administrators, a window appears that asks you to confirm if the changes are for a

Guest or for you.

5. Touch the particular option.

o Tohide afeature, for the required feature, touch the Eye icon. To signify that the feature is hidden,
the Eye icon appears with a line across it.

e To show a feature, for the required feature, touch the Eye icon. To signify a feature is visible, the
Eye icon appears with no line across it.

6. To reorder the menu features, touch and drag the features into the appropriate order.
7. To save the current configuration, touch Done.

Customizing or Personalizing the Entry Screen

The Entry Screen appears when the Fax, Email, USB or Scan To Apps are selected. The Entry Screen
provides options for entering recipient or destination details for a job. Use this procedure to choose the
options that to appear on the Entry Screen.

To customize the Entry Screen for an App:
1. At the printer control panel, press the Home button.
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Touch the App required.

Scroll to the bottom, then touch Customize.
Touch Entry Screen.

Touch the needed options.

Note

For logged-in administrators, a window appears that asks you to confirm if the changes are for a
Guest or for you.

To save the current configuration, touch X.

Saving Presets

You can use this feature to save a particular combination of App settings for future jobs. You can save
the settings with a name and retrieve them for later use.

To save the current App settings:

WRNOULEWN=

At the printer control panel, press the Home button.

Touch the App required.

Select the job settings.

Scroll to the bottom, then touch Save.

Touch Save as New Preset.

Touch Enter Preset Name, then to enter a preset name, use the keypad.
Touch Next.

Select an icon that best suits the preset that you are creating.

Touch Done.

Note
The preset is stored within the Preset feature.

Deleting a Saved Preset

To delete a saved preset:

NounLswN-=

At the printer control panel, press the Home button.

Touch the app required.

Scroll to the bottom, then touch Customize.

Touch Presets.

Touch the Trash icon that corresponds with the preset that you want to delete.
At the prompt, touch Delete.

Touch Done.

Removing App Customization

To remove the current App customization settings:

s wN=

At the printer control panel, press the Home button.
Touch the App required.

Scroll to the bottom, then touch Customize.

Touch Remove App Customization.

At the prompt, touch OK.
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Customizing App Default Settings

To customize the App default settings:

v wN=

3-4

At the control panel, press the Home button.

Touch the App required.

Configure the required default settings.

Touch Save.

Touch Save Defaults. The new settings override the previous default settings.
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Xerox® Apps are a gateway to the features and functions of your device. There are standard apps already
installed and displayed on the Home screen. There are also apps that are installed as standard but are
hidden when your device is used for the first time.

For more information about customizing the Home screen and the apps features, refer to Customize
and Personalize.

A range of apps is available for download and installation from the Xerox® App Gallery. These include
Xerox® Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed apps on
compatible printers.

Xerox® App Gallery

Xerox® App Gallery Overview

Use the Xerox® App Gallery to find Apps that provide new features or capabilities for your
device. The Xerox® App Gallery provides direct access to Apps that can improve your pro-
ductivity, simplify workflows, and enhance your user experience.

The Xerox® App Gallery enables you to browse and update apps easily. You can browse through the App library
without logging in. The moving banner provides an active display of apps, or you can scroll the full list of apps.
To get more details on an app, touch the app name in the list.

To use the Xerox® App Gallery App, ensure that your device uses either the wireless or the wired network
connection.
Note

If a local server inside a firewall hosts your device and a proxy is enabled, set a proxy exception at the
device.

For more information and instructions on using the Xerox® App Gallery, refer to the Xerox® App Gallery
User Guide available at www.xerox.com/XeroxAppGalleryDocumentation.
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Creating a Xerox® App Gallery Account

With an App Gallery account, you have direct access to all the available Apps for your device. An App
Gallery account allows you to view and acquire Apps, install Apps on your device, and manage your Apps
and licenses.

You can set up an App Gallery account using the control panel or from the Xerox® App Gallery web site.
To set up an App Gallery account from the web site, go to appgallery.external.xerox.com/XeroxAppGallery,
select Login > Create Account, and follow the instructions.

Note
If you have an existing Xerox App Gallery Account, refer to Logging in to Your Xerox App Gallery Account.

To create an App Gallery account using the control panel:

1.
2.
3.

10.

11.
12.
13.

At the printer control panel, press the Home button.
Touch Xerox® App Gallery.
To request a new account, minimize the on-screen keyboad, and touch Request an Account.

Note

For detailed information and instructions on using the Xerox® App Gallery, refer to the Xerox® App
Gallery User Guide available at www.xerox.com/XeroxAppGalleryDocumentation.

. Touch the Enter your email address. Enter a valid email address using the touch screen keypad, then

touch Enter.

Touch OK. A message is displayed stating completion instructions have been sent to the email address
entered.

Touch Close.
Access your email account for the email address that you provided to Xerox® App Gallery.

Open the Xerox® App Gallery Account Request email, then click the URL link to access the create
account page.

Review and accept the Terms of Use. To continue creating an account, click the Agree button.
Enter the information required into the appropriate fields:

e UserID

e Password

e Confirm Password

e First and Last Name

e Company Name

e Address (Street, City, State/Province, Postal)
e Country

Click OK.
After the account is created, a confirmation message appears.
At the printer control panel, log in to your App Gallery Account.

Logging into your Xerox® App Gallery Account

When you are logged in to the App Gallery, you can browse available Apps, and install and update Apps.
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To log in to your App Gallery Account:

At the printer control panel, press the Home button.

Touch Xerox® App Gallery.

Enter your User Name using the touch screen keypad, then touch Enter.
Enter your Password using the touch screen keypad, then touch Enter.
Touch Log In. The Xerox® App Gallery appears.

nnswN =

Installing or Updating an App from the Xerox® App Gallery

Xerox® Apps add, extend, or customize the functionality of your device. You can use the Xerox® App
Gallery App to browse and install Apps at your device control panel.

Installing an App from the App Gallery

1. At the printer control panel, press the Home button.
2. Touch Xerox® App Gallery.

Note

You can browse the App Gallery and view app descriptions without being logged in. To download or
update apps, you must be logged in to the App Gallery.

Enter your User Name using the touch screen keypad, then touch Enter.

Enter your Password using the touch screen keypad, then touch Enter.

Touch Log In. The Xerox® App Gallery appears.

Touch the app required, then touch Install. The License Agreement screen appears.

ounesw

Note
If the app was installed previously and a new version is available, the button is labeled as Update.

7. Touch Agree. The installation process begins.
If the app is not successfully installed, to attempt the installation process again, touch Install.

8. To exit the Xerox® App Gallery, touch Exit.

Updating an App from the App Gallery

At the printer control panel, press the Home button.

Touch Xerox® App Gallery.

Enter your User Name using the touch screen keypad, then touch Enter.

Enter your Password using the touch screen keypad, then touch Enter.

Touch Log In. The Xerox® App Gallery appears.

Touch the app required, then touch Update. The License Agreement screen appears.
Touch Agree.

When the update is complete, the Update button is labeled as Installed.

To exit the Xerox® App Gallery App, touch Exit.
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Device

Device Overview

The Device App gives you access to information about your printer, including the serial
number and model. You can view the status of the paper trays, billing and supplies in-
formation, and print Information Pages.

You can configure many Device options to meet your individual needs. For details about configuring all
Device settings, refer to the System Administrator Guide at
www.xerox.com/office/VLB605_VLB615support.

Device Options

The following Device options are available:

Description

Language

Language allows you to set the language that appears on the control panel.

About

The About option provides an overview of your device and its current settings
and status. You can access Information Pages and reports using this option.

Software Update

Use this option to check for software updates and configure update settings.

Notifications

Use the Notifications option to see details of current alerts or faults on the
device. A History button displays fault codes and the date that the fault oc-
curred on the device.

Paper Trays

Use the Paper Trays option to see the paper size, type, and color set for each
paper tray and the tray-capacity status.

Supplies

Use the Supplies option to monitor the status of the components you can
replace. The supply level and estimated number of impressions or days left
for each unit is displayed.

Billing/Usage

Use the Billing/Usage option to view the serial number and the total number
of impressions made by your device.

General

Use the General option to customize settings such as the power-saver modes,
date and time, and control panel brightness. You can configure the General
settings using the device control panel, or by using the Embedded Web
Server.
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Option Description

Apps Use Apps to select settings for the Apps installed on your device.
Connectivity Use the Connectivity option to configure network settings at the control
‘., panel, or join another wireless network.

Support Use this option to access and print the Support Pages to assist with
troubleshooting errors.

/ Resets Use the Resets option to reset device settings and font, forms, and macros
/ to the factory-default settings.

For details on configuring the printer settings, refer to the System Administrator Guide at
www.xerox.com/office/VLB605_VLB615docs.

About

The About option provides an overview of your device and current settings and status. You can access
Information Pages and reports using this option.

Supply Status

You can check the status and percentage of life remaining for your printer supplies at the control panel
or from the Embedded Web Server. When printer supplies near their replacement time, warning alerts
appear on the control panel. You can customize the alerts that appear on the control panel and configure
email alert notifications.

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System
Administrator Guide at www.xerox.com/office/VLB605 VLB615docs.

Checking the Supplies Status at the Control Panel

1. To view status information for the printer supplies, touch Device > Supplies.

2. To view details about a specific item, including part numbers for reordering, touch the specific item.
3. To return to the Supplies screen, touch X.

4. To return to the Device screen, touch the back arrow.

Customizing Supplies Alert Settings

1. To customize the alerts that appear for printer supplies, touch Device > Supplies > Alerts Setup.

2. To enable supplies alerts that appear on the control panel, touch the Enable Alerts toggle button.

3. To configure the printer to display an alert when an item reaches a specific usage percentage level,
touch the item, then select the percentage.

4. To customize the alerts for each supply item, or to enable or disable an alert, touch the toggle button.

To return to the Supplies screen, touch X.

6. To return to the Device screen, touch the back arrow.

v
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Setting Up Email Alerts

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System
Administrator Guide at www.xerox.com/office/VLB605_ VLB615docs.

1. To set up alerts to send to an email address, touch Device > Supplies > Email Alerts.
2. To enter an email address, touch Add Email, then touch Enter Email Address.

3. Use the touch screen keyboard to enter an email address, or select an entry from the Address Book,
then touch OK.

Add more email addresses if necessary.

To customize the alerts for each supply item, or to enable or disable an alert, touch the toggle button.
To exit the menu, touch OK.

To return to the Device screen, touch the back arrow.
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Billing and Usage Counters

The Billing/Usage menu displays the total number of impressions that the printer generated or printed
during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper. For
example, a sheet of paper that is printed on two sides counts as two impressions.

To view the Billing and Usage Counters:

1. At the printer control panel, press the Home button.

2. Touch Device > Billing/Usage.

3. To view more details, touch Usage Counters, then select an option.

e Impression Counters: This option provides the number of impressions made by the printer. The
number of impressions cannot equal the number of sheets counted, depending on the printer
setup. If your printer is set up to count large sheets as large impressions or as multiple smaller
impressions, the number of impressions can differ.

o Sheet Counters: This option provides the number of impressions made by the printer. Impressions
for 2-Sided sheets are identified as a separate line from 1-Sided sheets.

e Images Sent Counters: This option provides the number of images sent using the Fax, Email, or
Scan features.

o Fax Impressions Counters: This option provides the number of images sent using the Fax features.
Each fax feature is identified on a separate line.

e All Usage Counters: This option provides all printer usage information.

4. After viewing the usage readings, to return to the Home screen, press the Home button.

Reset to Factory Defaults

@ Caution

The Reset to Factory Defaults feature erases all settings and returns the printer to the original factory
state. All jobs, presets, Apps, and device settings are reset. If the printer includes a hard disk, the disk is
reinitialized.

The non-volatile memory (NVRAM) stores printer settings, even after the power is turned off. When
complete, the printer restarts, then displays the Install Wizard.

4-6 Xerox® VersaLink® B605/B615 Multifunction Printer
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB605_VLB615&PgName=userdocpdfs&FileName=user_guide&Language=English

Xerox® Apps

To reset the printer to factory defaults:

1. At the printer control panel, press the Home button.

2. Touch Device > Resets > Reset to Factory Defaults.

3. At the prompt, touch Reset.

4. When the process is complete, the printer restarts automatically.

Remote Services

You can use the Remote Services option in the Embedded Web Server to send error and usage information
to the Xerox support team to help them resolve problems quickly.

For information about enabling Remote Services and uploading information to Xerox, refer to the System
Administrator Guide at www.xerox.com/office/VLB605_ VLB615docs.

Address Book

Address Book Overview

Use the Device Address Book to create individual contacts or group contacts for use with
the Email, Fax, and Scan To Apps. You can add contacts to the Device Address Book using
the control panel or the Embedded Web Server. This feature can also be used to scan to
the Address Book contacts.

The Device Address Book stores a maximum of 2000 contacts, with or without the optional Productivity
Kit. If the Create New Contact button is unavailable, the address book has reached capacity.

Before you can use this feature, the System Administrator must enable users to view and manage the
Device Address Book.

Editing the Address Book

You can create and save contact information for individual contacts or groups. You can manage address
book contacts at the control panel, or in the Embedded Web Server.

Adding or Editing Contacts in the Address Book at the Control Panel

Adding Contacts in the Address Book at the Control Panel
1. At the printer control panel, press the Home button.

2. Touch Address Book.

3. Touch the Plus icon (+), then select Add Contact.

4

. To enter a name, touch the Enter First Name, Enter Last Name, or Enter Company field, then enter
the information. To move to the next field, touch Next. When finished, touch Enter.
5. Enter the contact details:

e To add an email address to the contact, touch Add Email. Enter an email address, then touch
Enter.

¢ To add a fax number to the contact, touch Add Fax. Enter a fax number, then touch Enter.

e To add an SMB scan location, touch Add SMB. Browse to the location required, then touch Enter.
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6.
7.
8.

e Toadd an FTP scan location, touch Add FTP. Browse to the FTP location or enter the FTP address,
then touch Enter.
Note
If authentication is required for scan locations, enter a valid login name and password.

To mark the email address or fax number as a favorite, touch the Star icon.
To save the contact, touch OK.
To return to the Home screen, press the Home button.

Editing or Deleting Contacts in the Address Book at the Control Panel

1.

5.
6.
7.

At the printer control panel, press the Home button.

2. Touch Address Book.
3.
4. To change contact information, touch the information that you want to update, edit as needed, then

From the Address Book, touch a contact name, then touch Edit.

touch OK.

To save your contact changes, touch OK.

To delete a contact, touch Delete Contact, then touch Delete.
To return to the Home screen, press the Home button.

Adding or Editing Groups in the Address Book at the Control Panel

Adding Groups in the Address Book at the Control Panel
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At the printer control panel, press the Home button, then touch Address Book.
Touch the Plus icon (+), then select Add Group.

Select the group type, enter a name for the group, then touch Enter.

To add group members, touch Add Member.

To add a contact name, from the Favorites or Contacts menu, select a contact.
To add more group members, touch Add Member, then select a contact.

To mark the group as a favorite, touch the Star icon.

To save the group, touch OK.

To return to the Home screen, press the Home button.

Editing or Deleting Groups in the Address Book at the Control Panel

Y
©
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At the printer control panel, press the Home button.

Touch Address Book.

From the Address Book, select a group, then touch Edit.

To add group members, touch Add Member.

To add a contact, from the Favorites or Contacts menu, select a contact.

To add more group members, touch Add Member, then select a contact.

To remove group members, for each contact, touch the Trash icon. At the prompt, touch Delete.
To save the changes, touch OK.

To delete the group, touch Delete Group, then touch Delete.

To return to the Home screen, press the Home button.
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Adding or Editing Contacts in the Address Book in the Embedded Web Server
Adding Contacts in the Address Book in the Embedded Web Server

To add contacts:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

In the Embedded Web Server, click Address Book.

Click Add Contact.

To enter a name, click the First Name, Last Name, or Company field, then enter the details.
Enter the contact details.
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e To add an email address to the contact, click the Email Plus icon (+), then enter an email address.

e To add a fax number to the contact, click the Fax Plus icon (+), then enter a fax number.

e To add an SMB scan location, click the (Network) SMB Plus icon (+), then enter the SMB details.
Click OK.

e To add an FTP scan location, click the FTP Plus icon (+), then enter the FTP details. Click OK.

6. To mark the email address or fax number as a favorite, touch the Star icon.
7. To save the contact, click OK.

Editing or Deleting Contacts in the Address Book in the Embedded Web Server

To edit or delete contacts:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

2. In the Embedded Web Server, click Address Book.

3. From the Address Book, select a contact.

4. To edit contact information, perform the following steps.
a) Click the contact name or contact information, then edit as needed.
b) To clear contact information, for the specific contact information, click the Trash icon.
¢) To save the changes, click OK.

5. To remove the selected contact from the Address Book, click Delete. At the prompt, click Delete.
Adding or Editing Groups in the Address Book in the Embedded Web Server
Adding Groups in the Address Book in the Embedded Web Server

To add groups:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

In the Embedded Web Server, click Address Book.

Click Add Group.

For Enter Group Name, enter a name for the group.

From the menu, select the group type.

To add group members, for Members, click the Plus icon (+).

To add contacts to the group, in the Add Members window, for each contact, select the check box.
When you are finished, click OK.

Nowus>wN
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8. To save the group, click OK.
Editing or Deleting Groups in the Address Book in the Embedded Web Server

To edit or delete groups:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

2. In the Embedded Web Server, click Address Book.
3. Within the address book, select a group.
4. To add group members:
a) For Members, click the Plus icon (+).
b) In the Add Members window, click the check box for each desired member.
¢) To save the changes, click OK.
5. To remove group members:
a) For the desired member, click the Trash icon.
b) At the prompt, click Delete.
¢) Repeat the previous two steps for each member.
d) To save the changes, click OK.

6. To remove the selected group from the Address Book, click Delete. At the prompt, click Delete.
Advanced Settings

The Advanced option provides more settings forimporting and exporting contact details and managing
contacts. You can use the Advanced option to set up a directory service.

For details about the Advanced options, refer to the System Administrator Guide at
www.xerox.com/office/VLB605_VLB615docs.

Managing Favorites

You can mark contacts as Favorites. A star next to a contact in the list indicates a Favorite. You can mark
a favorite as a Global Favorite for all services or as a Favorite for email, fax, or scan-to destinations.

Managing Favorites at the Control Panel

1. At the printer control panel, press the Home button, then touch Address Book.
2. Select a contact, then touch Edit.
3. To make the contact a Global Favorite, for the contact name, touch the Star icon.
4. To mark a contact as a Favorite for email, fax, or a scan-to destination:

a) For each desired feature, touch the Star icon.

b) To save changes, touch OK.

5. To clear a contact marked as a Favorite:

a) To remove the contact as a Global Favorite, for the contact name, touch the Star icon.

b) To remove the contact from the Favorite list for a selected feature, for the selected feature,
touch the Star icon.

c) To save changes, touch OK.

6. To return to the Home screen, press the Home button.
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Managing Favorites in the Embedded Web Server

1. In the Embedded Web Server, click Address Book.

2. Select a contact.

3. To make the contact a Global Favorite, click the Global Favorite Star icon.
4

. To mark a contact as a Favorite for email, fax, or a scan-to destination, for each feature, click the
Star icon.

5. To remove a contact marked as a Favorite, for Global Favorite or the selected feature, touch the Star
icon. The contact is removed from the Global Favorite list, or the Favorite list for the selected feature.

6. To save changes, click OK.

Jobs

Jobs Overview

— Use Jobs to view current jobs, print saved, personal, and secure jobs, and view details of
p— completed jobs. You can pause, delete, print, or view job progress or job details for a selected

— N

Managing Jobs

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs. You
can pause, delete, print, or view job progress or job details for a selected job. From the Jobs window in
the Embedded Web Server, you can view a list of active and completed print jobs. For more information,
refer to Managing Jobs Using the Embedded Web Server.

A print job can be held by the printer when it is unable to complete a print job. For example, when the
printer needs attention, paper, or supplies. When the condition is resolved, the printer automatically
resumes printing. When you send a Secure Print job, the job is held until you release it by typing a
passcode at the control panel. For more information, refer to Managing Special JobTypes.

Pausing the Print Job with the Option to Delete It

1. At the printer control panel, press the Home button.
2. Touch Jobs, then touch the name of the print job.
3. Do one of the following:

e To pause the print job, touch Pause. To resume the print job, touch Resume.
e To delete the print job, touch Delete. At the prompt, touch Delete.

Note
If you do not make a selection within 60 seconds, the job automatically resumes.

4. To return to the Home screen, press the Home button.
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Viewing, Printing, or Deleting Saved and Secure Jobs
Note

e The system administrator can restrict users from deleting jobs. If a system administrator has restricted
job deletion, you can view the jobs, but not delete them.

e Only the user that sent the job or the system administrator can delete a Secure Print job.
. At the printer control panel, press the Home button.

. To view a list of active and completed jobs, touch Jobs.
To view a list of specific job types, touch an option.

wN S

e To view Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then
touch OK. To delete the job, touch the Trash icon, then touch Delete.

o To view Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then
touch Print All, or Delete All.

e For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number,
then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder,
touch Print All, or Delete All.

4. To view details about a job, touch the job.
5. To return to the Home screen, press the Home button.
Printing a Job Held for Resources

1. At the printer control panel, press the Home button.
2. Touch Jobs.

3. From the jobs list, touch the held job name. The resources required for the job appear on the control
panel.

4. Do one of the following:

e To print the job, replenish the resources required. The job resumes automatically when the required
resources are available. If the job does not print automatically, touch Resume.

e To delete the print job, touch Delete. At the prompt, touch Delete.

5. To return to the Home screen, press the Home button.
Managing Special Job Types

Special job types allow you to send a print job from your computer, then print it from the printer control
panel. Select special job types in the print driver, Printing Options tab, under Job Type.

Saved Job

Saved Jobs are documents sent to the printer and, unless deleted, are stored there for future use. Any
user can print or delete a Saved Job.

To print a Saved Job, refer to Printing a Saved Job.

Releasing a Saved Job

1. At the printer control panel, press the Home button.
2. Touch Jobs.
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3. To view Saved Jobs, touch Saved Jobs.
To print a Saved Job, touch the job name, enter the quantity, then touch OK.

5. To delete the document after printing, for that job, touch the Trash icon, then at the prompt, touch
Delete.

6. To return to the Home screen, press the Home button.

e

Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the
printer until you enter your passcode at the printer control panel.

To print a Secure Print job, refer to Printing a Secure Print Job.

Releasing a Secure Print job

At the printer control panel, press the Home button.
Touch Jobs.

To view Secure Print jobs, touch Personal & Secure Jobs.
Touch your folder.

Enter the passcode number, then touch OK.

Select an option:
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e To print a Secure Print job, touch the job.

e To print all the jobs in the folder, touch Print All.

e To delete a Secure Print job, touch the Trash icon, then at the prompt, touch Delete.
e To delete all the jobs in the folder, touch Delete All.

Note
After a Secure Print job is printed, it is deleted automatically.

7. To return to the Home screen, press the Home button.
Personal Print

Personal Print allows you to store a document in the printer, then print it from the control panel.

Note
The Personal Print feature is only available on a Windows computer printing to a network printer.

Personal Print is a type of saved job with these features:

e A Personal Print job appears in a folder named after the user ID associated with the print job.
e A Personal Print job does not use a passcode.

e Any user can print or delete a Personal Print job.

e You can print all jobs in the list at once, delete an individual job, or delete all jobs in the list.

o After a Personal Print job is printed, it is deleted automatically.

To print a Personal Print job, refer to Printing a Personal Print Job.

Releasing a Personal Print Job

1. At the printer control panel, press the Home button.
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2. Touch Jobs.
3. To view Personal Print jobs, touch Personal & Secure Jobs.
4. Touch your folder.
5. If prompted for a passcode, touch Skip.

Note

When your folder contains Secure Print jobs and Personal Print jobs, the passcode prompt appears.
6. Select an option.

e To print a Personal Print job, touch the job.

e To print all the jobs in the folder, touch Print All.

e To delete all the jobs in the folder, touch Delete All.
7. To return to the Home screen, press the Home button.
Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining
copies. After reviewing the sample set, you can either print the remaining copies or delete them at the
printer control panel.

Sample Set is a type of saved job with these features:

A Sample Set job appears in a folder named after the user ID associated with the print job.
A Sample Set job does not use a passcode.
Any user can print or delete a Sample Set job.

A Sample Set prints one copy of a job to allow you to proofread the job before printing any remaining
copies.

After a Sample Set job is printed, it is deleted automatically.

To print a Sample Set, refer to Printing a Sample Set.

Releasing a Sample Set

1.
2.
3.

At the printer control panel, press the Home button.
To view available jobs, touch Jobs.
Touch the Sample Set job.

Note

The Sample Set file description shows the job as Held for Future Printing, and shows the number of
remaining copies of the job.

Select an option.

e To print the remaining copies of the job, touch Release.
e To delete the remaining copies of the job, touch Delete.

To return to the Home screen, press the Home button.
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Managing Jobs Using the Embedded Web Server

You can view a list of active jobs and delete print jobs from the Active Jobs list in the Embedded Web
Server. You can use the Embedded Web Server to submit jobs for printing at the device. You can print
.pdf, .ps, .pcl, .prn, .xps, .jpg, -.tif and .txt files directly from the Embedded Web Server without opening
another application or the print driver. The files can be stored on a local computer hard drive, mass
storage device, or network drive.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

2. In the Embedded Web Server, click Jobs.
3. Click the job name.
4. Do one of the following:

e To pause the print job, click Pause. To resume the print job, click Resume.
e To delete the print job, click Delete. At the prompt, click Delete.

5. To return to the Home screen, click Home.

Submitting Jobs for Printing Using the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

In the Embedded Web Server, click Home.

In the Quick Links areq, click Submit File.

Click the Submit field.

In the selection window, select a file to print, then click Open.
To print the document, click Submit.

Copy

Copy Overview
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To make a copy, the device scans your original documents and temporarily stores the im-
ages. The image print based on the options selected.

If Authentication or Accounting has been enabled on your device, enter your login details to access
Copy features.

You can adjust various settings for individual Copy jobs and save settings as Presets for future jobs. The
list of features can be customized, and some features could be hidden from view when the App is installed.
To view all available features and to find out more about customizing the Copy App, refer to Customize
and Personalize.

For information about all the App features and available settings, refer to Apps Feature.
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Making a Copy

To make a copy:

1. At the printer control panel, press the Home button.
2. To clear previous App settings, touch Reset.

3. Load your original documents.

e Use the document glass for single pages or paper that cannot be fed using the single-pass duplex
automatic document feeder. Lift the document feeder, then place the original document face
down in the upper-left corner of the document glass.

e For single, multiple, or 2-sided pages, use the single-pass duplex automatic document feeder.
Remove any staples and paper clips from the pages. Insert the original documents face up in the
document feeder, with the top of the page entering the feeder first. Adjust the paper guides so
that they fit against the original documents.

4. Touch Copy, then enter the number of copies needed.
Note

To amend the number of copies entered, touch the X button, then enter the required quantity.

5. If scanning from 2-sided original documents, touch 2-Sided, then select an option.
6. Adjust copy settings as needed.

For details about available features, refer to Apps Feature.

7. Touch Start. If you placed documents in the feeder, scanning continues until the feeder is empty.
8. If you are scanning from the document glass, when prompted, do one of the following:
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e To complete the job and return to the Copy app, touch Done.

e To scan another page, load a new original document on the document glass, then touch Add
Page.

e To delete the scan and return to the Copy app, touch Cancel, then touch Delete.

Note
If you are scanning a document from the automatic document feeder, a prompt does not appear.

9. To return to the home screen, press the Home button.
Stapling a Copied Document

With the optional finisher installed on the printer, copied documents can be stapled.
1. From the Copy app, touch Staple.

2. Touch 1 Staple.

3. Touch Save.
4,

Touch Start.
The stapled copy is delivered to the finisher.

Copy Workflows

Note

Some features are hidden from view when the Copy App is installed. For more information, refer to
Customize and Personalize.

Adjusting Contrast Settings

You can adjust the variation between light and dark areas of your copy using the Contrast feature. You
can reduce the sensitivity of the printer to variations in light background colors using Auto Background
Suppression.

To adjust the Auto Background Suppression and Contrast:

At the printer control panel, press the Home button.

Touch Copy.

Touch Image Enhancement.

To enable Auto Background Suppression, touch the Auto Background Suppression toggle button.
To enable Auto Contrast, touch the Auto Contrast toggle button.

To adjust the Contrast manually, ensure that the Auto Contrast toggle button is off, then move the
slider to increase or decrease the contrast.

7. Touch OK.

ounswN-R=

Changing the Page Layout
You can use Page Layout to place a defined number of pages on one or both sides of the paper.

To change the page layout:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Page Layout.

4, Select the required number of pages per side.
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5. To change the Original Orientation, touch Page Layout, then touch More. Select Portrait or
Landscape.
Note

The Original Orientation option is only available when the selected number of pages per slide is 2,
4, or 8.

6. To change the Image Order, touch Page Layout, then touch More. Select one of the following options.

e Right then Down: This option prints the images across the page, row by row.
e Down then Right: This option prints the images down the page, column by column.

Note
The Image Order option is only available when the selected number of pages per slide is 4 or 8.

7. Touch OK.
Book Copying

You can use the Book Copying feature to copy books, magazines, or other bound documents. You can
use this feature to copy images for different results.

e Copy either the left or right page onto a single sheet of paper.

e Copy both the left and right pages onto two sheets of paper.

e Copy both the left and right pages as a single image onto one sheet of paper.

Note

To make copies from books, magazines, or other bound documents, use the document glass only. Do
not place bound original documents in the document feeder.

To set up book copying:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Book Copying.

4. Touch Mode, then select one of the following options:

e Off: This option is the default setting.

e Both Pages: This option scans both pages of an open book onto two sheets of paper.

o Left/Right Page Only: This option scans the left or right page of an open book onto a single sheet
of paper.

5. If Binding Edge Erase is required, touch Binding Edge Erase, then move the slider to the right to
erase up to 50 mm (1.97 in.).

6. Touch OK.
Shifting the Image

You can change the placement of an image on the copy page. This is useful if the image is smaller than
the page size. For image shift to work correctly, position original documents as follows:
e Document Feeder: Position original documents face up, short edge entering the feeder first.

e Document Glass: Position original documents face down, in the upper-left corner of the document
glass, short edge to the left.
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To change the placement of the image:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Image Shift.

4. Select one of the following options.

o Off: This option is the default setting.

e Auto Center: This option centers the image on the page.

e Snap to Edge: This option shifts the image to the edge of the document. Select one of the
image-position options.

Mirror Side 1: This option allows you to set the Image Shift for Side 1, and matches the Side
2 Image Shift accordingly. To move the image to the required edge of the page, touch the
appropriate arrow.

Independent Sides: This option allows you to position the images on Side 1 and Side 2
independently of each other. To move each image to the required edge of the page, touch
the appropriate arrow.

e Manual: This option allows you to specify the amount of Image Shift required. Select one of the
image-position options.

Mirror Side 1: This option allows you to set the Image Shift for Side 1, and matches the Side
2 Image Shift accordingly. Touch the appropriate fields. To adjust the image shift, move
the slider.

Independent Sides: This option allows you to position the images on Side 1 and Side 2
independently of each other. Touch the appropriate fields. To adjust the image shift, move
the slider.

5. To specify the orientation of the original document, touch Original Orientation, then select an option.
6. Touch OK.

Creating a Booklet

The booklet feature reduces the original page images to fit two images on each side of the printed page.
You can print copies in booklet format.

Note

o This booklet option is available on printers with an optional Productivity Kit installed only.
e In Booklet mode, the printer scans all of the original documents before it prints the copies.

To create a booklet:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Booklet Creation.

Note

If Reduce/Enlarge has been adjusted, a message appears confirming that Reduce/Enlarge has
changed to Auto%. If Paper Supply has been set to Auto Select, a message appears confirming that
Paper Supply has changed to Tray 1.

4. Touch the Booklet Creation toggle button.
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5. Touch Original Document, then select the option that matches your original documents:
e 1-Sided Original: This option scans only one side of the original image and produces 1-sided
output files.
e 2-Sided Original: This option scans both sides of the original image.

e 2-Sided, Rotate Side 2: This option scans both sides of the original image, rotating the second
side.

6. If a cover sheet is required, touch the Cover toggle button, then adjust Paper Supply and Print On
Coveras needed.

7. Touch OK.
Adding a Front Cover

You can print the first page of your copy job on different paper, such as colored or heavyweight paper.
The printer selects the special paper from a different tray. The cover can be blank or printed.

Note

This function is available only on printers with an optional Productivity Kit installed only.

To add a front cover to your copy job:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Front Cover.

4. Touch the Front Cover toggle button.

Note
If Paper Supply is set to Auto Select, a notification appears confirming that the Paper Supply has
been changed to Tray 1.

5. Touch Printing Options, then select an option.

e Blank: This option inserts a blank front cover.

e Print on Side 1 Only: This option prints on the front side of the cover only.
e Print on Side 2 Only: This option prints on the back side of the cover only.
« Print on Both Sides: This option prints on both sides of the cover.

6. Touch Paper Supply, then select the required paper source.
7. Touch OK.

Erasing the Edges of Copies

You can erase content from the edges of your copies using the Edge Erase feature. You can specify the
amount to erase on the right, left, top, and bottom edges.

To erase the edges of copies:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Edge Erase.

4. Select one of the following options.
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o All Edges: This option erases all four edges by the same amount. To adjust the amount to erase,
move the slider.
e Print to Edge: This option prints with no edge erase.

e Individual Edges: This option allows you to specify different amounts to erase from the edges.
Select an erase option.

Mirror Edges: This option allows you to set the Edge Erase for Side 1, and matches the Side
2 Edge Erase accordingly. To adjust the edge erase, move the slider.

Independent Edges: This option allows you to set the Edge Erase on Side 1 and Side 2
independently of each other. Touch the appropriate field. To adjust the Edge Erase, move
the slider.

5. To specify the orientation of the original document, touch Original Orientation, then select an option.
6. Touch OK.

Printing a Sample Copy

Sample Copy allows you to print a test copy of a job to inspect before printing multiple copies. This
feature is useful for complex or high-volume jobs. After you print and inspect the test copy, you can
choose to print or cancel the remaining copies.

To print a sample copy of your job:

At the printer control panel, press the Home button.

Touch Copy.

Adjust the copy settings as needed.

Enter the number of copies needed.

Touch the Sample Copy toggle button.

Touch the Start button. The sample copy prints.

Inspect the sample copy, then select one of the following options.
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o If the copy is unsatisfactory, touch Delete. The job is canceled and no more copies are printed.
e If the copy is satisfactory, touch Release. The remaining copies are printed.

8. To return to the home screen, press the Home button.
Adding Annotations

You can use the Annotations feature to add a page number, comment, date, or Bates Stamp to your
copies.

Note

e This function is only available on printers with an optional Productivity Kit installed.
e If Booklet Creation is selected, you cannot add Annotations.

To add annotations:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Annotations.

4. To insert page numbers:

a) Select the required page location, then touch Page Number.
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b) Enter the starting page number.

¢) To adjust which pages contain the selected annotation, touch Apply To, then select All Pages
or All Pages Except First.

d) Touch OK.

5. To insert a comment:
a) Select the required page location, then touch Comment.
b) Select the required entry, then touch OK.

Note
To create a comment, touch the edit icon for Not in Use. Enter the required text, then touch OK.

¢) To adjust which pages contain the selected annotation, touch Apply To, then select the required
option.
d) Touch OK.

Note
To create a prefix, touch the edit icon for Not in Use. Enter the required text, then touch OK.

6. To insert the current date:
a) Select the required page location, then touch Date Stamp.
b) Touch Format, then select the required date format.
¢) To adjust which pages contain the selected annotation, touch Apply To, then select the required
option.
d) Touch OK.
7. Toinsert a Bates Stamp:
a) Select the required page location, then touch Bates Stamp.
b) Touch Prefix, then select the required entry. Touch OK.

Note
To create a prefix, touch the edit icon for Not in Use. Enter the required text, then touch OK.

¢) Touch Starting Number. Enter the required starting number, then touch OK.
d) Touch Number of Digits, then select the required option.
e) To adjust which pages contain the selected annotation, touch Apply To, then select the required
option.

f) Touch OK.

8. To change the text formatting, touch Format & Style. Adjust the settings as required, then touch

OK.
9. Touch OK.
10. If necessary, to remove all entered annotations, touch Delete All.

Note
Not all annotations are available in all page locations.
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ID Card Copy

ID Card Copy Overview
( You can use the ID Card Copy App to copy both sides of an ID card or small document
B onto one side of paper. To copy the card, place each side in the upper-left corner of the

document glass. The printer stores both sides of the document, then prints them side by
side on the paper.

The ID Card Copy App is hidden from view on initial device setup. The list of features can be customized,
and some features can be hidden from view. For more information about adding and customizing Apps,
refer to Customize and Personalize.

For information about all the App features and available settings, refer to Apps Feature.

Copying an ID Card

To copy an ID card:

1.
2.
3.
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At the printer control panel, press the Home button.
To clear previous App settings, touch Reset.

Lift the automatic document feeder, then place the original document in the upper-left corner of the
document glass.

Touch ID Card Copy.
Adjust the settings as required.
Touch Scan.

When scanning is finished, lift the automatic document feeder. Flip the original document, then place
it in the upper-left corner of the document glass.

To scan the second side of the original document and print the copies, touch Scan.
To return to the home screen, press the Home button.

Email

Email Overview

You can use the Email app to scan images and attach them to emails. You can specify
the file name and format of the attachment, and include a subject heading and message
for the email.

Note

Before using Email, you must set up and configure the Email features on the printer. For
details, refer to the System Administrator Guide at www.xerox.com/of-
fice/VLB605_VLB615docs.
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You can adjust various settings for individual Email jobs and save settings as Presets for future jobs. The
list of features can be customized, and some features could be hidden from view when the App is installed.
To view all available features and to find out more about customizing the Email App, refer to Customize
and Personalize.

For information about all the App features and available settings, refer to Apps Feature.

Sending a Scanned Image in an Email

To send a scanned image in an email:

1. At the printer control panel, press the Home button.
2. To clear previous App settings, touch Reset.

3. Load your original documents.

e Forsingle pages or paper that cannot be fed using the single-pass duplex automatic document
feeder, use the document glass. Lift the automatic document feeder, then place the original
documents face down in the upper-left corner of the document glass.

o For multiple, single, or 2-sided pages, use the single-pass duplex automatic document feeder.
Remove any staples or paper clips from the pages. Insert the original documents face up in the
automatic document feeder, with the top of the page entering the feeder first. Adjust the paper
guides so that they fit against the document originals.

4. Touch Email.
5. Enter recipients:

e To enter the email address manually into the To field, type the address using the touch screen
keypad. Touch Enter.
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e Toselect acontact or group from the Address Book, touch the Address Book icon. Touch Favorites
or Contacts, then select a recipient.

If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
Adjust the email settings as needed:

e To save the scanned document with a specific file name, touch the attachment file name, enter
a new name using the touch screen keypad, then touch Enter.

e To save the scanned document with a specific file format, touch the attachment file format, then
select the required format.

To create a searchable file or to add password protection, from the File format, select More.

e To change the subject line, touch Subject, enter a new subject line using the touch screen keypad,
then touch Enter.

e To change the email body message, touch Message, enter a new message, then touch OK.

For details about available features, refer to Apps Feature.

To start the scan, touch Send.

If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan
another page, touch Add Page. To cancel a job, touch Cancel Job.

Note
If you are scanning a document from the automatic document feeder, a prompt does not appear.

To return to the Home screen, press the Home button.

Scan To

Scan To Overview

The Scan To feature provides several methods for scanning and storing an original docu-
ment. The scanning procedure using your printer differs from that of desktop scanners.
The printer is connected typically to a network rather than a single computer, so you select
a destination for the scanned image at the printer.

The printer supports the following scanning functions:

Scan original documents to an email address.

Scan original documents to a USB Flash drive. This is available using the USB app. Refer to Scanning
to a USB Flash Drive,

Scan original documents to your home folder.
Scan original documents to a shared network location using SMB and FTP transfer protocols.

You can adjust various settings for individual Scan To jobs and save settings as Presets for future jobs.
The list of features can be customized, and some features could be hidden from view when the App is
installed. To view all available features and to find out more about customizing the Scan To App, refer
to Customize and Personalize.

For information about all the App features and available settings, refer to Apps Feature.
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Scanning to an Email Address

Before you scan to an email address, ensure that you configure the printer with the email server
information. For details, refer to the System Administrator Guide at
www.xerox.com/office/VLB605_VLB615docs.

To scan an image and send it to an email address:

1. Load the original document on the document glass or into the duplex automatic document feeder.
2. At the control panel, touch the Home button.

3. Touch Scan To.

4. Enter recipients.

e To enter the email address manually, touch Email, then enter an email address. Touch Enter.
e To select a contact or group from the Address Book, touch Contacts.

5. To save the scanned document as a specific file name, touch the attachment file name, then enter
a new name using the touch screen keypad. Touch Enter.

6. To save the scanned document as a specific file format, touch the attachment file format, then select
the required format.
Note

To make scanned documents searchable, your system administrator can enable the Searchable
feature.

7. Adjust scanning options as needed.

8. To change the subject line, from Email Features, touch Subject, then enter a new subject line using
the touch screen keypad. Touch Enter.

9. To change the email body message, from Email Features, touch Message, then enter a new message.
Touch OK.

10. To begin the scan, touch Scan.

11. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan
another page, touch Add Page.

Note
If you are scanning a document from the automatic document feeder, a prompt does not appear.

12. To return to the Home screen, press the Home button.
Scanning to a User Home Folder

Scan to Home allows you to scan documents that are saved to a home directory on an external server.
The home directory is distinct for each authenticated user. The directory path is established through
LDAP.

Before You Begin

To scan to the home folder defined in an LDAP directory, first ensure that the home folder locations are
defined for each user.

If you want to scan to a shared folder on the network, create a shared folder on your network with read
and write access privileges.
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Scanning to a Home Folder

Note

If LDAP Network Authentication is configured, the Home button appears as an option that you can
select on the Scan To screen.

Load the original document on the document glass or into the duplex automatic document feeder.
At the printer control panel, press the Home button.

To log in to the printer, touch Log In.

Enter your user name, then touch Next.

Enter your password, then touch OK.

To scan to a home folder, select an option:
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e Touch Scan To. On the Scan To screen, touch Home.
e Touch My Folder.

7. To save the scanned document as a specific file name, touch the attachment file name, enter a new
name using the touch screen keypad, then touch Enter.

8. To save the scanned document as a specific file format, touch the attachment file format, then select
the desired format.

9. Adjust scanning options as needed.
10. To begin the scan, press Scan.

If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan
another page, touch Add Page.
Note

If you are scanning a document from the automatic document feeder, a prompt does not appear.

11. To return to the Home screen, press the Home button.
Scanning to a USB Flash Drive

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function
produces scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats.

Note
o If the device is in Power Saver mode, before proceeding with the USB scan, to wake the device, press

the Power/Wake button.
e Only USB Flash drives formatted to the typical FAT32 file system are supported.

To scan to a USB Flash drive:

1. Load the original document on the document glass or in the duplex automatic document feeder.
2. At the printer control panel, press the Home button.

3. Insert your USB Flash drive into the USB memory port on the front of the printer.

4, At the USB Drive has been detected screen, touch Scan to USB.

Note
If USB scan does not appear, enable the feature or contact the system administrator.
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5.

6.

10.

11.

To save the scanned file to a specific folder on the USB Flash drive, navigate to the directory where
you want to save your file, then touch OK.

To save the scanned document as a specific file name, touch the attachment file name, then enter
a new name using the touch screen keypad. Touch Enter.

. To save the scanned document as a specific file format, touch the attachment file format, then select

the required format.
Adjust scanning features as needed.
To begin the scan, press Scan.

The printer scans your images to the folder that you specified.

If you are scanning from the document glass, when prompted, to finish, touch Done or to scan
another page, touch Add Page.

Note
If you are scanning a document from the automatic document feeder, a prompt does not appear.

® Caution

Do not remove the USB Flash drive while the device is scanning and processing the job. If you remove
the Flash drive before the transfer is complete, the file can become unusable and other files on the
drive can be damaged.

To return to the Home screen, press the Home button.

Scan to Desktop

Before you begin:

Before scanning, ensure that your computer and the printer are plugged in, powered on, and connected
to an active network.

On your computer, ensure that you have the correct print driver software installed. For details, refer
to Installing the Software.

On your computer, ensure that the printer is installed using WSD. For details, refer to Installing the
Software.

On your printer, ensure that WSD is enabled. For details, refer the System Administrator Guide at
www.xerox.com/office/VLB605_VLB615docs.

To Scan to Desktop:

1. Load the original document on the document glass or into the duplex automatic document feeder.
2. At the printer control panel, press the Home button.
3. Touch Scan to Desktop.
4. To select a destination, touch the computer address.
5. To begin the scan, press Scan.
The Windows Fax and Scan application opens on your PC desktop. The image file of your scan is
saved to the Scanned Documents folder.
6. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan
another page, touch Add Page.
Note
If you are scanning a document from the automatic document feeder, a prompt does not appear.
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7. To return to the Home screen, press the Home button.

Scanning to a Shared Folder on a Network Computer

Before you can use the printer as a scanner on a network do these steps:

e Create a shared folder on your computer hard drive.
e Access the Embedded Web Server, then create an address that points the scanner to the computer.

Sharing a Folder on a Windows Computer

Open Windows Explorer.

Right-click the folder you want to share, then select Properties.

Click the Sharing tab, then click Advanced Sharing.

Select Share this folder.

Click Permissions.

Select the Everyone group, then verify that all permissions are enabled.
Click OK.

Note
Remember the Share name for later use.
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8. Click OK again.
9. Click Close.

Sharing a Folder in Macintosh OS X Version 10.7 and Later

From the Apple menu, select System Preferences.

From the Internet & Wireless menu, select Sharing.

From the Service menu, select File Sharing.

Under Shared Folders, click the Plus icon (+).

Browse to the folder that you want to share on the network, then click Add.
To modify access rights for your folder, select the folder. The groups activate.
From the Users list, click Everyone, then use the arrows to select Read & Write.
Click Options.

To share the folder, select Share files and folders using SMB.

10. To share the folder with specific users, next to the user name, select On.

11. Click Done.

12. Close the System Preferences window.
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Note

When you open a shared folder, a Shared Folder banner appears in the Finder for the folder and
subfolders.

Adding an SMB Folder as an Address Book Entry from the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

Note
If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.
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2.
3.

4.
5.

Click Address Book, then click Add Contact.
For Network (SMB), click the Plus icon (+), then enter the following information:

¢ Nickname: Enter the name that you want to appear in the Address Book.
o Type: Select the network connection type.

e IP Address: Port / Host Name: Port or IPv6 Address/Prefix : Port: The option selected under
Type determines which option displays in this field. Enter the IP address of your computer, then
enter the default port number.

e Share: Enter a name for the directory or folder. For example, to save scanned files to a shared
folder named scans, type scans.

e Document Path: Enter the path of the folder on the SMB server. For example, to save the scanned
files to a folder named colorscans inside the scans folder, type colorscans.

e Login Name: Enter your computer user name.
e Password: Enter your computer login password.
e Retype Password: Enter your login password again.

To save your network information, click OK.
To save your contact, click OK.

Adding a Folder as an Address Book Entry Using the Control Panel
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6.

At the printer control panel, touch the Homebutton.

Touch Address Book.

Touch the plus icon (+), then select Add Contact.

Enter the name to appear in the address book.

Touch Add (SMB), then navigate to the desired folder.

Note

Login credentials are required for computers on secured networks.

To save changes, touch OK.

Scanning to a Shared Folder on a Networked Computer

1. Load the original document on the document glass or into the duplex automatic document feeder.

2. At the printer control panel, press the Home button.

3. Touch Scan To.

4. Touch Contacts.

5. From the Contacts list, select the shared folder.

6. To save the scanned document as a specific file name, touch the attachment file name, enter a new
name using the touch screen keypad, then touch Enter.

7. Tosave the scanned document as a specific file format, touch the attachment file format, then select
the needed format.

8. Adjust scanning options as needed.

9. To begin the scan, press Scan.

10. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan

another page, touch Add Page.
Note
If you are scanning a document from the automatic document feeder, a prompt does not appear.
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To return to the Home screen, press the Home button.

Scanning Images into an Application on a Connected Computer

You can import images directly from the scanner into a folder on your computer. With a Macintosh®
computer and some Windows® applications, you can import the images directly into an application.

Scanning an Image into an Application

Note
Some Windows applications, including Microsoft Office 2007 and newer, do not support this feature.

1.
2. At your computer, open the application into which you want to scan the image.

3.

4. From the Paper Source menu in Windows, or from the Scan From menu on a Macintosh® computer,

Load the original document on the document glass or in the duplex automatic document feeder.

In the application, select the menu item to acquire the image.

select one of the following:

e For the Document Glass, select Flatbed.
e For the Duplex Automatic Document Feeder, select Document Feeder.

Specify other scan driver settings as needed.
To begin the scan, click Scan.

The printer scans the document and places the image in your application.

Scanning from Windows Control Panel
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Load the original document on the document glass or in the duplex automatic document feeder.
On your computer, select Start > Devices and Printers.

From the Devices and Printers window, right-click the printer icon, then select Start Scan.

From the menu, select the paper source for your original document .

Adjust scanning options as needed.

To preview the document or select a portion of the document to scan, select Preview.

The printer scans a preview copy of the image.

. To select part of the document, use the corner points to resize the frame.

Click Scan.
To import the scan, in the Import Pictures and Video window, click Import.

The scanned image is stored in the default My Pictures folder.

Fax

Fax Overview

When you send a fax from the printer control panel, the document is scanned and
transmitted to a fax machine, using a dedicated telephone line. You can use the Fax
feature to fax documents to a fax number, or individual contact, or to a group of contacts.
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You can use the Fax feature to do the following tasks:

e Delay the send of your fax job for up to 24 hours.
e Send a fax from your computer.

e Forward fax documents to an email address.

e Print a fax from a secure folder.

The fax function works best with an analog phone line. Voice-Over-Internet Protocols (VOIPs) such as

FIOS and DSL are not supported. Before you use the fax, configure the Fax Settings to ensure that the
settings are compatible with your local connection and regulations. The Fax Settings include optional
features that you can use to configure the printer for faxing.

Note

Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

For details, refer to the System Administrator Guide at www.xerox.com/office/VLB605_VLB615docs.

You can adjust various settings for individual Fax jobs and save settings as Presets for future jobs. The
list of features can be customized, and some features could be hidden from view when the App is installed.
To view all available features and to find out more about customizing the Fax App, refer to Customize
and Personalize.

For information about all the App features and available settings, refer to Apps Feature.

Sending a Fax

To send a fax:

1. At the printer control panel, press the Home button.
2. To clear previous App settings, touch Reset.

3. Load your original documents.

e Use the document glass for single pages or paper that cannot be fed using the duplex automatic
document feeder. Lift the document feeder, then place the original document face down in the
upper-left corner of the document glass.

e Forsingle, multiple, or 2-sided pages, use the duplex automatic document feeder. Remove any
staples and paper clips from the pages. Insert the original documents face up in the document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit
against the documents.
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4, Touch Fax.

5. To enter a recipient fax number, use the touch screen keypad, then touch Enter. To add a number
from the fax address book, touch the Address Book icon.

Note
To insert a pause as needed, touch the Special Characters icon, then touch Dial Pause. To enter
longer pauses, touch Dial Pause multiple times.

6. If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
7. Adjust fax settings as needed.

For details about available features, refer to Apps Feature.

Touch Send.
9. If you are scanning from the document glass, when prompted, do one of the following:

©

e To complete the job and return to the Fax app, touch Done.

e To scan another page, load a new original document on the document glass, then touch Add
Page.

e To delete the scan and return to the Fax app, touch Cancel, then touch Delete.

Note
If you are scanning a document from the automatic document feeder, a prompt does not appear.

10. To return to the Home screen, press the Home button.

Fax Workflows

Sending a Delayed Fax

You can set a time in the future for the printer to send your fax job. You can delay the send of your fax
job for up to 24 hours.

Note

Before you use this feature, ensure that the printer is set to the current time. For details, refer to the
System Administrator Guide at www.xerox.com/office/VLB605_VLB615docs.

To specify the time to send your fax:
1. At the printer control panel, press the Home button.
2. Touch Fax.
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3. To add a recipient fax number, use the touch screen keypad, or, to add a contact from the Address
Book, touch the Address Book icon.

4. Load original documents into the printer, then adjust the settings as needed. For details, refer to
Sending a Fax.

Touch Delay Send.

Touch Specific Time, enter the required time, then touch OK.

Touch Send. The fax is scanned and saved, then sent at the time that you specified.

If you are scanning from the document glass, when prompted, do one of the following:
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e To complete the job and return to the Fax app, touch Done.

e To scan another page, load a new original document on the document glass, then touch Add
Page.

e To delete the scan and return to the Fax app, touch Cancel, then touch Delete.

Note
If you are scanning a document from the automatic document feeder, a prompt does not appear.

9. To return to the Home screen, press the Home button.
Sending a Cover Sheet with a Fax

You can send a cover sheet with your fax. The cover sheet lists recipient information from the fax address
book, and sender information from the Company Name Fax Line setting.

To send a cover sheet with a fax:

1. At the printer control panel, press the Home button, then touch Fax.

2. Add fax recipient names and adjust fax settings, as needed. For details, refer to Sending a Fax.

3. Touch Cover Sheet.

4. Touch Add Cover Sheet.

5. To add predefined comments in the From or To fields, touch Blank Comment, then select from the
list of predefined comments.
Note
If no predefined comments have been added, the list is unavailable. To populate the list with
predefined comments, refer to Adding Predefined Comments.

6. Touch OK.

Adding Predefined Comments

To add a predefined comment:

At the printer control panel, press the Home button.
Touch Device > Apps > Fax.

Touch Cover Sheet Comments.

Select a Not in Use comment.

Enter the required text, then touch OK.

To return to the Home screen, press the Home button.
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Forwarding a Fax to an Email Address

You can configure the device to forward faxes to an email address. You can specify the types of faxes
to forward, for example, received faxes, sent faxes, or sent and received faxes.

Note

Before you can forward a fax to an email address, ensure that the Fax Forwarding feature is enabled
and a SMTP server is configured. For details, refer to the System Administrator Guide at
www.xerox.com/office/VLB605_VLB615docs.

To forward a fax to an email address:

At the printer control panel, press the Home button.
Touch Device > Apps > Fax.

Touch Fax Forwarding > Fax Forwarding.

Select Receive Only, Send Only, or Send & Receive.

Touch Add Email. To enter an email address, use the touch screen keypad, or select a contact from
the Address Book.

To add a subject line, touch Subject, enter your subject line text, then touch OK.
7. To add a filename for attachments, touch Attachment, then enter a filename.

8. To change the file format for attachments, touch the current format extension, then select a new
format.

s wWwN=
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Note
The default file format is .pdf.

9. To save the settings, touch OK.
10. For the new settings to take effect, press the Home button, then at the prompt, touch Restart Now.

Printing a Secure Fax

When the Fax Secure Receive option is enabled, all faxes that the device receives are held in the Jobs
list until you enter a passcode. After you enter the passcode, the faxes are released and printed.

Note

Before you can receive a Secure Fax, ensure that the Secure Fax Receive feature is enabled. For details,
refer to the System Administrator Guide at www.xerox.com/office/VLB605_VLB615docs.

To print a secure fax:

At the printer control panel, press the Home button, then touch Jobs.
Touch Personal & Secure Jobs.

Touch your assigned private folder.

Enter your passcode, then touch OK.

Select a job to print, or touch Print All.

To return to the Home screen, press the Home button.

ot wN-R=

Sending a Fax Manually

You can use the Manual Send feature to enable the fax modem speaker temporarily. This feature is
helpful to dial international numbers, or to use phone systems that require you to wait for a specific
audio tone.
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To send a fax manually:
1. At the printer control panel, press the Home button, then touch Fax.
2. Touch Manual Send.

Note

To display the menu without entering a fax number, at the top of the screen, touch Fax.
Adjust the fax settings as needed.

Touch Dial, then enter a fax number using the touch screen keypad.

To send the fax, touch Scan.
If you are scanning from the document glass, when prompted, do one of the following steps:

ounsw

e To complete the job and return to the Fax app, touch Done.

e To scan another page, load a new original document on the document glass, then touch Add
Page.

e To delete the scan and return to the Fax app, touch Cancel, then touch Delete.

Note
If you are scanning a document from the automatic document feeder, a prompt does not appear.

7. To return to the Home screen, press the Home button.
Polling a Remote Fax Machine

Fax Polling allows the printer to retrieve a fax stored on another fax machine that supports fax polling.

Note

This feature is hidden from view when the Fax App is installed. For more information, refer to Customize
and Personalize.

To poll a remote fax machine:
1. At the printer control panel, press the Home button, then touch Fax.
2. Touch Polling.

Note
To display the menu without entering a fax number, at the top of the screen, touch Fax.

3. Enter the fax number of the fax machine that you want to poll.

e To enter a fax number manually, touch Enter Fax Number.
e To add a number from the fax address book, touch the Address Book icon.

4. To initiate the polling process, touch Retrieve.
5. To return to the Home screen, press the Home button.

Sending a Fax From Your Computer
You can send a fax to the printer from an application on your computer.
Sending a Fax from Windows Applications

You can use the print driver to send a fax from Windows applications.
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You can use the fax window to enter recipients, create a cover page with notes, and set options. You
can send a confirmation sheet, set the send speed, resolution, send time, and dialing options.

To send a fax from Windows applications:

1. With the desired document or image open in your application, open the Print dialog box. For most
software applications, click File > Print or press CTRL+P.

Select the required printer. To open the print driver dialog box, click Printer Properties.
On the Printing Options tab, from the Job Type list, select Fax.
In the Fax window, click the Recipients tab.
To add recipients manually:
a) Click the Add Recipient icon.
b) Type the recipient name and fax number, then add other information as required.
c) Click OK.
d) To add more recipients, repeat this procedure.
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6. To add existing contacts from a phonebook:
a) Click the Add From Phonebook icon.
b) Select the required phonebook from the list.
¢) Select names from the list, or search for a contact using the search bar.
d) To add the selected contacts to the Fax Recipients list, click the Down Arrow.
e) Click OK.
f) To add more recipients, repeat this procedure.

7. To include a cover sheet, click the Cover Sheet tab. From the Cover Sheet Options list, select Print a

Cover Sheet. Enter the details as needed, then click OK.
8. On the Options tab, select the required options, then click OK.
9. To save your settings and return to the main print dialog page, click OK.
10. Click Print. In the Fax Confirmation window, click OK.

Sending a Fax from Macintosh Applications

You can use the fax driver to send a fax from many Macintosh applications. To install the fax driver,
refer to Installing the Software.

To send a fax from Macintosh applications:

1. With the desired document or image open in your application, open the Print dialog box. For most
software applications, click File > Print or press CMD+P.

2. Select the required printer.

To access the fax driver settings, click Preview, select Xerox Features, then from Job Type list, select
Fax.

To add a recipient, in the Fax window, click the Recipients tab, then click the Add Recipient icon.
Type the recipient name and fax number, add other information as needed, then click OK.

To add more recipients, repeat this procedure.

To include a cover sheet, click the Cover Sheet tab.

From the Cover Sheet list, select Print a Cover Sheet, then enter the details as needed.

On the Options tab, select the required options. To save your settings and return to the main print
dialog window, click OK.

10. To send the fax, click Print.

w
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USB

USB Overview

Use the Print from USB feature to print jobs already stored on a USB drive. Jobs in a print-
ready format, such as PDF, TIFF, or JPEG, can be printed.

To create a print-ready file, select the Print to File option when you print your documents from programs
such as Microsoft Word. From advanced publishing programs, there may be several methods to create
print-ready files.

Printing from a USB Flash Drive

You can print a file stored on a USB Flash drive. The USB port is on the front of the printer.

Note

N

If the device is in Power Saver mode, before proceeding with the Print job, to wake the device, press
the Power Saver button.

Only USB Flash drives formatted to the typical FAT32 file system are supported.

. Insert the USB Flash drive into the USB memory port on the printer.
. At the USB Drive has been detected screen, touch Print from USB.

Note

If this feature does not appear, enable the feature or contact the system administrator. For more
information, see the System Administrator Guide at www.xerox.com/office/VLB605_VLB675docs.

. Add files using the Browse USB screen.

e To print a group of print-ready files, for the USB drive or folder, touch the Select All icon. Verify
that the files are selected.

o To print a specific file, browse to that file, then touch the file name or icon.

Touch OK.
Confirm that the required files are listed.

¢ To select more files, touch Add Documents, then touch OK.
e To remove a file name from the list, touch the file name, then touch Remove.

Select the paper supply, quantity, and 2-sided printing options.
Touch Print.
When you are finished, remove the USB Flash drive.
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Printing from a USB Flash Drive Already Inserted in the Printer

1. If the USB Flash drive is already in the USB memory port, press the Home button.
2. Touch Print from USB.
Note
If this feature does not appear, enable the feature or contact the system administrator. For more
information, see the System Administrator Guide at www.xerox.com/office/VLB605_VLB615docs.
3. Add files using the Browse USB screen.
e To print a group of print-ready files, for the USB drive or folder, touch the Select All icon. Verify
that the files are selected.
e To print a specific file, browse to that file, then touch the file name or icon.
4. Touch OK.
5. Confirm that the correct documents appear. If the documents do not appear, touch Add Documents,
select additional documents, then touch OK.
6. Select the paper supply, quantity, and 2-sided printing options.
7. Touch Print.
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Printing Overview

Before printing, your computer and the printer must be plugged in, powered on, and connected. Ensure

that you have the correct print driver software installed on your computer.

1. Select the appropriate paper.

2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type.

3. Access the print settings in your software application. For most software applications, press CTRL+P
for Windows, or CMD+P for Macintosh.

4. Select your printer.

5. To access the print driver settings:

e For Windows, select Properties or Preferences.

e For Macintosh, Xerox® Features.

The title of the button can vary depending on your application.

6. Modify the print driver settings as necessary, then click OK.
7. To send the job to the printer, click Print.

Selecting Printing Options

Printing options, also called print driver software options, are specified as Printing preferences in Windows
and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page layout,

and print quality. Printing options that are set from Printing preferences within the Devices and Printers
window become the default setting. Printing options that are set from within the software application
are temporary. The application and the computer do not save the settings after the application is closed.

Print Driver Help

Xerox® print driver software Help information is available from the Printing Preferences window. Click
the Help button (?) in the bottom, left corner of the Printing Preferences window to see the Help.
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Information about Printing Preferences appears in the Help window. From there, you can select by topic
or use the search field to enter the topic or function for which you need information.

Windows Printing Options
Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, you can change the Printing Preferences before
sending the job to the printer.

1. With the document open in your software application, access the print settings. For most software
applications, click File > Print or press CTRL+P.

2. Select your printer and click the Properties or Preferences button to open the Printing Preferences
window. The title of the button can vary depending on your application.

3. Click a tab in the Printing Preferences window, then make selections.
4. To save and close the Printing Preferences window, click OK.
5. To send the job to the printer, click Print.

Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings specified in the
Printing Preferences window. You can specify your most common printing options and save them so
that you do not have to change the settings every time you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in
Printing Preferences.

1. Navigate to the list of printers on your computer:
e For Windows Server 2008 and later, click Start > Settings > Printers.
e For Windows 7, click Start > Devices and Printers.
e For Windows 8.1 and Windows 10, right-click the Start icon > Control Panel > Devices and
Printers.
Note
If you are using a custom Start menu application, it can change the navigation path to your list of
printers.

2. In the list of printers, right-click the icon for your printer, then click Printing preferences.
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3. Inthe Printing Preferences window, click a tab, then select the options. To save the settings, click OK.

Note

For more information about Windows print driver options, click the Help button (?) in the Printing
Preferences window.

Selecting Printing Defaults in Windows for a Shared Network Printer
1. Navigate to the list of printers on your computer:

e For Windows Server 2008 and later, click Start > Settings > Printers.

e For Windows 7, click Start > Devices and Printers.

e For Windows 8.1 and Windows 10, right-click the Start icon > Control Panel > Devices and
Printers.

Note

If you are using a custom Start menu application, it can change the navigation path to your list of
printers.

In the list of printers, right-click the icon for your printer, then select Printer properties.
In the printer Properties dialog box, click the Advanced tab.

On the Advanced tab, click Printing Defaults.

Make your selections on the Print Driver tabs as needed, then click Apply.

To save the settings, click OK.
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Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs. In Xerox® App
Gallery, you can save an app as default, so you can have app-by-app default settings for printing.

To save a set of printing options:

With the document open in your application, click File > Print.

To open the Printing Preferences window, select your printer, then click Properties or Preferences.
In the Printing Properties window, click the tabs, then select the required settings.

In the Printing Properties window, click Saved Settings, then click Save As.

To save the set of options in the Saved Settings list, type a name for the set of printing options, then
click OK.
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Macintosh Printing Options
Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.
1. With the document open in your application, click File > Print.

2. Select your printer.

3. In the Print Options menu, select Xerox Features.

Note

To see all printing options, click Show Details.

4. Select any other required printing options from the lists.
5. To send the job to the printer, click Print.
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Saving a Set of Commonly Used Printing Options for Macintosh
You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1. With the document open in your application, click File > Print.

2. Select your printer from the Printers list.

3. Select the required printing options from the lists in the Print dialog box.

Note
To see all printing options, click Show Details.

4. Click Presets > Save Current Settings as Preset.
5. Type a name for the printing options. To save the set of options in the Presets list, click OK.
6. To print using these options, select the name from the Presets list.

UNIX and Linux Printing

The Xerox® Print Driver package provides tools for you to manage printers connected in UNIX and Linux
environments.

The Xerox® print drivers provide a GUI-based (Graphical User Interface) driver dialog for printer feature
selections. You can select print drivers based on your operating system.

Xerox® Printer Manager

Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in
UNIX and Linux environments.

Xerox® Printer Manager allows you to:

o Configure and check the status of network connected printers.
e Set up a printer on your network and monitor the operation of the printer once installed.
e Perform maintenance checks and view supplies status at any time.

e Provide a common look and feel across the many different suppliers of UNIX and Linux operating
systems.

Installing Xerox® Printer Manager
Before you begin, ensure that you have root or superuser privileges to install Xerox® Printer Manager.

To install Xerox® Printer Manager:

1. Download the appropriate package for your operating system. To locate print drivers for your printer,
go to www.xerox.com/office/VLB605_VLB615drivers.

On the print driver website, havigate to your printer model.

For your printer model, click Drivers & Downloads.

From the Operating System menu, select your operating system.

To identify the print driver for your printer model, review the list of available print drivers.
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Note
For additional information on each driver, click Description.
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6. To select the print driver for your printer model and operating system, click the print driver name.
7. To begin the download, read the End User License Agreement, then click Accept.
The file automatically downloads to the default location for your computer file downloads.
8. To install the Xerox® Print Driver package:
a) Open the package with your OS package manager.
b) To install using a command-line utility, change to the directory where you downloaded the file.

To run the installer, type the appropriate command-line utility for your operating system. For
example:

e Red Hat: rpm -U <filename>.rpm

Debian-based Linux: dpkg -i <filename>.deb

AIX: rpm -U <filename>.rpm

HPUX: <filename>.depot.gz

Solaris: pkgadd -d <filename>.pkg

Note

Most installations create a Xerox directory in /opt/Xerox/prtsys. For additional information about
utilities included in the OS package manager, refer to the manual included with the package.
For example, man xeroxprtmgr.

Launching Xerox® Printer Manager

To launch Xerox® Printer Manager, do one of the following tasks.

e For UNIX, log in as root. From a terminal window, type xosdprtmgr, then press Enter or Return.
e For Linux, type sudo xeroxprtmgr, then press Enter or Return.

Printing with xeroxprint
Xerox has its own print command. You can use the following command:

xeroxprint -d<Some_Queue > -o[Options] <Somefile

Printing from a Linux Workstation

To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS (Common UNIX
Printing System) print driver. You do not need both drivers.

Xerox recommends that you install one of the full-featured custom print drivers for Linux. To locate
drivers for your printer, go to www.xerox.com/office/drivers.

If you use CUPS, ensure that CUPS is installed and running on your workstation. The instructions for
installing and building CUPS are contained in the CUPS Software Administrators Manual, written and
copyrighted by Easy Software Products. For complete information on CUPS printing capabilities, refer
to the CUPS Software Users Manual available from www.cups.org/documentation.php.

Installing the PPD File on the Workstation

1. If available, download the Xerox® PPD for CUPS (Common UNIX Printing System) from the Drivers
and Downloads page on the Xerox Support website.
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2. Copy the PPD file into the CUPS ppd/Xerox folder on your workstation. If you are unsure of the
location of the folder, use the Find command to locate the PPD files.

3. Follow the instructions that are included with the PPD file.

Adding the Printer

1. Verify that the CUPS (Common UNIX Printing System) daemon is running.

2. Open a Web browser and type http://localhost:631/admin, then click Enter or Return.

3. For User ID, type root. For password, type the root password.

4. Click Add Printer, then follow the onscreen prompts to add the printer to the CUPS printer list.

Printing with CUPS (Common UNIX Printing System)

CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands.
1. To print to a specific printer in System V, type lp -dprinter filename, then click Enter.
2. To print to a specific printer in Berkeley, type lpr -Pprinter filename, then click Enter.

Mobile Printing Options

This printer can print from iOS and Android mobile devices. For more information, refer to Configuring
Google Cloud Print.

Printing with Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smartphone,
using Wi-Fi Direct.

For details, refer to Connecting to Wi-Fi Direct.

For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device.

Note
Depending on which mobile device you are using, the printing procedure varies.

Printing with AirPrint

You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint®. To enable AirPrint® for
your printer, refer to Configuring Air Print. To use AirPrint®, ensure that your mobile device is connected
to the same wireless network as the printer.

To print with AirPrint®:

Open the email, photograph, website page, or document that you want to print.
Tap the Action icon.

Tap Print.

Select your printer, then set the printer options.

Tap Print.

nuneswNn =

Printing from a MOPRIA-Enabled Mobile Device

MOPRIA" is a software feature that enables users to print from mobile devices without requiring a print
driver. You can use MOPRIA" to print from your mobile device to MOPRIA™-enabled printers.
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Note

e MOPRIA" and all of its required protocols are enabled by default.

e Ensure that you have the latest version of the MOPRIA™ Print Service installed on your mobile device.
You can obtain a free download from the Google Play Store.

e Wireless devices must join the same wireless network as the printer.

e The name and location of your printer appears in a list of MOPRIA -enabled printers on connected
devices.

To print using MOPRIA", follow the directions provided with your mobile device.

Printing Features

Managing Jobs

From the Jobs window in the Embedded Web Server, you can view a list of active and completed print
jobs.

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs. You
can pause, delete, print, or view job progress or job details for a selected job. When you send a secure
print job, the job is held until you release it by typing a passcode at the control panel. For more
information, see Printing Special Job Types.

Pausing the Print Job with the Option to Delete It

1. At the printer control panel, press the Home button.
2. Touch Jobs, then touch the name of the print job.
3. Do one of the following:

e To pause the print job, touch Pause. To resume the print job, touch Resume.
e To delete the print job, touch Delete. At the prompt, touch Delete.

Note
If you do not make a selection within 60 seconds, the job automatically resumes.

4. To return to the Home screen, press the Home button.

Viewing, Printing, or Deleting Jobs

1. At the printer control panel, press the Home button.
2. To view a list of active and completed jobs, touch Jobs.
3. To view a list of specific job types, touch an option.

o To view Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then
touch OK. To delete the job, touch the Trash icon, then touch Delete.

e To view Personal Jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then
touch Print All, or Delete All.

e For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number,
then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder,
touch Print All, or Delete All.
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4. To view details about a job, touch the job.
5. To return to the Home screen, press the Home button.

Note

e The system administrator can restrict users from deleting jobs. If a system administrator has restricted
job deletion, you can view the jobs, but not delete them.

e Only the user that sent the job or the system administrator can delete a Secure Print job.

Printing Special Job Types

Special job types allow you to send a print job from your computer, then print it from the printer control
panel. To select special job types from the print driver, select Printing Options > Job Type.

Printing a Saved Job

1. Inyour software application, access the print settings. For most software applications, press CTRL+P
for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button can
vary.
e For Macintosh, in the Print window, click Print Options, then select Xerox Features.
3. For Job Type, select Saved Job.

Type a job name or select a name from the list, then click OK.
5. Select any other required printing options.

e

e For Windows, click OK, then click Print.
e For Macintosh, click Print.

Printing a Secure Print Job

1. Inyour software application, access the print settings. For most software applications, press CTRL+P
for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.

e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Secure Print.
Type the passcode, confirm the passcode, then click OK.
5. Select any other required printing options.

&

e For Windows, click OK, then click Print.
e For Macintosh, click Print.

Printing a Personal Print Job

1. In your software application, access the print settings. For most software applications, click File >
Print or for Windows, press CTRL+P.

2. Select your printer, then click Printer Properties. Depending on your application, the title of the
button varies.
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3. For Job Type, select Personal Print.
4, Select any other required printing options, then click OK.
5. To send the job to the printer, click Print.

Printing a Sample Set

1. Inyour software application, access the print settings. For most software applications, press CTRL+P
for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.

e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Sample Set.
4. Select any other required printing options.

e For Windows, click OK, then click Print.
e For Macintosh, click Print.

Selecting Paper Options for Printing

There are two ways to select the paper for your print job. You can let the printer select which paper to
use based on the document size, paper type, and paper color you specify. You can also select a specific
tray loaded with the desired paper.

e For Windows, paper options are in the Paper field on the Printing Options tab.

e For Macintosh, in the Print window, in Xerox Features, paper options are in the Paper field for
Paper/Output.

Scaling

Scaling reduces or enlarges the original document to match the selected output paper size.

e For Windows, the scale options are on the Printing Options tab, in the Paper field.

e For Macintosh, the scale options are in the Print window for Preview. To view more printing options,
click Show Details.

The following scaling options are available:

e Automatically Scale scales the document to fit the selected Output Paper Size. The scaling amount
appears in the percentage box below the sample image.

¢ No Scaling does not change the size of the page image printed on the output paper, and 100 %
appears in the percentage box. If the original size is larger than the output size, the page image is
cropped. If the original size is smaller than the output size, extra space appears around the page

image.

e Manually Scale scales the document by the amount entered in the percentage box below the preview
image.
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Printing on Both Sides of the Paper
Printing a 2-Sided Document

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The
print driver uses the settings for portrait or landscape orientation from the application for printing the
document.

Note

Ensure that the paper size and weight are supported. For more information, refer to Supported Standard
Paper Sizes for Automatic 2-Sided Printing and Supported Paper Types and Weights for Automatic
2-Sided Printing.

2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn.
These settings override the application page orientation settings.

o 1-Sided Print: This option prints on one side of the media. Use this option when printing on envelopes,
labels, or other media that cannot be printed on both sides.

o 2-Sided Print: This option prints the job on both sides of the paper to allow binding on the long edge
of the paper. The following illustrations show the result for documents with portrait and landscape
orientations, respectively:

12 B

o 2-Sided Print, Flip on Short Edge: This option prints on both sides of the paper. The images print to
allow binding on the short edge of the paper. The following illustrations show the result for documents
with portrait and landscape orientations, respectively:

' 13

Note
2-Sided Printing is part of the Earth Smart settings.

To change your default print driver settings, see Setting Default Printing Options for Windows.

Print Quality

Print-quality modes:

e Standard print-quality mode: 600 x 600 dpi
e Enhanced print-quality mode: 600 x 600 dpi, 8-bit depth

5-10 Xerox® VersaLink® B605/B615 Multifunction Printer
User Guide



Printing

Image Options

Image options controls how the printer uses lightness and contrast to produce your document. The
Windows PostScript print driver and the Macintosh print drivers provide the widest range of controls on
the Image Options tab.

e For Windows, Lightness and Contrast features are on the Image Options tab.

e For Macintosh, in the Print window, in Xerox Features, image options are in the Paper field for
Paper/Output.

Lightness

The Lightness feature allows you to adjust the overall lightness or darkness of the text and images in
your printed job.

Contrast
You can use the Contrast feature to adjust the variation between light and dark areas of the print job.

Image Shift

Image Shift allows you to modify the location of the image on the page. You can shift the printed image
along the X and Y axes of each sheet of paper.

Printing Mirror Images

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right
when printed.

Printing Multiple Pages to a Single Sheet
When printing a multiple-page document, you can print more than one page on a single sheet of paper.

Toprint 1, 2,4,6,9, or 16 pages per side, select Pages Per Sheet on the Pages Per Sheet Page Layout
tab.

e For Windows, Page Layout is on the Document Options tab.
e For Macintosh, in the Print window, Layout is on the Preview list.

1 | 4

To print a border around each page, select Page Borders.

Printing Booklets

With 2-sided printing, you can print a document in the form of a small booklet. You can create booklets
from any paper size that is supported for 2-sided printing.
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The print driver automatically reduces each page image and prints four page images per sheet of paper,
two page images on each side. The pages are printed in the correct order so that you can fold and staple
the pages to create the booklet.

e For Windows, Booklet Layout is on the Page Layout tab. Page Layout is on the Document Options
tab.

e For Macintosh, in the Print window, in Xerox Features, Booklet Layout is on the Paper/Output list.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter
and creep.

o Gutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm
(1/72in.).

e Creep: Specifies how much the page images shift outward in tenths of a point. Shifting compensates
for the thickness of the folded paper, which can cause the page images to shift outward slightly when
folded. You can select a value from zero to 1 point.

Gutter Creep

w

Selecting Finisher Options

With the optional finisher option installed on the printer, you can request stapled documents right from
your desktop computer. The stapler can staple up to 30 sheets of 105 g/mz.
1. From the Printing Options tab, locate the Finishing option, then select 1 Staple.

2. Click OK.
The stapled prints are delivered to the finisher unit.

Selecting Mailbox Options

With the optional mailbox option installed on the printer, you can send prints to a specific mailbox bin
right from your desktop computer.
1. From the Printing Options tab, locate the Output Destination option, then select one of the mailbox
bins.
2. Click OK.
The prints are delivered to the selected mailbox bin.

Using Special Pages
The Special Pages options control how covers, inserts, and exception pages are added to your printed
document.

e For Windows, the Special Pages tab is on the Document Options tab.

e For Macintosh, in the Print window, in Xerox Features, Special Pages is in the Paper field for
Paper/Output.
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Printing Cover Pages

A cover page is the first or last page of a document. You can select paper sources for the cover pages
that are different from the source used for the body of a document. For example, you can use your
company letterhead for the first page of a document. You can also use heavyweight paper for the first
and last pages of a report. You can use any applicable paper tray as the source for printing cover pages.

Select one of these options for printing cover pages:

¢ No Covers does not print cover pages. No cover pages are added to the document.

e Front Only prints the first page on paper from the specified tray.

e Back Only prints the back page on paper from the specified tray.

e Front and Back: Same prints the front and back cover pages from the same tray.

o Front and Back: Different prints the front and back cover pages from different trays.

After making a selection for printing the cover pages, you can select the paper for the front and back
covers by size, color, or type. You can also use blank or pre-printed paper, and you can print side one,
side two, or both sides of the cover pages.

Printing Insert Pages

You can add blank or pre-printed insert pages before page one of each document or after designated
pages within a document. Adding an insert after designated pages within a document separates sections,
or acts as a marker or placeholder. Ensure that you specify the paper to use for the insert pages.

e Insert Options provides the options to place an insert After Page X, where X is the specified page,
or Before Page 1.
o Insert Quantity specifies the number of pages to insert at each location.

e Pages: Specifies the page or range of pages that use the exception page characteristics. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to specify pages 1, 6,9, 10, and 11, type 1,6,9-11.

e Paper: Displays the default size, color, and type of paper selected in Use Job Settings.

e Job Setting: Displays the attributes of the paper for the remainder of the job.

Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can specify differences
such as page size, page type, and page color. You can also change the side of the paper on which to
print as your job requires. A print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a special
paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages
to print the job.

In the Add Exceptions window, you can set the characteristics of the exception pages and select the
alternate paper source:

e Pages: Specifies the page or range of pages that use the exception page characteristics. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to specify pages 1, 6,9, 10, and 11, type 1,6,9-11.

o Paper: Displays the default size, color, and type of paper selected in Use Job Settings.
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e 2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow to select an
option:
1-Sided Print prints the exception pages on one side only.

2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the
long edge. The job then can be bound on the long edge of the pages.

2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and
flips the pages on the short edge. The job then can be bound on the short edge of the pages.

Use Job Setting prints the job using the attributes shown in the Job Settings box.
e Job Setting: Displays the attributes of the paper for the remainder of the job.

Note

Some combinations of 2-sided printing with certain paper types and sizes can produce unexpected
results.

Printing Watermarks for Windows

A watermark is special-purpose text that can be printed across one or more pages. For example, you can
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before
distribution.

Note

e This feature is available only on a Windows computer printing to a network printer.
e Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

e Watermarks are not supported for some print drivers when booklet is selected or when more than
one page is printed on a sheet of paper.

To print a watermark:
1. In the print driver, click the Document Options tab.
2. Click the Watermark tab.

3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or create
a customized watermark. You can also manage watermarks from this menu.

. Under Text, select an option:

i)

o Text: Enter the text in the field, then specify the font.
e Time Stamp: Specify the date and time options, then specify the font.
e Picture: To locate the picture, click the Browse icon.

(9,1

. Specify the scaling angle and position of the watermark.
o Select the scaling option that specifies the size of the picture in relation to the original image.
Use the arrows to scale the image in increments of 1 %.

o To define the angle of the image on the page, specify the position option or to rotate the image
left or right by increments of 1, use the arrows.

e Todefinethe location of the image on the page, specify the position option, or to move the image
in each direction in increments of 1, use the arrows.

(23}

. Under Layering, select how to print the watermark.
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e Print in Background This option prints the watermark behind the text and graphics in the
document.

¢ Blend: This option combines the watermark with the text and graphics in the document. A blended
watermark is translucent, so you can see both the watermark and the document content.

e Print in Foreground This option prints the watermark over the text and graphics in the document.

7. Click Pages, then select the pages to print the watermark:

o Print on All Pages This option prints the watermark on all pages of your document.
e Print on Page 1 Only This option prints the watermark only on the first page of the document.

8. If you select a picture as a watermark, specify the lightness settings for the image.
9. Click OK.

Orientation

Orientation allows you to select the direction that the page prints.
e For Windows, the Orientation tab is on the Document Options tab.

Note

The orientation setting in your application print dialog box may override the orientation options in the
print driver.

e For Macintosh, Orientation options are in the Print window.

The following options are available:

o Portrait: Orients the paper so that the text and images print across the short dimension of the paper.

e Landscape: Orients the paper so that the text and images print across the long dimension of the
paper.

¢ Rotated Landscape: Orients the paper so that the content is rotated 180 degrees and with the long
bottom side up.

Note

For Macintosh, to print portrait text and images in landscape orientation, clear the Auto Rotate check
box.

Printing Banner Pages

To enable or disable Banner Pages, contact your system administrator, or see the System Administrator
Guide at www.xerox.com/office/VLB605_VLB615docs.

Xerox® VersalLink® B605/B615 Multifunction Printer 5-15
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB605_VLB615&PgName=userdocpdfs&FileName=user_guide&Language=English

Printing

Selecting Job Completion Notification for Windows

You can select to be notified when your job finishes printing. A message appears on your computer
screen with the name of the job and the name of the printer where it was printed.

Note
This feature is only available on a Windows computer printing to a network printer.

To select job completion notification from the Advanced tab:
1. Click Notifications.
2. Click Notify for Completed Jobs, then select an option.

¢ Enabled: This option turns on notifications.

o Disabled: This option turns off the Notification feature.

3. Click OK.

Using Custom Paper Sizes

You can print on custom paper sizes that are within the minimum and maximum size range supported
by the printer. For more information, refer to Supported Custom Paper Sizes.

Printing on Custom Paper Sizes

Note

Before printing on a custom paper size, use the Custom Paper Sizes feature in Printer Properties to define
the custom size. For more information, refer to Defining Custom Paper Sizes.

Printing on Custom Paper Size from Windows

Note
Before printing on custom-size paper, define the custom size in the Printer Properties.

Load the custom-size paper in the tray.

In the application, click File > Print, then select your printer.

In the Print dialog box, click Printer Properties.

On the Printing Options tab, from the Paper list, select the required custom paper size and type.
Select any other required options, then click OK.

In the Print dialog box, click Print.

o wN-=

Printing on Custom Paper Size from Macintosh

1. Load the custom-size paper.

2. In the application, click File > Print.

3. From the Paper Size list, select the custom paper size.
4. Click Print.
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Defining Custom Paper Sizes

To print custom paper sizes, define the custom width and length of the paper in the print driver software
and on the printer control panel. When setting the paper size, ensure that you specify the same size as
the paper in the tray. Setting the wrong size paper can cause a printer error. Print driver settings override
control panel settings when you print using the print driver software on your computer.

Creating and Saving Custom Paper Sizes in the Print Driver

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print
driver and are available for you to select in all your applications.

For more information on supported paper sizes for each tray, refer to Supported Custom Paper Sizes.

Creating and Saving Custom Sizes for Windows

1. In the print driver, click the Printing Options tab.

2. For Paper, click the arrow, then select Other Size > Advanced Paper Size > Output Paper Size > New.
3. In the New Custom Paper Size window, enter the height and width of the new paper size.
4

. To specify the units of measurement, at the bottom of the window, click the Measurements button,
then select Inches or Millimeters.

5. To save, in the Name field, type a title for the new size, then click OK.

Creating and Saving Custom Sizes for Macintosh

In the application, click File > Print.

Click Paper Size, then select Manage Custom Sizes.

To add a new size, in the Manage Paper Sizes window, click the Plus icon (+).

Double-click Untitled, then type a name for the new custom paper size.

Enter the height and width of the new custom paper size.

Click the arrow for the Non-Printable Area field, then select the printer from the list. Or, for User
Defined margins, set the top, bottom, right, and left margins.

7. To save the settings, click OK.

o wN-=

Defining a Custom Paper Size at the Control Panel

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print
driver and are available for you to select in all your applications.

1. At the printer control panel, press the Home button.

Touch Device > Paper Trays.

Touch the desired tray for your custom-size paper.

Touch the current paper size setting, then from the list, touch Custom.

In the Custom Paper Size screen, enter the height and width of the new paper size.
To save the setting, touch OK.

To return to the Home screen, press the Home button.

NourwN
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Paper and Media Overview

Your printer is designed to use various paper and other media types. Follow the guidelines in this section

for the best print quality and to avoid jams:

e Use only Xerox approved paper. For details, refer to Supported Paper.

e Use only dry, undamaged paper.

e Some paper and other media types can cause poor output quality, increased paper jams, or damage
your printer. Refer to Paper That Can Damage Your Printer.

e Ensure that the paper type selected in your print driver matches the paper type on which you are
printing.

e If you have the same size paper loaded in more than one tray, ensure that the proper tray is selected
in the print driver.

e Store your paper and other media properly for optimum print quality. For details, refer to Paper
Storage Guidelines.

Supported Paper

Your printer is designed to use various paper and other media types. To ensure the best print quality
and to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

Recommended Media

A list of paper and media recommended for your printer is available at:

e www.xerox.com/rmlna Recommended Media List (United States)
e www.xerox.com/rmleu Recommended Media List (Europe)
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Ordering Paper

To order paper or other media, contact your local reseller or visit
www.xerox.com/office/VLB605_VLB615supplies.

General Paper Loading Guidelines

e Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.
e Adjust the paper guides to fit the paper size.

e Fan paper before loading it in the paper tray.

o If excessive jams occur, use paper or other approved media from a new package.

e Do not print on label media after a label has been removed from a sheet.

e Use only paper envelopes. Print envelopes 1-sided only.

Paper That Can Damage Your Printer

Some paper and other media types can cause poor output quality, increased paper jams, or damage
your printer. Do not use the following:

e Rough or porous paper

e Inkjet paper

e Non-laser glossy or coated paper

e Paper that has been photocopied

e Paper that has been folded or wrinkled

e Paper with cutouts or perforations

e Stapled paper

e Envelopes with windows, metal clasps, side seams, or adhesives with release strips
e Padded envelopes

¢ Plastic media

e Transparencies

® Caution

The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not cover damage
caused by using unsupported paper or specialty media. The Xerox Total Satisfaction Guarantee is
available in the United States and Canada. Coverage could vary outside these areas. Please contact
your local representative for details.

Paper Storage Guidelines

Storing your paper and other media properly contributes to optimum print quality.

o Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from ultraviolet
and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly damaging to
paper.

e Reduce the exposure of paper to strong lights for long periods of time.

e Maintain constant temperatures and relative humidity.
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» Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect
moisture.

e Store paper flat, either on pallets, cartons, shelves, or in cabinets.
¢ Avoid food or drinks in the area where paper is stored or handled.

» Do not open sealed packages of paper until you are ready to load the paper into the printer. Leave
stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or
gain.

e Some special media is packaged inside resealable plastic bags. Store the media inside the bag until
you are ready to use it. Keep unused media in the bag and reseal it for protection.

Supported Paper Types and Weights

Paper Types Weights
Tray 1 and Trays 2-5 Recycled 60-80 g/m?
Bypass Tray
Plain 60-90 g/m?
Custom 60-105 g/m?
Hole-Punched
Letterhead
Pre-Printed
Bond 91-105 g/m?
Lightweight Cardstock 106-176 g/m?
Cardstock 177-220 g/m?
Labels
High Capacity Feeder (HCF) Recycled 60-80 g/m?
Plain 60-90 g/m?
Custom 60-105 g/m?
Hole-Punched
Letterhead
Pre-Printed
Bond 91-105 g/m?
Lightweight Cardstock 106-176 g/m?
Tray 1 and Bypass Tray Envelopes

Supported Standard Paper Sizes

The paper sizes below are automatically detected in the paper trays and are available as a size selection.
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European Standard Sizes North American Standard Sizes

Bypass Tray A6 (105 x 148 mm, 4.1 x 5.8 in.) Postcard (102 x 152 mm, 4 x 6 in.)
A5 (148 x 210 mm, 5.8 x 8.3 in.) 127 x 178 mm, 5x 7 in.
A4 (210 x 297 mm, 8.3 x11.7 in.) Statement (140 x 216 mm, 5.5 x 8.5in.)
215x 315 mm Executive (184 x 267 mm, 7.25 x 10.5 in.)
DL Envelope (110 x 220 mm, 4.33 x 8.66 in.) 203 x 254 mm, 8 x 10 in.
C5 Envelope (162 x 229 mm, 6.4 x 9 in.) Letter (216 x 279 mm, 8.5x 11 in.)
B51ISO (176 x 250 mm, 6.9 x 9.8 in.) Folio (216 x 330 mm, 8.5x13in.)

Legal (216 x 356 mm, 8.5 x 14in.)
Monarch Envelope (98 x 190 mm, 3.9 x

7.5in.)
No. 10 Envelope (241 x 105 mm, 4.1 x
9.5in.)
Tray 1 and Trays |A5 (148 x 210 mm, 5.8 x 8.3 in.) Executive (184 x 267 mm, 7.25x 10.5 in.)
2-5 A4 (210 x 297 mm, 8.3 x 11.7 in.) Letter (216 x 279 mm, 8.5x 11 in.)
B51ISO (176 x 250 mm, 6.9 x 9.8 in.) Legal (216 x 356 mm, 8.5 x 14in.)
Folio (216 x 330 mm, 8.5x13in.)
High Capacity A4 (210 x 297 mm, 8.3 x11.7 in.) Letter (216 x 279 mm, 8.5x 11 in.)
Feeder (HCF)

Supported Standard Paper Sizes for Automatic 2-Sided Printing

Note
For the Duplex Automatic Document Feeder, refer to Document Feeder Guidelines.

European Standard Sizes North American Standard Sizes

A4 (210 x 297 mm, 8.3 x11.7 in.) Legal (216 x 356 mm, 8.5 x 14 in.)

A5 (148 x 210 mm, 5.8 x 8.3 in.) Letter (216 x 279 mm, 8.5x 11 in.)

215x315mm, 85x12.4in. Folio (216 x 330 mm, 8.5x 13 in.)

B51ISO (176 x 250 mm, 6.9 x 9.8 in.) Executive (184 x 267 mm, 7.25x 10.5in.)
203 x 254 mm, 8 x 10 in.

Supported Paper Types and Weights for Automatic 2-Sided Printing

Paper Type Weight

Recycled 60-80 g/m?

Plain 60-90 g/m?

Custom 60-105 g/m?

Hole-Punched

Letterhead

Pre-Printed

Bond 91-105 g/m?
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Paper Type

Lightweight Cardstock 106-176 g/m?

Supported Custom Paper Sizes

Tray Number Paper Sizes

Tray 1 Minimum: 76 x 190 mm (3 x 7.5in.)
Maximum: 216 x 356 mm (8.5 x 14 in.)

Trays 2-5 Minimum: 76 x 190 mm (3 x 7.5in.)
Maximum: 216 x 356 mm (8.5 x 14 in.)

Bypass Tray Minimum: 76 x 127 mm (3 x 5 in.)
Maximum: 216 x 356 mm (8.5 x 14 in.)

High Capacity Feeder (HCF) A4 or Letter only

2-Sided Printing, not available on the N model Minimum: 140 x 203 mm (5.5 x 8.0 in.)

Maximum: 216 x 356 mm (8.5 x 14in.)

Changing Paper Settings

When you load paper into a tray, you can change the tray settings. The following options are available:

o Fully Adjustable: If you select this paper setting, you can change the paper size, type, and color
when you load paper into the tray.

e Dedicated: If you select this paper setting, you cannot change the paper size, type, and color when
you load paper into the tray.

o Bypass: When paper is present in this tray, it is used for print jobs where you did not specify a particular
tray.

For more information on how to change the paper setting when loading paper in trays 1-5, refer to
Loading Paper in Trays 1 and 2. For more information on how to change the paper setting when loading
paper in the bypass tray, refer to Loading Paper in the Bypass Tray.
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Loading Paper in the Bypass Tray

To load paper in the Bypass Tray:

1. Open the Bypass Tray. If the Bypass Tray is loaded with paper already, remove any paper that is a
different size or type.

4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.
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Note
To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use the
paper.

5. Load the paper in the tray.

Note

Do not load paper above the maximum fill line on the width guides. Overfilling the tray can cause
the printer to jam.

e For 1-sided printing, load letterhead or pre-printed paper face up with the top edge going into
the printer.
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e For 2-sided printing, load letterhead and pre-printed paper face down with the top edge going
into the printer.

7. The printer prompts you to verify the paper type, size and color.

a) If the paper type, size and color are correct, touch OK.
b) If the paper type, size or color are incorrect, change the settings.

e To select a paper type, touch the current paper type, then from the list, select the type.

e To select a sheet size, touch the current size setting, then from the list, select the size.

e To select a different paper color, touch the current paper color, then from the list, select the
color.

¢) To save the settings, touch OK.
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Configuring Tray 1 and Trays 2-5 for the Paper Length

You can adjust the length of the trays to accommodate A4, Letter (8.5 x 11 in.), and Legal (8.5 x 14 in.)
paper sizes. When you use the Legal-length paper setting, the paper tray protrudes from the front of
the printer.

To change the trays to match the paper length:
1. To remove the tray from the printer, pull out the tray until it stops. Lift the front of the tray slightly,

then pull it out.

2. Remove all paper from the tray.
3. To compress the tray for shorter paper, hold the back of the tray with one hand. With the other hand,
press the release latch at the front of the tray, then push the ends inward until they latch.

4. To extend the tray for longer paper, hold the back of the tray with one hand. With the other hand,
press the release latch at the front of the tray, then pull the ends outward until they latch.
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5. To protect the paper when the tray is extended, place the tray cover over the extended section of
the paper tray.

Loading Paper in Trays 1-5

To load paper in Tray 1 and optional Trays 2-5:
1. To remove the tray from the printer, pull out the tray until it stops. Lift the front of the tray slightly
and then pull out the tray completely.
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2. Adjust the paper length and width guides as illustrated.

3. For Legal-size paper, to extend the front of the tray, press the green release latch, then pull the tray
out.

4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.

5. Load paper into the tray with the print-side face up.

¢ Load hole-punched paper with the holes to the left.
e Load label-sheets in the tray face up.

e For 1-sided printing, load letterhead paper face up with the top of the paper toward the back of
the tray.

e For 2-sided printing, load letterhead and pre-printed paper face down with the top edge feeding
into the printer.

Note
Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.
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Note
To avoid paper jams, do not remove the paper cover while printing is in progress.

8. If the tray is extended for Legal-size paper, the tray protrudes when it is fully inserted into the printer.
You can place a cover over the area protruding out of the tray.

6-12 Xerox® VersaLink® B605/B615 Multifunction Printer
User Guide



Paper and Media

9. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the paper type, size, and
color.

a) If the paper type, size and color are correct, touch OK.
b) If the paper type, size or color are incorrect, change the settings.

o To select a paper type, touch the current paper type, then from the list, select the type.
e To select a sheet size, touch the current size setting, then from the list, select the size.
o To select a different paper color, touch the current paper color, then from the list, select the
color.
c) To save the settings, touch OK.
10. To change a paper tray to Dedicated mode:
a) At the printer control panel, press the Home button.
b) Touch Device > Paper Trays.

c) Touch the appropriate tray.
d) To dedicate the tray for a paper size, type, or color, touch Tray Mode, then touch Dedicated.

e To select a paper size, touch the current size setting, then select a size.
e To select a paper type, touch the current paper type, then select a paper type.
e To select a paper color, touch the current paper color, then select a paper color.

e) To save the settings, touch OK.
f) To return to the Home screen, press the Home button.

Loading Paper in the High Capacity Feeder (HCF)

The High Capacity Feeder (HCF) tray accommodates 8.5 x 11 in. / A4 paper only and is loaded in the
short-edge feed (SEF) direction.
1. Pull out the tray slowly until it stops.
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3. Load the paper into the tray.

Note

5. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the paper type, size and
color.

a) If the paper type, size and color are correct, touch OK.
b) If the paper type, size or color are incorrect, change the settings.

e To select a paper type, touch the current paper type, then from the list, select the type.

e To select a paper size, touch the current paper size, then from the list, select the size.

e To select a different paper color, touch the current paper color, then from the list, select the
color.

¢) To save the settings, touch OK.

6-14 Xerox® VersaLink® B605/B615 Multifunction Printer
User Guide



Paper and Media

Setting the Tray Mode

Tray Mode determines if you are prompted to confirm or modify paper settings when you load paper
in the tray. Tray Mode defines how the printer behaves when a paper conflict or mismatch occurs.

To configure the Bypass Tray Mode:

At the printer control panel, press the Home button.

Touch Device > Paper Trays.

Touch the Bypass Tray icon. It is displayed in the top position, before the numbered trays.
Touch Tray Mode.

Touch the desired mode:

s wWwN=

e Bypass prompts you to confirm or modify paper tray settings when paper is loaded in the Bypass
Tray. The Bypass Tray Mode sets the Bypass Tray as the default tray for all print jobs without a
specified tray.

e Fully Adjustable prompts you to confirm or modify paper tray settings when paper is loaded in
the Bypass Tray.

6. To save the setting, touch OK.
7. To return to the Home screen, press the Home button.

Configuring the Tray Mode for Trays 1-5

At the printer control panel, press the Home button.
Touch Device > Paper Trays.

Touch the desired tray.

Touch Tray Mode.

Touch the desired mode:

s wWwN=

e Fully Adjustable prompts you to confirm or modify paper tray settings when paper is loaded in
a tray.

o Dedicated uses the current paper size and type settings and does not prompt you to confirm or
modify the settings. Select this setting to use a tray for printing on a specific paper type and size,
such as letter-size or hole-punched paper.

6. To save the setting, touch OK.
7. To return to the Home screen, press the Home button.

Printing on Special Paper

To order paper or other media, contact your local reseller or visit
www.xerox.com/office/VLB605_VLB61 5supplies.

For reference:

e www.xerox.com/rmlna Recommended Media List (United States)
e www.xerox.com/rmleu Recommended Media List (Europe)
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Envelopes

You can print envelopes from Tray 1 or the Bypass Tray.

Guidelines for Printing Envelopes

Use only paper envelopes.
Do not use envelopes with windows or metal clasps.

Print quality depends on the quality and construction of the envelopes. If you do not get the desired
results, try another envelope brand.

Maintain constant temperatures and relative humidity.

Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect
print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during
printing.

Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book
on top of the envelopes.

In the print driver software, select Envelope as the paper type.

Do not use padded envelopes. Use envelopes that lie flat on a surface.

Do not use envelopes with heat-activated glue.

Do not use envelopes with press-and-seal flaps.

Loading Envelopes in the Bypass Tray

1.

Open the Bypass Tray.
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3. Move the width guides to the edges of the tray.

Note

o To prevent jams, ensure that the leading edge of the envelopes are flat or have only a slight
upward curl, less than 5 mm (.19 in.), before loading into the tray. If the edge is curled or swollen,
fold it over to decurl. The length of the curl must be within 810 mm (.31-.39 in.). Downward
curl at the leading edge of envelopes is not acceptable and can cause a jam or misfeed.

e Load envelopes up to 16.5 mm (.65 in.) in height. This is approximately 10-20 envelopes,
depending on brand, size, and texture.

e If you do not load envelopes in the Bypass Tray right after you have removed the envelopes
from the packaging, the envelopes can bulge. To avoid jams, flatten the envelopes before loading
them into the tray.

4. To load the envelopes, select an option:

e For Number 10 envelopes, load the envelopes with the short edge going into the printer, flaps
down, and flaps to the right.

N\
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e For Monarch or DL envelopes, perform one of the following steps. If the envelopes wrinkle, try
another option.

Load envelopes with the short edge going into the printer, flaps down, and flaps to the right.

Load envelopes with the print-side up, flaps open and down, and the bottom of the envelope
going into the printer.

e For C5 envelopes, perform one of the following steps. If the envelopes wrinkle, try the other option.

Load envelopes with the print-side up, flaps open and down, and the bottom of the envelope
going into the printer.
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Load envelopes with the print-side up, flaps closed and down, and short edge going into the
printer.

Note

For envelopes to print correctly, load envelopes with the flaps open. In the print driver, select
Portrait, Landscape, or Rotated Landscape, as needed. To flip the images, select Rotate
Image 180 Degrees.

5. Adjust the width guides until they touch the edges of the envelopes.
6. The printer prompts you to verify the paper type, size, and color.

a) If the paper type, size, and color are correct, touch OK.
b) If the paper type, size, or color are incorrect, change the settings.
o To select a paper type, touch the current paper type, then from the list, select Envelope.
e To select a size, touch the current size setting, then from the list, select the size.
e To select an envelope color, touch the current paper color, then from the list, select the color.

c) To save the settings, touch OK.

Loading Envelopes in Tray 1

1. To remove the tray from the printer, pull out the tray until it stops. Lift the front of the tray slightly,
then pull it out.
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2. Remove any paper in the tray.
3. Adjust the paper length and width guides as illustrated.

—

B5
—
10.5”

—
11»

4. Load envelopes in the trays with the flaps closed, flap-side down, and the short edge leading into
the printer.

Note
Do not load more than 50 envelopes into the tray, up to 45 mm (1.8 in.) in height.

5. Adjust the width guides until they touch the edges of the envelopes.
6. Slide the tray all the way into the printer.

7. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the paper type, size and
color.
a) If the paper type, size and color are correct, touch OK.
b) If the paper type, size or color are incorrect, change the settings.

6-20 Xerox® VersaLink® B605/B615 Multifunction Printer
User Guide



Paper and Media

o To select a paper type, touch the current paper type, then from the list, select Envelope.

o To select a size, touch the current size setting, then from the list, select Custom. Touch the
Length field and select a number value. Touch the Width field and select a number value.
Select OK.

e To select a different color, touch the current paper color, then from the list, select the color.

¢) To save the settings, touch OK.

8. From the Print dialog at your workstation, select the paper setting values and click OK. To feed and

print the envelopes, click Print.

Labels

You can print labels from the Bypass Tray or Tray 1.

Guidelines for Printing Labels

Use labels designed for laser printing.

Do not use vinyl labels.

Do not feed a sheet of labels through the printer more than once.

Do not use dry gum labels.

Print only on one side of the sheet of labels. Use full-sheet labels only.

Store unused labels flat in their original packaging. Leave the label sheets inside the original packaging
until ready to use. Return any unused label sheets to the original packaging and reseal it.

Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing
labels in extreme conditions can cause print-quality problems or cause labels to jam in the printer.

Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and
jam in the printer.

In the print driver software, select Label as the paper type.
Before loading labels, remove all other paper from the tray.

A .
/1N Warning

Do not use any sheet where labels are missing, curled, or pulled away from the backing sheet. It could
damage the printer.
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Loading Labels in the Bypass Tray
1. Open the Bypass Tray. If the tray is already open, remove all paper from the tray.

4. Load sheet-labels in the Bypass Tray, face up, with the top edge of the page feeding into the printer
first.
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5. Adjust the width guides until they touch the edges of the paper.

6. The printer prompts you to verify the type, size and color of the label sheets.

a) If the type, size and color are correct, touch OK.
b) If the type, size or color are incorrect, change the settings.

o To select the type, touch the current paper type, then from the list, select Labels.
e To select a size, touch the current size setting, then from the list, select a size.
e To select the color, touch the current paper color, then from the list, select a color.

c) To save the settings, touch OK.

Loading Labels in Tray 1

1. To remove the tray from the printer, pull out the tray until it stops. Lift the front of the tray slightly,
then pull it out.

2. Adjust the paper length and width guides.
3. Load the label sheets in the tray, face up.
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Note
Do not load paper above the maximum fill line. Overfilling can cause paper jams.

5. Push the tray in all the way.

6. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the label sheet size, type
and color.

a) If the paper size, type and color are correct, touch OK.
b) If the paper size, type or color are incorrect, change the settings.

o To select a sheet size, touch the current size setting, then from the list, select the size.
e To select the paper type, touch the current paper type, then from the list, select Labels.
o To select a different color, touch the current color, then from the list, select the color.

c) To save the settings, touch OK.
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General Precautions

@ Caution

When cleaning your printer do not use organic or strong chemical solvents or aerosol cleaners. Do not
pour fluids directly into any area. Use supplies and cleaning materials only as directed in this
documentation.

A Warning
Keep all cleaning materials out of the reach of children.

A Warning

Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays contain explosive
mixtures and are not suitable for use in electrical applications. Use of pressurized spray cleaners increases
the risk of fire and explosion.

A Warning

Do not remove the covers or guards that are fastened with screws. You cannot maintain or service any
parts that are behind these covers and guards. Do not attempt any maintenance procedure that is not
described in the documentation supplied with your printer.

A Warning
Internal parts of the printer can be hot. Use caution when doors and covers are open.

Do not place anything on top of the printer.

Do not leave the covers and doors open for any length of time, especially in well-lighted places. Light
exposure can damage the drum cartridges.

Do not open covers and doors during printing.
Do not tilt the printer while it is in use.

Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print
quality to deteriorate.

Ensure that any parts removed during cleaning are replaced before you plug in the printer.
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Cleaning the Printer

Cleaning the Exterior

Clean the exterior of the printer once a month.

e Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth.
e After cleaning, wipe with a dry, soft cloth.

e For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the stain
off.

@ Caution

Do not spray detergent directly on the printer. Liquid detergent could enter the printer through a gap
and cause problems. Never use cleaning agents other than water or mild detergent.

Cleaning the Scanner

Clean the scanner about once a month, when anything is spilled on it, or when debris or dust collect on
any of the surfaces. Keep the feed rollers clean to ensure the best possible copies and scans.

1. Remove any paper from the Document Feeder Tray, and the Document Output Tray.

3. Slightly dampen a soft, lint-free cloth with water.
4. Clean the document glass.
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Note
For best results, use Xerox® Glass Cleaner to remove marks and streaks.

5. Clean the CVT glass.

Note
For best results, use Xerox® Glass Cleaner to remove marks and streaks.
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7. To access the second-side scanning lens assembly, lower the Second-Side Scanning Access Cover.

I

S

8. Using a soft cloth moistened with water, wipe the mirrored glass, the white-plastic strip, and the
rollers. If dirt is difficult to remove, moisten a soft cloth with a small amount of neutral detergent,
then wipe the printer parts dry with a soft cloth.

Note
To prevent damage to the film around the glass, do not press heavily on the mirrored glass.
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10. Close the Document Cover.

Cleaning the Feed Rollers on the Duplex Automatic Document Feeder
1. Open the Top Cover.

2. Wipe the feed rollers with a dry, soft, lint-free cloth until they are clean.
Note

If the feed rollers get stained with toner or debris, they can cause stains on the documents. To remove
the stains, use a soft lint-free cloth dampened with a neutral detergent or water.

3. Close the Top Cover.
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Cleaning the Interior

A Warning

e Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If a sheet of
paper is wrapped around the heat roller, do not try to remove it immediately. Power off the printer
immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the printer has
cooled.

o If you spill any toner in the printer, remove the toner using a moist cloth. Never use a vacuum cleaner
to remove spilled toner. Sparks inside the vacuum cleaner can cause a fire or explosion.

To prevent stains inside the printer that can deteriorate print quality, clean the interior of the printer
regularly. Clean the printer interior whenever you replace the drum cartridge.

After clearing paper jams or replacing a toner cartridge, inspect the inside of the printer before closing
the printer covers and doors.

e Remove any remaining pieces of paper or debris. For more information, refer to Clearing Paper Jams.
e Remove any dust with a dry, clean cloth.

Cleaning the LED Lens
1. Open the Front Door of the printer.

2. ® Caution

Until the Front Door is opened fully, the Toner Cartridge is locked in place. To prevent damaging the
printer, ensure that the Front Door is opened fully before attempting to remove the Toner Cartridge.
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To remove the Toner Cartridge, grip both its handles, then pull the Toner Cartridge straight out of
the printer. Place the removed Toner Cartridge on a level surface.

3. ® Caution
Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent lighting. Do not
touch or scratch the green surface of the Drum Cartridge.

To remove the Drum Cartridge, grip the orange handle, then pull the Drum Cartridge straight out of
the printer. Place the removed Drum Cartridge on a clean, level surface.
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5. Remove the cleaning pad from the cleaning tool by pushing in on the two tabs. Properly recycle the
used cleaning pad.

Note

If the cleaning pad is dirty, replace it. A replacement cleaning pad is included with the Drum Cartridge
Replacement Kit.

F

7. To remove any debris or toner dust, set the cleaning tool on the LED Lens Block. Slide the cleaning
tool until it stops at one end of the LED Lens Block. Then slide the cleaning tool in the other direction
until it stops at the opposite end. Repeat this motion two more times.
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8. Replace the cleaning tool into its storage location inside the Front Door.
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11. Close the Front Door.

Adjustments and Maintenance Procedures

Adjusting Paper Registration

Use Adjust Paper Registration to adjust the placement of the printed image on the page. The adjustment
allows you to place the top, bottom, left, and right margins exactly where you want. You can specify the
image position on both the front and back sides of the paper, for each installed paper tray.

Verifying Paper Registration

1.
2.

7-10

At the printer control panel, press the Home button.

Log in as administrator. For details, refer to the System Administrator Guide at
www.xerox.com/office/VLB605_VLB615docs.

Touch Device > Support > Image Position.
Select the source paper tray for the registration print.

a. Touch Paper Supply.
b. Touch the desired tray.

If your printer has automatic 2-sided printing, select the sides that you want to optimize.

e Toselect asample registration page for adjusting side 1, touch Adjusted Side, then touch Side 1.

e To select a sample registration page for adjusting both sides, touch Adjusted Side, then touch
Side 2.

Specify the consecutive number of sample pages to print.

a. Touch Print Settings.
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b. To increase or decrease the number of sample pages, for Quantity, touch the Plus icon (+) or
the Minus icon (-), then touch OK.

To print the sample pages, touch Print Sample.
When printing is completed, touch Close.

On the sample pages, for Side 1, use a ruler to measure the distance of the printed image from the
top, bottom, left, and right edges.

Note
For identification, a single dot is printed on Side 1, and two dots are printed on Side 2.

b
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For Side 2, measure the distance of the printed image from the top, bottom, left, and right edges.

If the image is centered, no adjustment is required. If the image is not centered, adjust the paper
registration. For more information, refer to Performing a Paper Registration Adjustment.

Performing a Paper Registration Adjustment

1. At the control panel, press the Home button.
2. Login as administrator. For details, refer to the System Administrator Guide at
www.xerox.com/office/VLB605 VLB615docs.
3. Touch Device > Support > Image Position.
4. To adjust registration, select the source paper tray.
a. Touch Paper Supply.
b. Touch the desired tray.
5. Using the chart printed in Verifying Paper Registration, select the side for registration.
a. Foradjusting Side 1, touch Adjusted Side, then touch Side 1.
b. For adjusting Side 2, touch Adjusted Side, then touch Side 2.
6. To adjust the registration, touch Lead/Side Registration.
a. Toadjust the side-to-side registration, for Side Registration, touch the Plus icon (+) or the Minus
icon (-).
b. To adjust the top-to-bottom registration, for Lead Registration, touch the Plus icon (+) or the
Minus icon (-).
For reference, position the chart so that Side-1 or Side-2 dots are at the bottom of the page.
e For Lead Registration, a positive value shifts the image down the page.
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o For Side Registration, a positive value shifts the image to the left.

=

7. To save your settings, touch OK.
8. As needed, to enter additional values, repeat the previous steps.

9. Print another sample page, then repeat the process until you complete the registration corrections.
10. To return to the Home screen, press the Home button.

Adjusting the Density

The Adjust Density feature controls how much toner is used to print. Adjust the density for lighter toner
use for saving toner, or adjust for heavier density to make prints bolder. A positive adjustment makes
the prints darker, while a negative adjustment makes the prints lighter. You can also adjust density to
compensate for different paper types and thicknesses.

To adjust the density:

At the printer control panel, press the Home button.

Touch Device > Support > Adjust Density > Density Level.
To adjust the density level, move the slider.

To save your setting, touch OK.

To return to the Home screen, press the Home button.

nunswN =

Scan Color Consistency

Use the Scan Color Consistency procedure to adjust scanned colors that appear incorrect, or for composite
grays that look neutral. This procedure prints a Calibration Chart that you load into the automatic
document feeder. The printer scans that page and uses the scanned values to complete the adjustments.

To perform the Scan Color Consistency procedure:

1. At the printer control panel, press the Home button.

2. Touch Device > Support > Scan Color Consistency.

3. To select the desired procedure, touch Calibration Type, then select a procedure.

e To perform the Scan Color Consistency procedure, touch Print Calibration Chart>Start.

Follow the onscreen instructions, but discard the printed black-and-white calibration chart, then
use the color calibration chart that shipped with the scanner.

o Torestore the color scan settings to the previous settings, touch Restore Previous Settings. Follow
the onscreen instructions.
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e Toreset the color scan settings to factory-default values, touch Reset to Factory Defaults. Follow
the onscreen instructions.

4. When finished, touch Close.
5. To exit the menu, touch X.
6. When finished, to return to the Home screen, press the Home button.

Refreshing the Toner

Toner Refresh recalibrates toner concentration and developer voltages. If you print documents with
high or low toner coverage, Toner Refresh can optimize print quality.

Note

Do not use this procedure repeatedly. Running the procedure repeatedly uses the toner supply more
quickly.

To refresh the toner:

At the printer control panel, press the Home button.
Touch Device > Support > Toner Refresh.

To perform a Toner Refresh process, touch Start.

At the successfully completed prompt, touch Close.
To exit the menu, touch X.

To return to the Home screen, press the Home button.

ot wN-=

Transfer Voltage Adjustment

Use Transfer Voltage Adjustment to specify the bias transfer roller voltage for printing on the selected
paper type. If the printed image is too light, increase the voltage for the paper you are using. If the
printed image is mottled or blotchy-looking, decrease the voltage for the paper you are using.

To adjust the transfer voltage:

At the printer control panel, press the Home button.

Touch Device > Support > Transfer Voltage Adjustment.

To select the paper type for the adjustment, touch Paper Type, then touch the required paper type.
To adjust the transfer voltage, for Voltage Level, touch the Plus icon (+) or the Minus icon (-).

Touch Adjust.

To exit the menu, touch X.

To return to the Home screen, press the Home button.

NounLrwN-=

Adjusting the Fuser

Use Adjust Fuser for optimum print quality across a wide range of paper types. If the toner on a print
is smeared or can be rubbed off the paper, increase the temperature for the paper you are using. If the
toner is blistered or mottled, decrease the temperature for the paper you are using.

To adjust the fuser:

1. At the printer control panel, press the Home button.

2. Touch Device > Support > Fuser Temperature Adjustment.

3. To select the paper type, touch Paper Type, then touch the name of the paper type in the list.
4. To increase or decrease the fusing temperature, touch the arrow buttons, then touch Adjust.
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5. To adjust the Fuser for another paper type, select it from the list, then repeat steps 3 and 4.
6. To exit the menu, touch X.
7. To return to the Home screen, press the Home button.

Adjusting the Altitude

Use Adjust Altitude to adjust the altitude to match that of the location where the printer is installed. If
the altitude setting is incorrect, it can cause print-quality problems.

To adjust the altitude:

1. At the printer control panel, press the Home button.

2. Touch Device > Support > Altitude Adjustment.

3. Touch the altitude of the location of the printer, then touch OK.
4. To return to the Home screen, press the Home button.

Performing a Developer and Transfer Roller Cleaning Procedure

When a printer sits idle for an extended time, visible background toner can potentially appear on prints.
Use the Developer and Transfer Roller Cleaning procedure to reduce background toner on prints.

To perform a Developer and Transfer Roller Cleaning procedure:

At the printer control panel, press the Home button.

Touch Device > Support > Developer & Transfer Roller Cleaning.

To perform a Developer and Transfer Roller Cleaning procedure, touch Start.
At the successfully completed prompt, touch Close.

To exit the menu, touch X.

To return to the Home screen, press the Home button.

ot wWwN-R=

Supplies

Consumables

Consumables are printer supplies that get depleted during the operation of the printer. The consumable
supply for this printer is the genuine Xerox® Black Toner Cartridge.

Note

e Each consumable includes installation instructions.

¢ Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner remaining
amount displayed could be inaccurate.

e To ensure print quality, the toner cartridge has been designed to cease functioning at a predetermined
point.

@ Caution

Use of toner other than genuine Xerox® Toner can affect print quality and printer reliability. Xerox®
Toner is the only toner designed and manufactured under strict quality controls by Xerox for specific
use with this printer.
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Routine Maintenance Items

Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements can be parts or kits. Routine maintenance items are typically customer-replaceable parts.
Note

Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:

e Drum Cartridge Kit
e Transfer Roller

e Feed Roller

e Fuser

Ordering Supplies
When to Order Supplies

A warning appears on the control panel when supplies near their replacement time. Verify that you have
replacements on hand. It is important to order these items when the messages first appear to avoid
interruptions to your printing. An error message appears on the control panel when supplies must be
replaced.

Order supplies from your local reseller or go to www.xerox.com/office/VLB605_VLB615supplies.

@ Caution

Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and Total
Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by
use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total Satisfaction
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please
contact your Xerox representative for details.

Supply Status Information

You can check the supplies status, customize the alerts that appear on the control panel, and configure
email alert notifications. For more information, refer to the Supply Status.

Supplies Usage Report

The Supplies Usage Report provides coverage information and part numbers for reordering supplies.
The date a supply item was installed also appears on the report.

To print the Supplies Usage Report:

1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.

3. Touch Supplies Usage Report.

4. To return to the Home screen, press the Home button.
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Toner Cartridges

General Precautions

A Warning

e When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid contact
with clothes, skin, eyes, and mouth. Do not inhale the toner dust.

e Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have the
child spit out the toner, and rinse the mouth with water. Consult a physician immediately.

A Warning

Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills. Electric sparks
inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of toner, contact your
local Xerox representative.

A Warning

Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can catch fire and
cause burn injuries or an explosion.

Replacing a Toner Cartridge

A message appears on the control panel when a toner cartridge must be replaced.

Note
Each toner cartridge includes installation instructions.

Printer Status Message Cause and Solution

Reorder Toner The toner cartridge is low. Order a new toner cartridge.

Out of Toner The toner cartridge is empty. Replace the toner cartridge
with a new one.

Recycling Supplies

For more information on the Xerox® supplies recycling program, go to www.xerox.com/gwa.

Managing the Printer

Viewing the Meter Reading

The Billing/Usage menu displays the total number of impressions that the printer generated or printed
during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper. For
example, a sheet of paper that is printed on two sides counts as two impressions.
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Note

If you provide regular billing information for your device, you can use the Remote Services Upload
feature to simplify the process. You can enable Remote Services to send billing meter readings to Xerox
automatically so that you do not have to collect the readings manually. For more information, refer to
the System Administrator Guide at www.xerox.com/office/VLB605_VLB675docs.

To view the billing information for your printer:

1. At the printer control panel, press the Home button.

2. Touch Device > Billing/Usage.

3. To view more details, touch Usage Counters, then select an option.

4. After viewing the usage readings, to return to the Home screen, press the Home button.

Printing the Billing Summary Report

The Billing Summary Report provides information about the device and a detailed listing of the billing
meters and sheet counts.

To print the Billing Summary Report:

1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.

3. Touch Billing Summary Report.

4. To return to the Home screen, press the Home button.

Moving the Printer

/\\ .
/!\ Warning

e To lift the printer, always use at least two people to grasp the hand holds on each side of the printer.

e To prevent you from dropping the printer or injury, lift the printer firmly by gripping the recessed
areas on both sides of the printer. Never lift the printer by gripping any other areas.

e If the optional 550-Sheet Feeder is installed, uninstall it before you move the printer. If the optional
550-Sheet Feeder is not fixed to the printer securely, it could fall to the ground and cause injury.

Follow these instructions when moving the printer:
1. Power off the printer, then disconnect the power cord and other cables from the back of the printer.

Note

To prevent electric shock, never touch the power plug with wet hands. When removing the power
cord, ensure that you pull the plug and not the cord. Pulling the cord can damage it, which can lead
to fire or electric shock.

Xerox® VersalLink® B605/B615 Multifunction Printer 7-17
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB605_VLB615&PgName=userdocpdfs&FileName=user_guide&Language=English

Maintenance

4. Remove any paper or other media from the Output Tray.
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5. If the Output Tray Extension is extended, close it.

7. Keep the paper wrapped and stored away from humidity and dirt.
8. If the optional 550-Sheet Feeder is installed, unlock, then uninstall it before you move the printer.
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9. Lift and carry the printer as shown in the illustration.

Note

e When moving the printer, do not tilt it more than 10 degrees in any direction. Tilting the printer
more than 10 degrees can cause toner spillage.

e Repack the printer and its options using the original packing material and boxes or a Xerox
Repackaging Kit.

e Failure to repackage the printer properly for shipment can result in damage not covered by the
Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty,
Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused
by improper moving.

After moving the printer:

1. Reinstall any parts that you removed.
2. Reconnect the printer to the cables and power cord.
3. Plug in and power on the printer.
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General Troubleshooting

This section contains procedures to help you locate and resolve problems. Resolve some problems by
simply restarting the printer.

Printer Does Not Power On

® Caution
Plug the three-wire cord with grounding prong directly into a grounded AC outlet.

Probable Causes Solutions

The power switch is not turned on. At the printer control panel, press the Power/Wake
button. For more information, refer to Power Options.

The power cord is not plugged into the outlet correctly. | Power off the printer, then plug the power cord securely
into the outlet.

The printer requires a full reset. Power off the printer, then unplug the power cord and
wait 30 seconds. Plug the power cord into the outlet se-
curely, then press the Power/Wake button.

Something is wrong with the outlet connected to the | Plug another electrical appliance into the outlet, then
printer. check if it operates properly.
Try a different outlet.

The printer is connected to an outlet with a voltage or |Use a power source with the specifications listed in the
frequency that does not match the printer specifications. | Electrical Specifications.
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Printer Resets or Powers Off Frequently

Probable Causes Solutions

The power cord is not plugged into the outlet correctly.

Power off the printer, confirm that the power cord is
plugged in correctly to the printer and the outlet, then
power on the printer.

A system error occurred.

Power off the printer, then power on again. For more
information, refer to Printing the Error History Report.
If the error persists, contact your Xerox representative.

The printer is connected to an uninterruptible power
supply.

Power off the printer, then connect the power cord to a
suitable outlet.

The printer is connected to a power strip shared with
other high-power devices.

Plug the printer directly into the outlet or into a power
strip that is not shared with other devices.

The Auto Power Off feature is enabled to save power.

Increase the Auto Power Off timer setting or disable
the Auto Power Off feature. For more information, refer
to the System Administrator Guide at www.xerox.com/of-
fice/VLB605_VLB615docs.

Printer Does Not Print

Probable Causes Solutions

The printer is in Power Saver mode.

On the control panel, press the Power/Wake button.

The printer has an error.

If the Status LED is blinking amber, follow the instruc-
tions on the control panel to clear the error. If the error
persists, contact your Xerox representative.

The printer is out of paper.

Load paper into the tray.

The incorrect paper is loaded for the print job.

Load the correct paper in the appropriate tray. At the
printer control panel, specify the correct paper size, type
and color.

The paper settings for the print job do not match any
paper loaded in the paper trays at the printer.

From the print driver, select a paper tray containing the
correct paper.

A toner cartridge is empty.

Replace the empty toner cartridge.

No control panel indicators are lighted.

Power off the printer, confirm that the power cord is
plugged in correctly to the printer and the outlet, then
power on the printer. If the error persists, contact your
Xerox representative.

The printer is busy.

If the Status LED is flashing blue, a previous print job
could be the problem.
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Probable Causes Solutions

1. Inthe print driver, use the Printer Properties to
delete all print jobs in the print queue.

2. At the control panel, touch Jobs, then delete
all pending print jobs.

e Load the paper in the tray.

e If the Status LED does not flash once after you send
a print job, check the connection between the printer
and the computer. Power off the printer, then power
on the printer.

The printer cable is disconnected.

If the Status LED does not flash once after you send a
print job, check the connection between the printer and
the computer.

There is a network-connectivity issue.

If the printer is connected to a network:
1. Verify that the Ethernet cable is connected to the
printer.

2. On the printer Ethernet connector, verify that the
green LED is On. If the green LED is not lighted, re-
seat both ends of the Ethernet cable.

3. Examine the TCP/IP address in the Communication
section of the Configuration Report. For more in-
formation, refer to Printing the Configuration Re-
port.

4. If the TCP/IP address is 0.0.0.0, the printer needs
more time to acquire an IP address from the DHCP
server. Wait 2 minutes, then print the Configuration
Report again.

5. If the TCP/IP address is unchanged, or begins with
169, contact your network administrator.

There is a wireless network setup or connectivity issue.

Verify that the Wireless Network Adapter is installed
and properly configured. For more information, refer to
Connecting to a Wireless Network.

Printing Takes Too Long

Probable Causes Solutions

The printer is set to a slower printing mode. For example,
the printer could be set to print on heavyweight paper.

It takes more time to print on certain types of special
paper. Ensure that the paper type is set properly in the
print driver and at the printer control panel. For more
information, refer to Print Speed.

The printer is in Power Saver mode.

It takes time for printing to start when the printer is ex-
iting Power Saver mode.
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Probable Causes Solutions

The print bei ly installed on the network.
€ printermaybe Improperly Instafled onthe network 1, Determine if a print spooler or a computer sharing

the printer is buffering all print jobs and then spool-
ing them to the printer. Spooling can slow print
speeds.

e Totest the speed of the printer, print some Informa-
tion Pages such as the Demonstration Print. If the
page prints at the rated speed of the printer, there
could be a network or printer installation issue. For
additional help, contact the system administrator.

The job is complex. Wait. No action needed.

The print-quality mode in the print driver is set to En- [ Change the print-quality mode in the print driver to
hanced. Standard.

Document Prints from Wrong Tray

Probable Causes Solutions

Application and print driver have conflicting tray selec- [1.  Check the tray selected in the print driver.

tions. 2. Access the page setup or printer settings of the
application from which you are printing.

3. Set the paper source to match the tray selected in
the print driver or set the paper source to Automat-
ically Select.

4. Check that you have the latest print driver installed.
For details, go to www.xerox.com/of-
fice/VLB605_VLB615support.

Note

To have the print driver select the tray, set the tray used
as the paper source to Auto Selection Enabled.

Automatic 2-Sided Printing Problems

Probable Causes Solutions

Unsupported or incorrect paper. Ensure that you are using a supported paper size and
weight for 2-sided printing. Envelopes, cardstock, and
labels cannot be used for 2-sided printing. For more in-
formation, refer to Supported Paper Types and Weights
for Automatic 2-Sided Printing and Supported Standard
Paper Sizes for Automatic 2-Sided Printing.

Incorrect setting. In the print driver Printing Options tab, select 2-Sided
Print.
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Printer is Making Unusual Noises

Probable Causes Solutions

There is an obstruction or debris inside the printer. Power off the printer, then remove the obstruction or
debris. If you cannot remove the obstruction, contact
your Xerox representative.

Paper Tray Will Not Close

Probable Causes Solutions

Th tray d t fully close.
© paper tray does not fufly close o If the tray is extended for legal-size paper, the tray

protrudes when it is inserted into the printer. For
more information, refer to Configuring Trays 1 or 2
for the Paper Length.

e Some debris or an object is blocking the tray.

e The tray is blocked by the table or shelf on which it
is located.

e If the paper lift plate at the back of the tray is not
locked down, replace the tray.

Condensation Has Formed Inside the Printer

Moisture can condense in the printer when room humidity exceeds 85 % or when a cold printer is located
in a warm room. Condensation can form in a printer after it has been sitting in a cold room that is heated
quickly.

Probable Causes Solutions

The printer has been sitting in a cold room. Allow the printer to operate for several hours at room
temperature.

The relative humidity of th is too high.
€ relative humidity ot the room is too hig e Reduce the humidity in the room.

e Move the printer to a location where the temperature
and relative humidity are within the operating spe-
cifications. For more information, refer to Environ-
mental Specifications.
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Paper Jams

Locating Paper Jams

A Warning

Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If a sheet of paper
is wrapped around the heat roller, do not try to remove it immediately. Power off the printerimmediately
and wait 40 minutes for the fuser to cool. Try to remove the jam after the printer has cooled. If the error
persists, contact your Xerox representative.

@ Caution

Do not attempt to clear any paper jams using tools or instruments. This can permanently damage the
printer.

The following illustration shows where paper jams can occur along the paper path:

1. Tray 2
2. Optional Mailbox or Finisher

Bypass Tray
Tray 1
3. Fuser

Minimizing Paper Jams

The printer is designed to function with minimal paper jams using Xerox-supported paper. Other paper
types can cause jams. If supported paper is jamming frequently in one areq, clean that area of the paper
path.

The following can cause paper jams:

e Selecting the incorrect paper type in the print driver
e Using damaged paper

e Using unsupported paper

e Loading paper incorrectly

e Overfilling the tray
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Adjusting the paper guides improperly

Most jams can be prevented by following a simple set of rules:

Use only supported paper. For more information, refer to Supported Paper.
Follow proper paper handling and loading techniques.

Always use clean, undamaged paper.

Avoid paper that is curled, torn, moist, creased, or folded.

To separate the sheets before loading into the tray, fan the paper.

Do not load paper above the paper tray fill line.

After loading paper in the trays, adjust the paper guides in all trays. A guide that is not properly
adjusted can cause poor print quality, misfeeds, skewed prints, and printer damage.

After loading paper in the trays, at the control panel, select the correct paper type and size.
Before printing, select the correct type and size paper in the print driver.
Store paper in a dry location.

The following can cause paper jams:

Polyester-coated paper that is designed especially for inkjet printers

Paper that is folded, wrinkled, or excessively curled

Loading more than one type, size, or weight of paper in a tray at the same time
Loading paper above the MAX fill line in the paper tray

Allowing the output tray to become overfilled

For a detailed list of supported paper, go to www.xerox.com/rmlna.
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Clearing Paper Jams

Clearing Paper Jams from the Duplex Automatic Document Feeder

1. Open the Top Cover and remove any paper.

Cover.
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3. To access the jammed paper, open the Second-Side Scanning Access Cover, then remove any jammed
paper.

To prevent paper jams:

e Do not load original documents above the MAX fill line.
o Adjust the paper guides so that they fit against the original documents.
e Use only supported paper. For more information, refer to Document Feeder Guidelines.
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Clearing Paper Jams from the Bypass Tray

To resolve the error displayed on the control panel, you must clear all paper from the paper path.
1. Remove any paper from the Bypass Tray.
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4. Remove the jammed paper.

S

5. Insert Tray 1 into the printer, then push it all the way in.

Note

If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the printer. If
removed in a previous step, replace the tray cover.

7. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper settings.
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a) To confirm the same paper size, type, or color, touch OK.

b) To select a new paper size, type, or color, touch the current setting, then select a new setting.
When finished, touch OK.

8. To return to the Home menu, press the Home button.

Clearing Paper Jams from the Tray 1 Area

To resolve the error displayed on the control panel, you must clear all paper from the paper path.
1. Remove any paper from the Bypass Tray.
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4. Remove any crumpled paper from the tray and any remaining paper jammed in the printer.

S

5. Insert Tray 1 into the printer, then push it all the way in.

Note

If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the printer. If
removed in a previous step, replace the tray cover.

7. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper settings.
a) To confirm the same paper size, type, or color, touch OK.
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b) To select a new paper size, type, or color, touch the current setting, then select a new setting.
When finished, touch OK.

8. To return to the Home menu, press the Home button.
Clearing Paper Jams from the Trays 2-5 Areas

To resolve the error displayed on the control panel, clear all paper from the paper path.
1. For the tray reported on the Touch Screen Display, pull out the tray until it stops.

3. Remove any crumpled paper from the tray and any remaining paper jammed at the front of the
printer.

8-14 Xerox® VersaLink® B605/B615 Multifunction Printer
User Guide



Troubleshooting

4. Forthe same tray, at the back of the printer, locate the jam-access door. Open the door, then remove
any jammed paper.

Vi

5. Re-insert the paper tray into the printer, then push the tray in until it stops.

Note

If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the printer. If
removed in a previous step, replace the tray cover.

6. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper settings.
a) To confirm the same paper size, type, or color, touch OK.

b) To select a new paper size, type, or color, touch the current setting, then select a new setting.
When finished, touch OK.

Clearing Paper Jams from the Fuser Area

To resolve the error displayed on the control panel, clear all paper from the paper path.
1. Lift the rear door release and pull open the door.
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2. To open the paper guide on the top of the fuser, lift the paper guide tab.
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5. Close the rear door.

Clearing Paper Jams from the Finisher

To resolve the error displayed on the control panel, clear all paper from the paper path.

1. At the back of the printer, locate the Finisher jam-access door. Open the door, then remove any
jammed paper.

2. Close the jam-access door. To clear any remaining errors, follow the instructions on the control panel.
Clearing Paper Jams from the Mailbox

To resolve the error displayed on the control panel, clear all paper from the paper path.

1. At the back of the printer, locate the Mailbox jam-access door. Open the door, then remove any
jammed paper.

2. Close the jam-access door. To clear any remaining errors, follow the instructions on the control panel.
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Troubleshooting Paper Jams
Multiple Sheets Pulled Together

Probable Causes Solutions

The paper tray is too full.

Remove some of the paper. Do not load paper past MAX
fill line.

The edges of the paper are not even.

Remove the paper, align the edges, and then reload it.

The paper is moist from humidity.

Remove the paper from the tray. Load new, dry paper
parer into the tray..

Too much static electricity is present.

Load a new ream of paper.

Using unsupported paper.

Use only Xerox®-approved paper. For more information,
refer to Supported Paper.

The feed rollers are dirty.

With a clean, lint-free cloth moistened with water, wipe
the feed rollers until they are clean. For more informa-
tion, refer to Cleaning The Printer.

Paper Misfeeds

Probable Causes Solutions

The paper is not correctly positioned in the tray.

e Remove the misfed paper and reposition it properly
in the tray.

e Adjust the paper guides in the tray to match the size
of the paper.

The paper tray is too full.

Remove some of the paper. Do not load paper past the
fill line.

The paper guides are not correctly adjusted to the paper
size.

Adjust the paper guides in the tray to match the size of
the paper.

The tray contains warped or wrinkled paper.

Remove the paper, smooth it out, and reload it. If it still
misfeeds, do not use that paper.

The paper is moist from humidity.

Remove the moist paper and replace it with new, dry
paper.

Using paper of the wrong size, thickness, or type.

Use only Xerox approved paper. For more information,
refer to Supported Paper.

The feed rollers are dirty.

With a clean, lint-free cloth moistened with water, wipe
the feed rollers until they are clean. For more informa-
tion, refer to Cleaning The Printer.
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Troubleshooting

Probable Causes Solutions

The label sheet is facing the wrong way in the tray.

e Load label sheets according to the instructions from
the manufacturer.

e Load labels in the tray, face up.
e For more information, refer to Labels.

Labels are missing, curled, or pulled away from the
backing sheet.

Do not use any sheet where labels are missing, curled,
or pulled away from the backing sheet.

Envelopes are loaded incorrectly.

You can print envelopes from the Bypass Tray or Tray
1.
For more information, refer to Envelopes.

Envelopes are wrinkling.

e The heat and pressure of the laser printing process
can cause wrinkling.

e Usesupported envelopes. For more information, refer
to Guidelines for Printing Envelopes.
Note

When you load envelopes long-edge feed, ensure that
you specify landscape orientation in the print driver.

Paper Jam Message Stays On
Note

Check for, and remove, torn pieces of paper in the paper path.

Probable Causes Solutions

Some paper remains jammed in the printer.

Recheck the paper path and make sure that you have
removed all of the jammed paper.

One of the printer doors is open.

Check the doors on the printer. Close any door that is
open.

Jams During Automatic 2-Sided Printing

Probable Causes Solutions

Using paper of the wrong size, thickness, or type.

Use paper of the correct size, thickness, or type. For more
information, refer to Supported Paper Types and
Weights for Automatic 2-Sided Printing.

Paper is loaded in the wrong tray.

Ensure that paper is loaded into the correct tray. For
more information, refer to Supported Paper.
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Probable Causes Solutions

Tray is loaded with mixed paper. Load the tray with only one type and size of paper.

Print-Quality Problems

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems,
use the information in this section to troubleshoot the problem. For more information, go to
www.xerox.com/office/VLB605_VLB615support.

@ Caution

The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not cover damage
caused by using unsupported paper or specialty media. The Xerox Total Satisfaction Guarantee is
available in the United States and Canada. Coverage could vary outside these areas. Contact your local
Xerox representative for details.

Note

To ensure consistent print quality, the toner, print, and drum cartridge for many devices are designed
to cease functioning at a predetermined point.

Controlling Print Quality

Various factors can affect the quality of the output of your printer. For consistent and optimum print
quality, use paper designed for your printer, and correctly set the Print-Quality Mode. Follow the guidelines
in this section to maintain optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. The range for optimal print quality
is 15-28°C (59-82°F) and 20-70 % relative humidity. However, print quality can be affected when
operating near the limits for both temperature and humidity.

Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section
for the best print quality and to avoid jams:

e Use only Xerox-approved paper. For more information, refer to Supported Paper.
e Use only dry, undamaged paper.
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@ Caution
Some paper and other media types can cause poor output quality, increased paper jams, or damage
your printer. Do not use the following:
- Rough or porous paper
- Inkjet paper
- Paper that is photocopied
- Paper that is folded or wrinkled
- Paper with cutouts or perforations
- Stapled paper
- Envelopes with windows, metal clasps, side seams, or adhesives with release strips
- Padded envelopes
- Plastic media
- Transparencies

e Ensure that the paper type selected in your print driver matches the paper type on which you are
printing.

o If you have the same size paper loaded in more than one tray, ensure that the proper tray is selected
in the print driver.

e Store your paper and other media properly for optimum print quality. For more information, refer to
Paper Storage Guidelines.

Solving Print-Quality Problems

When the print quality is poor, select the closest symptom from the following table, then refer to the
corresponding solution to correct the problem. You can also print a Demonstration Print page to more
precisely determine the print-quality problem. For more information, refer to Information Pages.

If the print quality does not improve after performing the appropriate action, contact your Xerox
representative.

Note

To maintain print quality, the toner cartridge is designed to provide a warning message when the toner
level is low. When the toner cartridge reaches this level, a warning message appears. When the toner
cartridge is empty, another message prompts you to replace the toner cartridge. The printer stops
printing until you install a new toner cartridge.

Symptom Solutions

The output is too light.

™.

e To check the toner level, check the control panel, use
™,

AN the print driver, or the Embedded Web Server. If the
toner cartridge is near empty, replace it.

e Verify that the toner cartridge is approved for use in
this printer, then replace it as needed. For best results,
use a genuine Xerox toner cartridge.

¢ Replace the paper with a recommended size and
type, then confirm that your printer and print driver
settings are correct.
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Symptom Solutions

Verify that the paper is dry and that supported paper
is used. If the paper is moist or is not a supported
paper type, load new, dry paper in the tray.
Change the Paper Type settings in the print driver.

In the print driver Printing Options tab, select Paper,
then change the Other Type setting.

Toner smears or print rubs off.
The output has stains on the back side.

", -
", Ve

",
", //

ABC .
DEf .

Change the Paper Type settings in the print driver.
For example, change Plain to Lightweight Card-
stock. In the print driver Printing Options tab, select
Paper, then change the Other Type setting.

Verify that the paper is the correct size, type, and
weight. Change the paper settings to match the pa-
per in the tray.

Verify that the printer is plugged into an outlet that
is providing the correct voltage and power. Review
the electrical specification of the printer with an
electrician if necessary. For more information, refer
to Electrical Specifications.

Random spots on the output, or the image is blurry.
\
S

",
",

Ensure that the toner cartridge is installed correctly.

If you used a non-genuine brand toner cartridge, in-
stall a genuine Xerox toner cartridge.

For the print driver Rough Paper Type setting, select
Rough, or load a smooth-surfaced paper in the paper
tray.

Ensure that the humidity in the room is within spe-
cifications. For more information, refer to Relative
Humidity.

The output is blank.

",
\\
",

Power off the printer, then power on again.

If the error persists, contact your Xerox representat-
ive.
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Symptom Solutions

White lines or vertical blanks appear. Clean the LED Lens. For more information, refer to
Cleaning the LED Lens.

Streak inth tput.
redks dppearin the outpu ¢ Replace the Drum Cartridge.

o If the error persists, contact your Xerox representat-

3

The output h ttled .
€ output has a Mottied appedrance o Verify that the paper is the correct size, type, and
S
S

weight. Change the paper settings to match the pa-
per in the tray.

e Ensure that the humidity in the room is within spe-
cifications. For more information, refer to Relative
Humidity.

e Choose a different paper type at the control panel,
in the application, and in the print driver.

e Replace the paper.

Ghosti rs in the printed output.
>-nd gPPedrs In The printed outpu o Verify that the paper is the correct size, type, and

weight. Change the paper settings to match the pa-
per in the tray.

¢ Change the Paper Type settings in the print driver.
In the print driver Printing Options tab, select Paper,
then change the Other Type setting.

¢ Replace the Drum Cartridge.

Auger marks appear on the printed output.
9 PP P P e To check the toner level, check the control panel, use

the print driver, or the Embedded Web Server. If the
toner cartridge is near empty, replace it.
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Symptom Solutions

e Verify that the toner cartridge is approved for use in
this printer, and replace it as needed. For best results,
use a genuine Xerox toner cartridge.

o Verify that the paper is the correct size, type, and
weight for the printer and that it is loaded properly.

e Load a new ream of paper.

/ — e Change the Paper Type settings in the print driver.
In the print driver Printing Options tab, select Paper,
i then change the Other Type setting.

Envelopes are wrinkled or creased when printed. Check if the crease is within 30 mm (1.2 in.) of the four
edges of the envelope.

e If the crease is within the supported measurement,
it is printing as expected. Your printer is not faulty.

e If the crease is more than the supported measure-
ment, do the following steps:
1. Ensure that envelopes are loaded properly in
the Bypass Tray. For more information, refer
to Loading Envelopes in the Bypass Tray.

2. Follow the guidelines for printing on envelopes.
For more information, refer to Guidelines for
Printing Envelopes.

3. If the problem persists, use a different size en-
velope.

Thet inisi t.
< op margl\n 15 Incorrec e Ensure that the paper is loaded properly.

",
",
",

e Ensure that the margins are set correctly in the ap-
plication that you are using.

e Adjust the paper registration. For more information,

A B C refer to Adjusting Paper Registration.
DEF

The printed surface of the paper is bumpy. 1. Print a solid image over the entire surface of one
sheet of paper.
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Troubleshooting

Solutions

N\
ABC’
DEF,

2. Loadthe printed sheet into the tray with the printed

side face down.

Print five blank pages to remove debris from the
fuser rollers.

Spots or lines appear at regular intervals on the prints.

1. Print the Repeating Defects pages.
At the control panel, touch Device > Support >
Support Pages > Repeating Defects.

2. To determine the cause of the problem, measure
the distance between the print defects.
e 28 mm (1.1 in.): Drum Cartridge
e 31 mm (1.2in.): Drum Cartridge
e 42mm (1.7 in.): Drum Cartridge
e 52mm (2.0 in.): Drum Cartridge
e 94 mm (3.7 in.): Drum Cartridge
e 46 mm (1.8 in.): Transfer Roller
e 82mm (3.2in.): Fuser
e 94 mm (3.7 in.): Fuser

3. If the repeating defects matches one of the dis-

tances, replace the matching component.

Copy and Scan Problems

If the copy or scan quality is poor, refer to the following table.

If the problem persists, for online support information, go to

www.xerox.com/office/VLB605_VLB61 5support.

Symptoms

Solutions

Lines or streaks only present in copies made from the
document feeder.

There is debris on the CVT glass or the second-side
scanning lens assembly. When scanning, the paper from
the document feeder passes over the debris on the glass
surfaces, resulting in lines and streaks. Clean all glass
surfaces with a lint-free cloth. For more information,
refer to Cleaning the Scanner.

Spots present in copies made from the document glass.

There is debris on the document glass. When scanning,
the debris creates a spot on the image. Clean all glass
surfaces with a lint-free cloth.
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Symptoms Solutions

Image is too light or too dark.

Adjust the lighten/darken setting.

documents.

Image quality is poor when scanning color original

For best results, select Black & White output.

Fax Problems

Note

If the printer cannot send and receive faxes, make sure that you are connected to an approved analog
telephone line. The fax cannot send or receive when connected to a digital phone line.

If you cannot send or receive faxes correctly, refer to the following tables.

Problems Sending Faxes
Symptoms

The document is not scanned using
the document feeder.

Causes

The document is too thick, too thin,
or too small.

Solutions

Use the document glass to send the
fax.

The document is scanned at an
angle.

The document feeder guides are not
adjusted to the width of the docu-
ment.

Adjust the document feeder guides
to fit the width of the document.

The fax received by the recipient is
blurry.

The document is positioned incor-
rectly.

Position the document correctly.

The document glass is dirty.

Clean the document glass.

The text in the document is too light.

Adjust the resolution.

There is a problem with the tele-
phone connection.

Verify that the telephone line is
working, then send the fax again.

There is a problem with the fax ma-
chine of the caller.

Make a copy to verify that your
printer is operating correctly. If the
copy was printed correctly, have the
recipient verify the condition of the
receiving fax machine.

The fax received by the recipient is
blank.

The document was loaded incor-
rectly.

e Document feeder: Place the origin-
al document face up.

e Document glass: Place the origin-
al document face down.

Xerox® VersaLink® B605/B615 Multifunction Printer
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Symptoms

Fax was not transmitted.

Causes

The fax number is wrong.

Troubleshooting

Solutions

Verify the fax number.

The telephone line is connected incor-
rectly.

Verify the telephone connection. If
it is disconnected, connect it.

There is a problem with the fax ma-
chine of the recipient.

Contact the recipient.

The fax is not installed or is not en-
abled.

Verify that the fax is installed and
enabled.

If the problem persists, for online support information, go to
www.xerox.com/office/VLB605_VLB615support.

Problems Receiving Faxes

Symptoms

The received fax is blank.

Causes

There is a problem with the tele-

phone connection or with the fax
machine of the caller.

Verify that the printer can make

Solutions

clean copies. If it can, have the caller
send the fax again.

The sender loaded the pages incor-
rectly.

Contact the sender.

The printer answers the call, but does
not accept incoming data.

Not enough memory.

If the job contains several graphics,
the printer could not have enough
memory. The printer does not answer
when memory is low. Delete stored
documents and jobs then wait for
the existing job to complete. This in-
creases available memory.

The received fax size is reduced.

The paper supply in the printer does
not match the document size sent.

Confirm the original size of the docu-
ments. Documents could be reduced
based on the available paper supply
in the printer.
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Symptoms Causes Solutions

Faxes cannot be received automatic- | The printer is set to receive faxes Set the printer to automatic recep-
ally. manually. tion.

The memory is full. Load paper if it is empty, and then
print the faxes stored in the memory.

The telephone line is incorrectly con- | Verify the telephone line connection.
nected. If it is disconnected, connect it.

There is a problem with the fax ma- | Make a copy to verify that your
chine of the sender. printer is operating correctly. If the
copy prints correctly, have the recipi-
ent verify their fax machine is oper-
ating correctly.

If the problem persists, for online support information, go to
www.xerox.com/office/VLB605_VLB615support.

Getting Help

Your printer includes utilities and resources to help you troubleshoot printing problems.

Viewing Warning Messages on the Control Panel

When a warning condition occurs, the printer alerts you of the problem. A message appears on the
control panel and the LED status light on the control panel flashes amber or red. Warning alerts inform
you about printer conditions, such as low supplies or open doors, that require your attention. If more
than one warning condition occurs, only one warning message appears on the control panel at a time.

Viewing Current Errors on the Control Panel

When an error condition occurs, a message appears on the control panel to inform you of the problem.
Error messages warn you about printer conditions that prevent the printer from printing or degrade
printing performance. If more than one error occurs, only one is displayed on the control panel.

Using the Integrated Troubleshooting Tools

Your printer has a set of reports that you can print. These reports include the Demonstration Print page
and the Error History report that can assist you in troubleshooting certain problems. The Demonstration
Print page prints an image to show print quality. You can use this page to troubleshoot print-quality
issues with the printer. The Error History report prints information on the most recent printer errors.

For more information, refer to Printing Information Pages.
Printing the Error History Report

1. At the printer control panel, press the Home button.
2. To print the Error History Report, touch Device > Support > Support Pages > Error History Report.
3. To return to the Home screen, press the Home button.
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Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help
to solve your printer problems. You can find solutions for print-quality problems, paper jams, software
installation issues, and more.

To access the Online Support Assistant, go to www.xerox.com/office/VLB605_VLB61 5support.

Helpful Information Pages

To assist with troubleshooting, your printer has a set of Information Pages that you can print. These
pages include configuration and font information, demonstration pages, and more. For more information,
refer to Information Pages.

Support Pages

To assist with troubleshooting, your printer has a set of Support Pages that you can print. These pages
include Ghosting Print, Repeating Defects, System Status, Error History Report, and more. For more
information, refer to Printing Support Pages.

Printing Support Pages

1. At the printer control panel, press the Home button.
2. Touch Device > Support > Support Pages.

3. To print a support page, touch the needed page.

4. Toreturn to the Home screen, press the Home button.

More Information about Your Printer

To obtain more information about your printer, refer to More Information.
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Specifications

Configurations and Options

Available Configurations

This multifunction printer is a network printer with copy, automatic 2-sided printing, scan functions, fax
functions, and USB or network connectivity.

For detailed configurations information, refer to the Specifications sheet for your device:

From a Web browser, go to www.xerox.com/digital-printing-equipment.

Scroll down the page, and select Multifunction / All In One Printers.

From the Multifunction / All In One Printers page, scroll down the page to find your device.

From your device listing, select the PDF downloads link.

From the PDF downloads dialog, select the Specifications link for your device.

A new webpage opens, then a Specifications sheet for your device appears. The document contains
configuration information for your device.

6. You can download and save the PDF to your local computer drive, tablet, or other device.

s WwWwN =
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Specifications

Standard Features

Print Speed

e B605: Letter (8.5x 11 in.), A4 (210 x 297 mm): 58 ppm, 55.5 ppm maximum
e B615: Letter (8.5x 11 in.), A4 (210 x 297 mm): 65 ppm, 63 ppm maximum

2-Sided Print Speed

e B605: Letter (8.5x 11 in.), A4 (210 x 297 mm): 56 ppm, 49.3 ppm maximum
e B615: Letter (8.5x 11 in.), A4 (210 x 297 mm): 58.5 ppm, 52.2 ppm maximum

Print Resolution

1200 x 1200 dpi

Paper Capacity

e Bypass Tray: 150 sheets

e Tray 1: 550 sheets

e Output Tray: 500 sheets; 400 sheets for Models B605S, B605X, and B615X
e Optional 550-Sheet Feeder: 550 sheets, up to 4 trays

e Optional High-Capacity Feeder: 2000 sheets

e Optional Finisher: 500 sheets

e Optional Mailbox: 400 sheets

Maximum Print Size

Legal (216 x 356 mm, 8.5 x 14 in.)

2-Sided Printing

For 2-Sided Printing models, up to 176 g/m? from any tray

Copy Speed

e 1-Sided Copy: Up to 58 A4-size copies per minute (cpm), or 65 cpm for Letter-size copies
e 2-Sided Copy: Up to 52.2 A4-size copies per minute (cpm), or 58.5 for Letter-size copies

Copy Resolution

600 x 600 dpi

Maximum Copy Size

Legal (216 x 356 mm, 8.5 x 14 in.)
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Specifications

Document Feeder

e Type: Single-Pass Duplex Automatic Document Feeder
e Document Feeder Capacity: 100 sheets

Optical Scan Resolution

600 x 600 dpi

Maximum Scan Size

e Document Glass: 215.9 x 355.6 mm (8.5 x 14 in.)
e Duplex Automatic Document Feeder: 215.9 x 355.6 mm (8.5 x 14 in.)

File Formats

. JPEG
o TIFF
. PDF
« PDF/A
« XPS

Supported Scanning

e Scan to Desktop (WSD)
e Scanto SMB

e Scanto FTP

e Scan to Email

e Scan to USB Flash drive

Control Panel

7-inch LCD touch screen with Home and Power/Wake buttons

Connectivity

e 3 USB 2.0 (Type A) Ports

e USB 3.0 (Type B) Port

e USB Flash drive

e Ethernet 10/100/1000 Base-TX

e Optional wireless network connectivity with an IEEE 802.11 b/g/n-compliant Wireless Network Adapter
e Near Field Communication (NFC) Tap-to-Pair

e AirPrint®

e MOPRIA™

Xerox® VersaLink® B605/B615 Multifunction Printer A-
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Specifications

Connectivity

e IC Card Reader support

e Foreign Device Interface (FDI)

Remote Access

Embedded Web Server

Options and Upgrades

e Wireless Network Adapter: IEEE 802.11 b/g/n-compliant, and supports 2.4-GHz and 5-GHz frequencies.
e 550-Sheet Feeder, depending on configuration, up to 4 feeders

e 2000-Sheet High-Capacity Feeder with Casters

e Finisher, available for all models except: B605S, B605X, and B615X

e 4-Bin Mailbox, available for all models except: B605S, B605X, and B615X

e Cabinet with Casters

e CACKit/Card Reader
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Physical Specifications

Weights and Dimensions

Base Configuration, Short Model

47.0cm

18.5in "“‘*‘J\

Base Configuration, Tall Model

47.0cm

_ 18.5in ‘L
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Width: 47.0 cm (18.5in.)
Depth: 50.3 cm (19.8 in.)
Height: 64.4 cm (25.4in.)
Weight: 30.5 kg (67.2 |b.)

Width: 47.0 cm (18.5in.)
Depth: 50.3 cm (19.8 in.)
Height: 84.4 cm (33.2in.)
Weight: 32.5 kg (71.7 |b.)
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Clearance Requirements

Clearance Requirements for Short Model

87.8cm
34.6in

107.8 cm
42 4in
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Clearance Requirements for Optional 550-Sheet Feeder

15cm
59in

—

15cm ™
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Environmental Specifications

Temperature

e Operating Temperature Range: 10-32°C (50-90°F)
e Optimal Temperature Range: 15-28°C (59-82°F)

Relative Humidity

e Operating Humidity Range: 15-85 %
e Optimal Humidity Range: 20-70 % relative humidity at 28°C (82°F)

Note

Under extreme environmental conditions, such as 10°C and 85 % relative humidity, printing defects can
occur due to condensation inside the printer.

Elevation

For optimum performance, use the printer at elevations below 3100m (10,170ft.).
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Electrical Specifications

Power Supply Voltage and Frequency

Power Supply Voltage Frequency Current Required

110-127 VAC +/-10% 50/60 Hz +/-3 Hz 12A
(99.0-139.7 VAQ)

220-240 VAC +/-10 % 50/60 Hz +/-3 Hz 8A
(198-264 VAC)

Power Consumption

e Power Saver Mode (Sleep): 1.1 W
e Ready: 79 W
¢ Continuous printing: 950 W

Performance Specifications

Feature Specifications

Printer warm-up time Power on: less than 79 seconds.
Recovery from sleep mode: less than 47 seconds.
Note

Warm-up time assumes an ambient temperature of 23°C
(73°F) at 65 % relative humidity.

Print Speed

Depending on the model, print speeds for continuous printing are up to 65 ppm.

Several factors affect print speed:

e Print mode: The fastest print modes are Standard and Enhanced.

e Paper size: Letter (8.5 x 11 in.) size prints slightly faster than A4 (210 x 297 mm) size. Larger sizes
reduce print speeds.

e Paper type and weights: For faster printing, use paper weights of 105 g/m? or less.

Maximum Print Speeds

e 1-sided printing is 65 ppm on Letter-size paper, and 63 ppm on A4-size paper.

e 2-sided printing is 58.5 ppm on Letter-size paper and 52.2 ppm on A4-size paper.
o Lightweight Cardstock is 50 ppm.

e Cardstock is 40 ppm.
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e Envelopesis 17 ppm.
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Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are
designed to mitigate interference caused or received by this printer in a typical office environment.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and purchase
of energy-efficient models, which help to reduce environmental impact. Details on the EN-
ERGY STAR program and models qualified to ENERGY STAR can be found at the following
website: www.energystar.gov.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United States,
European Union, Japanese governments, and the office equipment industry to promote
energy-efficient copiers, printers, fax, multifunction printers, personal computers, and
monitors. Reducing product energy consumption helps combat smog, acid rain, and long-
term changes to the climate by decreasing the emissions that result from generating elec-

tricity.

For more information on energy or other related topics, go to
www.xerox.com/about-xerox/environment/enus.html or
www.xerox.co.uk/about-xerox/environment/engb.html.

Power Consumption and Activation Time

The amount of electricity that a device consumes depends on the way the device is used. This device is
designed and configured to enable you to reduce your electricity usage.
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Power Saver modes are enabled on your device to reduce energy consumption. After the last print, the
device transitions to Ready mode. In this mode, the device can print again immediately. If the device
is not used for a specified period, the device transitions to Low Power mode, then to Sleep mode. In
these modes, to enable reduced-power consumption, only essential functions remain active. The device
takes longer to produce the first print after it exits the Power Saver modes than it takes to print in Ready
mode. This delay is the result of the system waking up and is typical of most imaging devices on the
market.

To save power, you can enable Auto Power Off mode on your device. If Auto Power Off mode is enabled,
you can configure the mode as follows:

e Always Allowed: The device powers off automatically after the specified time, and the cumulative
Low Power mode and Sleep mode timeouts have elapsed.

e Allowed ONLY When Conditions are Met: The device automatically powers off only after timeouts
have elapsed. The device also powers off if Fax, USB Drive, and Wired and Non-Wired Network have
not been activated.

To change the Power Saver settings, refer to the User Guide at
www.xerox.com/office/VLB605_VLB61 5docs. For further assistance, contact your System Administrator
or refer to the System Administrator Guide.

To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System
Administrator Guide at www.xerox.com/office/VLB605 VLB615docs.

To learn more about Xerox participation in sustainability initiatives, go to:
www.xerox.com/about-xerox/environment/enus.html.

Note

Changing the default Power Saver activation times can result in an overall higher energy consumption
of the device. Before you turn off Power Saver modes or set a long activation time, consider the increase
in device power consumption.

Default Power Saver Settings

This device is ENERGY STAR®-qualified under the ENERGY STAR Program Requirements for Imaging
Equipment. The transition time from Ready mode to Low-Power mode can be set up to 60 minutes. The
default value is 5 minutes. The transition time from Low-Power mode to Sleep mode can be set up to
60 minutes. The default value is set at 1 minute. The total transition time from Ready mode to Sleep
mode can take up to 60 minutes.

To change the Power Saver settings, contact your System Administrator, or refer to the System
Administrator Guide at www.xerox.com/office/VLB605 VLB615docs.

B-2 Xerox® VersaLink® B605/B615 Multifunction Printer
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB605_VLB615&PgName=userdocpdfs&FileName=user_guide&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB605_VLB615&PgName=userdocpdfs&FileName=user_guide&Language=English
http://www.xerox.com/about-xerox/environment/enus.html
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB605_VLB615&PgName=userdocpdfs&FileName=user_guide&Language=English

Regulatory Information

Environmental Benefits of Duplex Printing

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you
to print on both sides of the paper automatically, and therefore helps to reduce the use of valuable
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the
duplex function has been auto-enabled, during the setup and driver installation. Some Xerox models
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time
of install. Continuing to use the duplex function will reduce the environmental impact of your work.
However, should you require simplex/1-sided printing, you may change the print settings in the print
driver.

Paper Types

This product can be used to print on both recycled and virgin paper, approved to an environmental
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper
(60 g/m?), which contains less raw material and thus saves resources per print, may be used in certain
applications. We encourage you to check if this is suitable for your printing needs.

Regulatory Information for 2.4-GHz and 5-GHz Wireless Network Adapter

This product contains a 2.4-GHz and 5-GHz Wireless LAN radio transmitter module that complies with
the requirements specified in FCC Part 15, Industry Canada RSS-210, and European Council Directive
2014/53/EU. Radio Frequency (RF) output power of this device will not exceed 20 dBm in either frequency
band.

Operation of this device is subject to the following two conditions:

1. This device may not cause harmful interference, and

2. This device must accept any interference received, including interference that may cause undesired
operation.

Changes or modifications to this device not specifically approved by the Xerox Corporation may void
the user's authority to operate this equipment.

United States FCC Regulations

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant
to Part 15 and Part 18 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency energy. If the equipment is not installed
and used in accordance with these instructions, it can cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference. Users are required
to correct the interference at their own expense.

If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and receiver.
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e Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
o Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user
to operate this equipment.

A Warning
To ensure compliance with Part 15 and Part 18 of the FCC rules, use shielded interface cables.
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Canada
This Class A digital apparatus complies with Canadian ICES-003 and ICES-001.

Cet appareil numérique de la classe A est conforme @ la norme NMB-003 et NMB-001 du Canada.
EcoLogo Certified to Office Machines CCD-035

Ay This product is certified to EcoLogo standard for office machines, meeting all requirements for

1 E reduced environmental impact. As part of achieving certification, Xerox Corporation has proven
this product meets the EcoLogo criteria for energy efficiency. Certified copier, printer, multifunc-
tional device, and fax products must also meet criteria such as reduced chemical emissions and
demonstrate compatibility with recycled supplies. EcoLogo was established in 1988 to help con-
sumers find products and services with reduced environmental impacts. EcoLogo is a voluntary,
multi-attribute, and lifecycle-based environmental certification. This certification indicates that
a product has undergone rigorous scientific testing, exhaustive auditing, or both, to prove its
compliance with stringent, third-party, environmental performance standards.

Certifications in Europe

c € The CE mark applied to this product symbolizes a declaration of conformity by Xerox with the following
applicable Directives of the European Union as of the date indicated:

e April 16, 2014: Radio Equipment Directive 2014/53/EU

Hereby, Xerox declares that the radio equipment model VersalLink® B605/B615 is in compliance with
Directive 2014/53/EU. The full text of the EU declaration of conformity can found at the following
internet address: www.xerox.com/environment_europe

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or
for the environment.

A Warning

e Changes or modifications to this equipment not specifically approved by the Xerox Corporation may
void the user's authority to operate this equipment.

e External radiation from Industrial, Scientific, and Medical (ISM) equipment can interfere with the
operation of this Xerox device. If external radiation from ISM equipment interferes with this device,
contact your Xerox representative for assistance.

e Thisis aclass A product. In a domestic environment, this product can cause radio frequency
interference, in which case the user can be required to take adequate measures.

e To ensure compliance with European Union regulations, use shielded interface cables.

European Union Lot 4 Imaging Equipment Agreement Environmental Information
Environmental Information Providing Environmental Solutions and Reducing Cost

The following information has been developed to assist users and has been issued in relation to the
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging
Equipment. This requires manufacturers to improve environmental performance of in scope products
and supports the EU action plan on energy efficiency.
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In scope products are Household and Office equipment that meet the following criteria:

e Standard monochrome format products with a maximum speed less than 66 A4 images per minute
e Standard color format products with a maximum speed less than 51 A4 images per minute

Germany

Germany - Blue Angel

SSREE, RAL, the German Institute for Quality Assurance and Labeling, has awarded this device the Blue
<

Angel Environmental Label. This label distinguishes it as a device that satisfies Blue Angel criteria
?;\% ,@j for environmental acceptability in terms of device design, manufacture, and operation. For more

information, go to: www.blauer-engel.de.

Blendschutz

Das Gerat ist nicht fur die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen.
Um storende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im
unmittelbaren Gesichtsfeld platziert werden.

Larmemission

Maschinenldrminformations-Verordnung 3. GPSGV: Der héchste Schalldruckpegel betréigt 70 dB(A) oder
weniger gemdf3 EN ISO 7779.

Importeur

Xerox GmbH

HellersbergstraBe 2-4

41460 Neuss

Deutschland

Turkey RoHS Regulation

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”
“EEE yonetmeligine uygundur.”

Eurasian Economic Community Certification

Economic Community, or EurAsEC. The Eurasian Economic Community members anticipate sharing

Russia, Belarus, and Kazakhstan are working to establish a common customs union, the Eurasian
a common regulatory scheme and common EurAsEC certification mark, the EAC Mark.
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Copy Requlations

United States

Congress, by statute, has forbidden the reproduction of the following subjects under certain circumstances.
Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions.

1. Obligations or Securities of the United States Government, such as:

Certificates of Indebtedness.
National Bank Currency.
Coupons from Bonds.
Federal Reserve Bank Notes.
Silver Certificates.

Gold Certificates.

United States Bonds.
Treasury Notes.

Federal Reserve Notes.
Fractional Notes.
Certificates of Deposit.
Paper Money.

Bonds and Obligations of certain agencies of the government, such as FHA and so on.

Bonds. United States Savings Bonds may be photographed only for publicity purposes in
connection with the campaign for the sale of such bonds.

Internal Revenue Stamps. If it is necessary to reproduce a legal document on which thereis a
canceled revenue stamp, this may be done provided the reproduction of the document is
performed for lawful purposes.

Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be
photographed, provided the reproduction is in black and white and is less than 75 % or more
than 150 % of the linear dimensions of the original.

Postal Money Orders.
Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.

Stamps and other representatives of value, of whatever denomination, which have been or may
be issued under any Act of Congress.

Adjusted Compensation Certificates for Veterans of the World Wars.

Obligations or Securities of any Foreign Government, Bank, or Corporation.

3. Copyrighted materials, unless permission of the copyright owner has been obtained or the
reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law.
Further information of these provisions may be obtained from the Copyright Office, Library of
Congress, Washington, D.C. 20559. Ask for Circular R21.

4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be photographed.

5. Passports. Foreign Passports may be photographed.

6. Immigration papers.

Xerox® VersalLink® B605/B615 Multifunction Printer B-7
User Guide



Regulatory Information

7. Draft Registration Cards.
8. Selective Service Induction papers that bear any of the following Registrant’s information:

e Earnings or Income.
o Court Record.
¢ Physical or mental condition.
e Dependency Status.
¢ Previous military service.
e Exception: United States military discharge certificates may be photographed.
9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of

the various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered
by the head of such department or bureau).

Reproducing the following is also prohibited in certain states:

e Automobile Licenses.
¢ Drivers’ Licenses.
e Automobile Certificates of Title.

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case
of doubt, consult your attorney.

For more information about these provisions contact the Copyright Office, Library of Congress,
Washington, D.C. 20559. Ask for Circular R21.

Canada

Parliament, by stature, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such
reproductions.

e Current bank notes or current paper money
e Obligations or securities of a government or bank
e Exchequer bill paper or revenue paper

e The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of
a court of law

e Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause
same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer for
a province)

e Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of
a province, the government of a state other than Canada or a department, board, Commission, or
agency established by the Government of Canada or of a province or of a government of a state
other than Canada

e Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of
a province or by the government of a state other than Canada

o Documents, registers, or records kept by public officials charged with the duty of making or issuing
certified copies thereof, where the copy falsely purports to be a certified copy thereof
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e Copyrighted material or trademarks of any manner or kind without the consent of the copyright or
trademark owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is
assumed for its completeness or accuracy. In case of doubt, consult your solicitor.

Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be
imposed on those found guilty of making such reproductions.

e Currency notes

e Bank notes and checks

¢ Bank and government bonds and securities

e Passports and identification cards

o Copyright material or trademarks without the consent of the owner

e Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of
doubt, contact your legal counsel.

Fax Regulations

United States

Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer
or other electronic device, including a fax machine, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or other
individual sending the message and the telephone number of the sending machine or such business,
other entity, or individual. The telephone number provided may not be a 900 number or any other
number for which charges exceed local or long-distance transmission charges.

For instructions on programming the Fax Send Header information, refer to the section of the System
Administrator Guide on Setting Transmission Defaults.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested,
this number must be provided to the Telephone Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It connects to a compatible modular
jack that is also compliant. See installation instructions for details.
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You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the
compliant telephone line cord (with modular plugs) provided with the installation kit. See installation
instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be connected
to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing in response
to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain
of the number of devices that can be connected to a line, as determined by the RENs, contact the local
Telephone Company. For products approved after July 23, 2001, the REN is part of the product identifier
that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal

point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.

To order the correct service from the local Telephone Company, you could also have to quote the codes
in the following list:

e Facility Interface Code (FIC) = 02LS2
e Service Order Code (SOC) = 9.0Y

® Caution

Ask your local Telephone Company for the modular jack type installed on your line. Connecting this
machine to an unauthorized jack can damage telephone company equipment. You, not Xerox, assume
all responsibility and/or liability for any damage caused by the connection of this machine to an
unauthorized jack.

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could
temporarily discontinue service to the telephone line to which it is connected. If advance notice is not
practical, the Telephone Company notifies you of the disconnection as soon as possible. If the Telephone
Company interrupts your service, they can advise you of your right to file a complaint with the FCC if
you believe that it is necessary.

The Telephone Company could change its facilities, equipment, operations, or procedures which could
affect the operation of the equipment. If the Telephone Company changes something that affects the
operation of the equipment, they should notify you in order for you to make necessary modifications
to maintain uninterrupted service.

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for
repair or warranty information. Contact information is contained in the Device app on the printer and
in the back of the Troubleshooting section of the User Guide. If the equipment is causing harm to the
telephone network, the Telephone Company may request you to disconnect the equipment until the
problem is resolved.

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make
repairs to the printer. This applies at any time during or after the service warranty period. If unauthorized
repair is performed, the remainder of the warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is subject to state
tariffs. Contact the state public utility commission, public service commission, or corporation commission
for information.

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that
the installation of this Xerox® equipment does not disable your alarm equipment.
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If you have questions about what could disable alarm equipment, consult your Telephone Company or
a qualified installer.

Canada

This product meets the applicable Innovation, Science and Economic Development Canada technical
specifications.

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs
or alterations made by the user to this device, or device malfunctions, could cause the telecommunications
company to request you to disconnect the equipment.

For user protection, make sure that the printer is properly grounded. The electrical ground connections
of the power utility, telephone lines, and internal metallic water pipe systems, if present, must be
connected together. This precaution could be vital in rural areas.

A Warning

Do not attempt to make such connections yourself. Contact the appropriate electric inspection authority,
or electrician, to make the ground connection.

The Ringer Equivalence Number (REN) indicates the maximum number of devices allowed to be connected
to a telephone interface. The termination of an interface may consist of any combination of devices
subject only to the requirement that the sum of the RENSs of all the devices not exceed five. For the
Canadian REN value, please refer to the label on the equipment.

Canada CS-03 Issue 9

This product has been tested to and is compliant with CS-03 issue 9.

European Union

Radio Equipment and Telecommunications Terminal Equipment Directive

This device has been designed to work with the national public switched telephone networks and
compatible PBX devices of the following countries:

Pan-European Analog PSTN and

Compatible PBX Certifications

Austria Greece Netherlands
Belgium Hungary Norway
Bulgaria Iceland Poland
Cyprus Ireland Portugal
Czech Republic Italy Romania
Denmark Latvia Slovakia
Estonia Liechtenstein Slovenia
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Pan-European Analog PSTN and

Compatible PBX Certifications

Finland Lithuania Spain
France Luxembourg Sweden
Germany Malta United Kingdom

If you have problems with your product, contact your local Xerox representative. This product can be
configured to be compatible with other country networks. Before reconnecting the device to a network
in another country, contact your Xerox representative for assistance.

Note

e Although this product can use either loop disconnect (pulse) or DTMF tone signaling, Xerox
recommends that you use DTMF signaling. DTMF signaling provides reliable and faster call setup.

e Modification of this product, or connection to external control software or control apparatus not
authorized by Xerox, invalidates its certification.

New Zealand

1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has
accepted that the item complies with minimum conditions for connection to its network. It indicates
no endorsement of the product by Telecom, it does not provide any sort of warranty, and it does
not imply that any Telepermitted product is compatible with all Telecom network services. Above
all, it provides no assurance that any item will work correctly in all respects with another item of
Telepermitted equipment of a different make or model.

The equipment may not be capable of correct operation at the higher data speeds designated.
33.6kbps and 56kbps connections are likely to be restricted to lower bit rates when connected to
some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in such
circumstances.

2. Immediately disconnect this equipment should it become physically damaged, then arrange for its
disposal or repair.

3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom
customers.

4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There
is no guarantee that Telecom lines will always continue to support pulse dialing.

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, may
give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such problems,
do not contact the Telecom Faults Service.

6. DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is
readily available on almost all New Zealand telephone exchanges.

A Warning
No 111" or other calls can be made from this device during a mains power failure.

7. This equipment may not provide for the effective hand-over of a call to another device connected
to the same line.
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8. Some parameters required for compliance with Telecom Telepermit requirements are dependent
on the equipment (computer) associated with this device. The associated equipment shall be set
to operate within the following limits for compliance with Telecom Specifications:

For repeat calls to the same number:

e There shall be no more than 10 call attempts to the same number within any 30 minute period
for any single manual call initiation, and

e The equipment shall go on-hook for a period of not less than 30 seconds between the end of
one attempt and the beginning of the next attempt.

For automatic calls to different numbers:

The equipment shall be set to ensure that automatic calls to different numbers are spaced such
that there is no less than five seconds between the end of one call attempt and the beginning of
another.

9. For correct operation, total of the RNs of all devices connected to a single line at any time should
not exceed five.

South Africa

This modem must be used in conjunction with an approved surge protection device.

Safety Certification

This device is certified by the following agencies using the following safety standards.

Agency Standard

Underwriters Laboratories Inc. (US/Canada) UL 60950-1, 2nd Edition, 2014-10-14
CAN/CSA C22.2 No. 60950-1-07, 2nd Edition, 2014-10

Underwriters Laboratories Inc. (Europe) IEC 60950-1:2005 + A1:2009 + A2:2013 EN 60950-
1:2006 + A11:2009 + A1:2010 + A12:2011 + A2:2013

Material Safety Data Sheets

For Material Safety Data information regarding your printer, go to:

e North America: www.xerox.com/msds
e European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.
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Recycling and Disposal

All Countries

If you are managing the disposal of your Xerox product, please note that the printer may contain lead,
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental
considerations. The presence of these materials is fully consistent with global regulations applicable at
the time that the product was placed on the market. For recycling and disposal information, contact
your local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing
devices, such as batteries. Special handling may apply. For more information, go to
www.dtsc.ca.gov/hazardouswaste/perchlorate.

North America

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative
(1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information
about Xerox environmental programs, visit www.xerox.com/environment, or for recycling and disposal
information, contact your local authorities.

European Union

Some equipment may be used in both a domestic/household and a professional/business application.

Domestic/Household Environment

Application of this symbol on your equipment is confirmation that you should not dispose of the
equipment in the normal household waste stream.

|
In accordance with European legislation, end of life electrical and electronic equipment subject to

disposal must be segregated from household waste.
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Recycling and Disposal

Private households within EU member states may return used electrical and electronic equipment to
designated collection facilities free of charge. Please contact your local disposal authority for information.

In some member states, when you purchase new equipment, your local retailer may be required to take
back your old equipment free of charge. Please ask your retailer for information.

Professional/Business Environment

i

Application of this symbol on your equipment is confirmation that you must dispose of this equipment
in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back
information.

Collection and Disposal of Equipment and Batteries

b

These symbols on the products and/or accompanying documents mean that used electrical and
electronic products and batteries should not be mixed with general household waste.

For proper treatment, recovery, and recycling of old products and used batteries, please take them
to applicable collection points, in accordance with your national legislation and the Directive
2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to save valuable resources and
prevent any potential negative effects on human health and the environment which could otherwise
arise from inappropriate waste handling.

For more information about collection and recycling of old products and batteries, please contact
your local municipality, your waste disposal service or the point of sale where you purchased the

items.

Penalties may be applicable for incorrect disposal of this waste, in accordance with national legislation.

Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for
further information.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items, please contact
your local authorities or dealer and ask for the correct method of disposal.

Battery Symbol Note

g

Hg

C-2

This wheeled bin symbol may be used in combination with a chemical symbol. This establishes
compliance with the requirements set out by the Directive.
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Recycling and Disposal

Battery Removal

Batteries should only be replaced by a manufacturer-approved service facility.

Other Countries

Please contact your local waste management authority to request disposal guidance.
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Apps Features

Note
None of the ID Card Copy features can be customized.

Feature Description Copy Email Fax Scan ID
To Card
Copy
Preset Use Preset to select values that were stored | X X X X
previously. Select the required Preset from
the menu.
Output Color Use Output Color to control the color render- X X
‘ ing of the scanned image.
Saturation Saturation allows you to adjust the color X X
. strength and the amount of gray in the color.
2-Sided and 2-Sided You can use the 2-Sided options to set the [X X X X
Scanning device to scan one or both sides of an origin-
al document. You can specify 1-Sided or 2-
Sided output.
Paper Supply Use Paper Supply to specify the size, type | X X
and color of the paper required, or the Paper
E Tray to use. If Auto is selected, the printer
— chooses the paper tray based on the original
document size and the selected settings.
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Apps Features

Feature Description Copy Email Fax Scan
To
Collated You can collate multiple-page copy jobs X
? automatically. For example, when making
?ﬂ three 1-Sided copies of a six-page document,
the copies are printed in this order:
1,2,3,4,56;1,2,3,4,5,6;1,2,3,4,5,6.
Reduce/Enlarge You can reduce the image to as little as 25 % | X
of its original size or enlarge it as much as
400%.
Original Type The printer optimizes the image quality of |X X
the copies based on the type of images in
[&] the original document and how the original
was created.
&
Lighten/Darken Use the Lighten/Darken slider to make the |X X
m output image or print lighter or darker.
Sharpness Use this option to sharpen the output image | X
or print. For best results, sharpen text images
and soften photos.
Original Orientation You can use the Original Orientation option | X
to specify the layout of the original images
that you scan. The printer uses the informa-
tion to determine if images require rotation
E to produce the desired output.
Image Shift Image Shift allows you to modify the loca- | X
tion of the image on the page. You can shift
the printed image along the X and Y axes of
each sheet of paper.
Auto Background Sup- | Use the Auto Background Suppression set- | X X
pression ting to reduce the sensitivity of the printer
to variations in light background colors.
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Apps Features

Feature Description Copy Email Fax Scan ID
To Card

Copy

Edge Erase You can erase content from the edges of [ X X X
your images using the Edge Erase feature.
You can specify the amount to erase on the
right, left, top, and bottom edges.

Original Size To ensure that you are scanning the correct | X X X X
area of the documents, specify the original
document size.
Book Copying You can use the Book Copying featureto [ X
copy books, magazines, or other bound
documents.
Front Cover You can print the first page of your copy job | X
on different paper, such as colored or
heavyweight paper. The printer selects the

special paper from a different tray. The
cover can be blank or printed.

Note

This function is only available on printers
with an optional Productivity Kit installed.

Annotations You can add Annotations, such as page X

g numbers and the date, to your copies.
Note

This function is only available on printers
with an optional Productivity Kit installed.

Booklet Creation The Booklet Creation feature prints two X
pages on each side of the paper. The pages
are reordered so that they are in numerical

order when folded.

Note

This function is only available on printers
with an optional Productivity Kit installed.

Page Layout You can print the selected number of pages | X
. g on one side of a sheet of paper. Selecting
31 multiple pages per sheet saves paper and
provides a way to review the layout of a
document.
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Apps Features

Feature Description Copy Email Fax Scan ID
To Card
Copy
Sample Copy Sample Copy allows you to print a test copy | X
of a job to inspect before printing multiple
[-Fo copies. This feature is useful for complex or

high-volume jobs. After you print and inspect
the test copy, you can choose to print or
cancel the remaining copies.

Quantity Use this option to enter the number of re- X
quired ID card copies.

Preview Use this option to view a sample image. X X X

Resolution Resolution determines how fine or grainy X X X
graphic images appear. Image resolution is
measured in dots per inch (dpi).

Contrast You can use the Contrast feature to adjust X X
the variation between light and dark areas
of the image.

Remove Blank Pages Remove Blank Pages configures the printer X X X

to ignore blank pages.

kd

Book Scanning You can use the Book Scanning feature to X X
scan books, magazines, or other bound doc-
uments.
Subject Use the Subject option to add a title or X
.: heading.
From Use the From option to specify the originator X
E of the email.
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Feature

Reply To

Apps Features

Description Copy Email Fax Scan ID
To Card

Copy

Use the Reply To option to include an email X
address you want the recipient to reply to.
This option is useful if you want the recipient
to reply to your email address rather than
to the device.

Note

The system administrator can preset this
option.

Message

Use Message to enter information to accom- X
pany the email.

File Format

PDI FI

Use the File Format option to specify the X
format of the saved image or to define a
searchable image. You can add a password
to protect the image or choose to combine
multiple images into a single file.

Note

The Scan To app allows customization of file
format, although it cannot be disabled
through the Customization menu.

File Already Exists

[

Use the File Already Exists option to define X
what action the device takes when the file
name is used already.

File Name

Use the File Name option to specify a name X X
for the file containing the scanned images.

Book Faxing

B

You can use the Book Faxing feature to scan X
images from books, magazines, or other
bound documents for faxing.

Starting Rate

@

Select the highest starting rate to transmit X
the fax, unless the destination for the fax
you are sending has special requirements.

Cover Sheet

You can use the Cover Sheet option to add X
an introduction page to the beginning of
your fax. You can add a short comment to
the cover sheet, and To and From details.
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Apps Features

Feature Description Copy | Email

Transmission Header It is unlawful to send a message from a fax X
Text machine without the proper Transmission

Header Text. Ensure that the name and
i telephone number of the sender, and the

date and time of the transmission are in-

cluded on all faxes.

Delay Send You can set a time in the future for the X
printer to send your fax job. You can delay
'a the sending of your fax job for up to 24
hours.
Priority Send Use Priority Send to identify urgent faxes. X
E Priority faxes are sent first.
Manual Send You can use the Manual Send feature to X

enable the fax modem speaker temporarily.
This feature is helpful to dial international
numbers, or to use phone systems that re-
quire you to wait for a specific audio tone.

Polling Polling allows you to retrieve faxes stored X
on other fax machines.
(o))
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